ADOBE PHOTOSHOP CC

JAVASCRIPT SCRIPTING REFERENCE

Al

Adobe



© 2013 Adobe Systems Incorporated. All rights reserved.
Adobe® Photoshop® CC JavaScript Scripting Reference for Windows' and Macintosh”.

NOTICE: All information contained herein is the property of Adobe Systems Incorporated. No part of this publication (whether in hardcopy or
electronic form) may be reproduced or transmitted, in any form or by any means, electronic, mechanical, photocopying, recording, or
otherwise, without the prior written consent of Adobe Systems Incorporated. The software described in this document is furnished under
license and may only be used or copied in accordance with the terms of such license.

This publication and the information herein is furnished AS IS, is subject to change without notice, and should not be construed as a
commitment by Adobe Systems Incorporated. Adobe Systems Incorporated assumes no responsibility or liability for any errors or
inaccuracies, makes no warranty of any kind (express, implied, or statutory) with respect to this publication, and expressly disclaims any and
all warranties of merchantability, fitness for particular purposes, and noninfringement of third party rights.

Any references to company names in sample templates are for demonstration purposes only and are not intended to refer to any actual
organization.

Adobe’, the Adobe logo, Acrobat’, GoLive®,InDesign®, Illustrator’, Photoshop® are either registered trademarks or trademarks of Adobe
Systems Incorporated in the United States and/or other countries.

Applea, Mac 0S°, and Macintosh” are trademarks of Apple Computer, Inc,, registered in the United States and other countries. Microsoft’, and
Windows " are either registered trademarks or trademarks of Microsoft Corporation in the United States and other countries. JavaScript™ and
all Java-related marks are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States and other countries. UNIX  is a

registered trademark of The Open Group.

All other trademarks are the property of their respective owners.

If this guide is distributed with software that includes an end user agreement, this guide, as well as the software described in it, is furnished
under license and may be used or copied only in accordance with the terms of such license. Except as permitted by any such license, no part
of this guide may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, recording,
or otherwise, without the prior written permission of Adobe Systems Incorporated. Please note that the content in this guide is protected
under copyright law even if it is not distributed with software that includes an end user license agreement.

The content of this guide is furnished for informational use only, is subject to change without notice, and should not be construed as a
commitment by Adobe Systems Incorporated. Adobe Systems Incorporated assumes no responsibility or liability for any errors or
inaccuracies that may appear in the informational content contained in this guide.

Adobe Systems Incorporated, 345 Park Avenue, San Jose, California 95110, USA.



Contents

1 Introduction . cesssssessssssssesssssssssssssssnssssssssnnns cesssssessssssnneas . cessssessssnnssseses 32
JavaScript support in Adobe Photoshop CC 32
EXEQCULING SCIIPES cuvvvrerrceneincinnissensesssssesssssesssesssssessssssssesssssssssessssssssssssssesssssssssssssasssssassssssssssssssssssssssssssssssssssasssssasssssssns 33
INSTAIIING SCLPLS w.cveeerrerrirneisssesrirssesessssesssesssssssssssssssssssssssssssssssssssssssssssssssssessssssssssssssssssssssssssssssssasssssssssssssssssassssons 33
EXECULING OTNEE SCIIPLS cuurteirrerrererneissssssississsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssessssons 33
STAMTUD SCHIPTS corvererrereereereississisisssssessssssssssssssssssssssssssssssassssssssssssssssssssssssssssssssssesssssasssssassssssssssssesssssasssssssssssssssssnses 33
Object model usage anNd NAMING ......covrrrrinrineissesssissesssssssssssssssssssssssssssssssssssssens 34
Changes since earlier versions—CC changes............... 34
2 JavaScript Object Reference...... .35
ODbjJECt AESCIIPLIONS....veerverererrrisrirerssisssesssssssssssssssssssssssssessssssssssssssssssssssssssssasssssasses v sssisrens 35
Properties NOTAtION .......ricernenirineeseseeisesssssesssssssssssssssssssssssees detstee sttt sttt snas et nssassasssnaseas 35
AISPIAYDIAIOGS...ceuriurieeirrissiisrisesisesississesisssissesssessssssssesssssassssssssassssssssasassssssssssasans 35
Methods notation . . 35

(e (o] o JORSUINUIRN ceteteuet sttt st st R st st R s e R E et E et A et s s e R ARt b et R s e n s tensnas 36
ACTIONDESCIIPLON ettt sssssssessssasssassassassesanes eeveseesansseesaesanes 37
PrOPEITIES. ... euieeererrrirrisiersssssssssaserseasersssssssssssssssssssssssnsens ettt bbb b bR e st tens 37
count eetta bbb R s R Rt ne 37
TYPENAME ..ot aans 37
MELROMAS oo ssssssssssssesssesssssssseses ceetuse sttt s 37
ClAT ettt st as e sb s s eSS R R eRRaRRet 37

BFASE cuceeirirerinere sttt b s ss s s bR bRt SN 37
FTOMISTIEAIM ..ottt ss bbb e s s bbbttt 37
GELBOOIEAN ...ttt s s s tass st assbeees 37
GOECIASS wverrverrereeeeeeesasseasssssss et sssss s ssssssssesssassssssssesssassssssssasssssssssssssssssssssasssesssessssasssassssssssesssassssssssesssssssns 37
getData e R R R R RS S R S RS RS R RS R S R R S R R R S R R RRR R R RS R R R 0s 37
getDouble ceeeeserssissaanans . ceeeese sttt nees 37
getENUMEratioNTYPE ....reeeererereneeresesesessesesessessesesessessens . 37
GEtENUMEIAtiONVAIUE ...ttt ssssesssssssssees . 37
getinteger eetetetust sttt s R st R st R ARt R s AR SRR AR AR E R Rt R AR b e E Rt ee 37
GOEKRY .ottt esesss sttt e e R e RS bR bt 37
GetLargelNteger ... ceceeeererenerserseesessesesensessessennes 38
getList eeeueet ettt st a s s AR SRR SRR E e AR AR RS SRRsER SRR A e bR e R R0t 38
GELODJECITYPE ot sssssssssssssssssssssasssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssessssssssssssens 38
GOLODJECIVAIUE ..ttt s s s s ssssbsss s ssssbssssssssssssssssasssassssssssssssessssssssnssnsans 38
getPath ettt e s e e AR bRt e bRt A bbb ee 38
JELREFEIENCE ..t sssesassssssssasssaans 38
GEESTIING coutrneenceeerceieeiereeitsessesesessassessssssssssessssssssassasssssesssssasens N 38
GEETYPE curereereirrireisesessessesessssssssssssssssssssssasssssasssssssssssssssssessssssssessssssssssssssstsssasssssassssssssssssssssssssssssassassasssssssssnss 38
GEtUNItDOUDIETYPE .ceurrerreinrirerssissesssssisssesssssssssssssssssssssssssssssssses . 38
GELUNITDOUDIEVAIUE ...ttt sessissessssssisssasssssssssssssssssssssssssssssssssssasees 38
RASKEY ..ottt sisss s issssasesasesssssses ceetes ettt sttt 38
isEqual ceetue bR AR AR RS e AR AR bRt et 38
PULBOOIEAN ..ottt sssssssssssssssssssssssssssssssssssssssssasssasssssssssses 38
PUECIASS .ereeeetetrierseessseeestes st sasssssasssss s sss s sessassasssssssssss b s s b sassassssssesses s s basbassassessasssessstessesbensassassansanssnsens 38
PUEDATA «..ocvrvricieicenninnesssiesseisessssssssssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses 38




Adobe Photoshop CC

JavaScript Scripting Reference 4
PULEDOUDIE ..ottt ssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssassssssssssssssessssssssssens 38
PULENUMErAted ...t sesnessens 38
PULINTEGET c.ueeeeicrreneeiseeseseeisesesssesssessssssaees ..39
putLargelnteger .......vreenerennees 39
PUTLIST vttt tes st seassssssssssasssssssssssstsssssasssssssssssssesssssssessessasassessasastessessasassesssssssesssssssassessassssessessssassessassssnsns 39
PUTODJECT .. verreeeereiessisseneessessssssesssssssssssssssssssssssssssssssasssssssssssssssssssssssasssssssssssssssssssssasssssssssssssssssssssssssssssssssssssssssssssssssons 39
PULPATN ...t ssssssssss s s sssasssssssssssssbss s s sssssbssssssbsss b s asssasssasasssessssassessasessssasesssssassssssssnsons 39
pUtReference......rveeveecnsressennenns 39
PUESTIING c.eteteeireisiessesseisseseississsssssssssssssasssssissssssssssssssssssssssssssssssssssssssssssssssssssssssssessassssssssssssesssssassasssssssssssssssesssssassasses 39
PULUNIEDOUDBIE. ...ttt ssssssessss s sasssessassssssssssasssasssssassanees 39
EOSTIRAIM ottt ese e ess s es s e BBt et s et mene 39

ACTIONLIST..urereereieereisriersisisesesessssssssssssssssssesssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssssssssssssssssssessssssssssssssssassassasssssssasssssssssssssanes 40
PrOPEITIES ...ttt isssssisssssssssssssssssssssssssssssssssssssssssssssessssssssssssasssssssssssssssssssssssssssssssssssessssssssssasssssassssssssssssnssssans 40
COUNT ettt b st st bR b bR b bR bbb R bbb bR bRt bbbt bas b0 40
EYPENAME ..ttt sssssstastsss s sssssssssssssssssssssssssaens ..40
IMIEEROMAS oottt ssss s ssses s ssssssssssasssssss st b s st s b s s s s s AR s s s st R bbbt s nnes 40
ClAT ettt ettt sb s bbb bR R AR AR R Rttt R e 40
GEIBOOIEAN ...ttt sss s s s s s s s s s ER s R SRR R RS enR0 e 40
GEUCIASS cuvueerrerirsrereressissaessssss s st ssssssssssssssssssssssssssssssssssssssssssssssssssssssasasesessssssssssessssasssssssssssssssssssssssassssssssssassssnseness 40
GOIDATA ..ottt s s s s s Rt e et a R s 40
GEIDOUDIE .ot sissisesssessssssssessssssssssssssssssanns .40
getEnumerationType .......cocvcererrevrerrennennes 40
getEnumerationValue.........couuuun.... 40
GOUINTEGN .ttt sttt ss st as s st s ass s sttt b s s et s b e st s s st as b st asa s ssasessasesssssarssnsas 40
GETLAIGERINTEGEN ..ceeeeeerereereereeieieeiseessesesssssesessssasasssssssassssssssassssssssssssssssssssssssssasensssssssasesssssasessssssssssssssssssssssees 41
GOTLIST carieererectresicteesestessts st sssstsesssssssssssssssssssasassssssssassssssssssasssssssssssssssassssssssssssssssssssssssssssssssssssssssssssasssssssssssssenes 41
o114 o [=Tet f Y/ o 1= JSN R 41
GETODJECIVAIUE....coeveeeeeeiecercireessaesssessssessssessssssssasessssesssssessssesssssssssssssssessas 41
GEIPATN ottt s s s s s b s ss bR e s R R R R RS AR RS R R R AR RnR0n 41
GEIRETEIENCE .ottt st st s s s st e R AR RS sss b AeR e e et R s bass b et ennbenes 41
GEESTIING ottt issssssesssssesssasstsssssssssssssssssssssssabssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassassanes 41
GEETYPC ettt ettt e AR RSttt 41
getUnitDoubleType.....eeerrerneenn. 41
GELUNILDOUDIEVAIUE. ...ttt sasssessssssssssssssssssssssssssssesssssssseses 41
PUEBOOIEAN ...ttt tss st et sassasssss st s s s et s s ase s e b s st e b b e st bbb e e b assassansss s b s sansansas 41
PULCIASS covvrvrreriesrereresisssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssssssssssssessssssssssens 41
PUEDATA «..ocvrieirieinensesnesseiseississsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssssessssssssasssssssssssssssssssssassasses 41
PULDOUDIE ..ottt ssssssass s st sasssasssessans w41
PULENUMErAted ...t esssssans 41
PULINTEQET .ceueerncreecrceerseaensessissennees .41
PULLAIGEINTEGET c.cccuvreeeeiiereisriseieressisenseassssessessesssssssssessssssssssssssssssssssssessssssssssssssssssssssasssssssessssssssssassassssssssssessssssssssasses 41
PPULLIST coreereeirrenreerseesensiesseasessseasessasssessessssessessassssessesssssssesssssssessssssssssssssssssssssssssesstssssssssasssssssussssssssssssssssssassssssssssssssans 41
PULODJEC T coureerrereerersissessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssssssssssssessssssssnsons 42
PULPATN ...ttt s st bbb st bbb bbb et e s bbb e s R bbb e basntns 42
pUtReference. ... veeneeeneeneenesns 42
PUESTIING ettt tssesssesesesssssesss s tssse s essse et sss bt ass s asesss s bas s st b et sssesasesesssssassssens 42
PUEUNIEDOUDIE ...ttt sstssass s sst sttt assass st s s b s b b s sass s bbb et s s s s ansas s b s s sansas 42
ACHIONREFEIENCE .ottt sisssssisesisss s ssssesssssssssse s s s bR AR e bbbttt 43
PrOPEITIES ... eueereiseirisisisessesseiss s isssssssssssssssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssasssssssssssssnssssans 43
EYPENAIME .ttt ssesssasessesssssessssssssasssassasessessesssssssas .43
IMIEEROMAS oottt sasss s s s ssss s sasssssss st s st R b s s RS sRs e R s s R et een 43



Adobe Photoshop CC

JavaScript Scripting Reference 5
GEECONTAINET .eoeeeerrrirersisesesssiseasesssisssssssssssssssssssssssssssssssssssssasssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssases 43
GEtDESITEACIASS. ..ot sssssssssssasssessassanns 43
getEnumeratedType.... e ecnncnneenneennns 43
getEnumeratedValue............ 43
GOEF O Mttt sssass s s sssesssssessssssssssssssssssesssssasssssassssssssssesssssasasssssesssssessssssssssssssssssssssasessssssssssassaes 43
Lo 1= o F=1 0 =T TP OP TP P PSPPI 43
GEUINUEX ettt s s ssssssssssssssssss s sssesssssessssssassssssasssessssassssssssssasssnsssssssssssssssssssassasasssassssssnseness 43
getName................. .43
GEUOTTSEE .ottt bbb s e s e R bR s bR bR R bR e bRt e s e tn 43
getProperty ... cencrececesenennn. .43
PUECIASS .ereeeeeeterieisessseeestesere s tss s ssssss s s sss st s s bessasssssasssss s bes s sassassasssssses st esbessassssssessestessessessassansssssnsanssnssessassansas 44
PUEENUMEIATE ..ottt sstsssesstestss st tessssassssssssssssssss s sassassasssssses s s s bestessassasssesessessessassassssssnssnssessessassansas 44
PULIAENTI IO cuuvereerrrisrerrrssissssesssiss s isssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssesssssssasssssassssssssssssssessssssssnsens 44
PULINAEX vttt ssssssssssssssssassssssasssassssssssssessssssassssssssssasssessasssasssessssssesssessasssssssssanssassasssanssessassssssons 44
putName................ .44
PULOTSEE vttt sssassssssssssasssassssssasssassssssassbessasssass s ssssssass s ssassbasssessasesass s sassbasssesbanssesssnssanssessanssnsssons 44
PUEPTOPEITY .u.uriurerenrensenseiessesssssessessesssssssssssssssssssssesssssasssssssssssssssssssssssssssssssssssssssssassssssssssssssssssssssssassassasssssssessssssssssasses 44

APPHICATION ettt sss st s s s bbb e b e AR R bbb AR SR s AR bbb e b e A e sRen b s b st s benbaen 45
PrOPEITIES ...ttt isssssssssssssssssssssssssssssssssssssssssssssesssssssssssssasssssssssssssssssssssssssssssessssssssssssssssssssssssssssssnssssssssssans 45
ACLIVEDOCUMENT ...ttt sttt ssanens 45
backgroundColor.....eeecnreeneinnrens 45
DUII.ceo et sss s sssessssssssesssesssessssesssessssssssssssassssssssasssasssassssasssasssassssessssssssssssssssssssssssasssnses 45
COIOTSEEINGS eurvrrerrrerisreieressississsssessssssssssssssssssssssssssssssssssssssssssssssssssssssssessssssssssassssssssssssssssssssssssssssssssssssssssssssssssssssssess 45
AISPIAYDIAIOGS. ... cerererrirrrernsisrsississsississessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssssssssssssssssssssssssssssssssssssesess 45
AOCUMENTES coevtrereeeeeeeeseessetaseeease s sasse s s ssssebssessset st bsse b st R s R ettt bbbttt banes 45
fonts..... TP D TP P PO T PP O T OP T E TP OT TP EEOP OO T OO OT OO EOPEOPRUTOPROPRUROPROTRIN 45
fOregroUNdCOION ... ssssissssssssssssssesssssssssssssssssssens 45
FTEEMEIMOTY ..ooveerrerrerreeiseessesssessssessssessasssssssssssssssasessssssssasessssessanes 45
JOCAIE oottt ts s sb s ss st bR R R R R RS RaRRRa aeRneRRee 46
MACINTOSIFIIETYPES ...ttt sesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssons 46
MEASUIEMENTLOG «ecvuererereceereereaseseersesseesssasessssessnnes .46
NAMIEceirinieiiriseiesississ sttt ss st st s st bes s st bbbt b s b SRS E SRS bR E s S sEe bbb RS RbsRs bbbttt b b0 46
NOTIFIEIS oottt sssssss s bt s s s ssses s ass s s bR E SRRt AR e et bt s e es 46
notifiersEnabled..........ccoecuu...... 46
PNttt st e st s E e AR AR bR AR AR AR e b e e AR A e AR bbb e tas 46
playbackDisplayDialogs ......rinreeessrsssensssssssssens 46
PlaybackParameters........nernnsinrnsssssssssensssssssssens .46
PIEFEIENCES ..euveeeerrrtesrsrisstsssssissssssss s sessasssasssessens .46
PreferenNCESFOIAE ... s esssssssassssssssens 46
FECENTFIIES ..ottt s s s ssse s ssss s s bese s s s s s bbb sse e R e et nees 46
SCHPTINGBUIIADATE «....cevvveeerereeinirisssisssssisssssssssssssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssons 46
SCHIPTINGVEISION wcveeeetrererieeresietsesessssssesssssstasesssssssessssssssssssssssassssssssssassessssassassesassasssssssastasssssssssssssessssssssssssssssssns 46
SYStEMINTOrMALION ... ssesssssssssssssssssssens .46
L1877 2= 1T 10 11O 46
VEISION weueueeeureureuseusesssssesssessessesseastssesssssesssssesssessessessesssssssssssessssssssssssesstsssssssssssssssssssastssssssssssssssesasssssantasessessesssssssssssssaes 47
WINAOWSFIETYPES ...coumreeeerenerrerresesnaenssessssesssessssesssssssasessssesssssessssesssssssssssssssssas 47
IMIEEROMAS ...cvnveeeeeeneeins e essesasessse s s ssseessssssse s aass s e s bR bR RAsERRaasRa b a e Ren e basens et 47
DATCN ettt sttt AR ettt 47
DEEP ettt s R R R R AR AR R R R AR R ARt R bR ns 47
BIINGTOFIONT ...ttt sssss s sass s sasssassssssasssassssssasssanees 47
CharIDTOTYPEID. ... ceeeeeeereeeereerseessseessessssesssssesaseseas 47



Adobe Photoshop CC

JavaScript Scripting Reference 6
AOACHION oot s sss s s sssssssasssssssass s s s b s sssnbes e s s s bsse e e b s b b s s basn b s sssssnsnsens 47
eraseCustomOptions 47
EXECULEACHION .ttt ssessssssessssssssssssssssssssssssssssssssens 47
EXECUTEACTIONGET......eceeeeererereerereesessesesessessessesssssesssssseasesseasessssses 47
FEALUIEENGDIEM ...ttt s ssss s s s s s s s s s s s st sns s sasnes 47
getCUSTOMOPLIONS.....cvreerrerenrrserrensersersssesssessessesssssessssss 48
iISQUICKtIMEAVAIIADIE......errerrrssstsess s sssessesssaes 48
JOQ .ottt sttt e s a s s bR bR AR AR AR SRR R ARt bRt b ee 48
makeContactSheet........ 48
MakePDFPresentation ..........eensessennns 48
MAKEPRNOTOGAIIEIY ...t isssasssssssssssssssssssssssssssssssssssssssssssssassssssssssssssssssssssssssssssssssssses 48
makePhotomerge........ovensecneennes 48
MAKEPICLUIEPACKAGE ...ttt sssesssssssssssssssssssssssssassssssssssens 48
OPIENN cereieeereueesasessesstssssessesssssssasstsssssssssssosssssssssssssssasssssstsssssssssssssssssssssassssssssssessssssssssssassessssssssssessssssssnssssssnsssssans 49
OPENDIAIOG caceerereterrteirsinstsssssissssssssssssssssssss st ssssesssssssssssssssssssssssasssasses 49
11 [ [ 49
PULCUSTOMOPTIONS ..ccvevererrcrrrresieissssssssessssssssassssssssssssssssssssssssssssssssesases 49
FEITESI ettt ass s sssssbsseaes AR SRR ReeReRSesReesR AR n e 49
FEITESNFONTS ...ttt b s s s bt e b e bR ARt s s s b sssen b ten 49
runMenultem 49
SNNOWCOIOIPICKEN ..ot cesesesssssessesassessssssssssssssssssssssssssssssssssssssassssssssssssessssssssasssssssssssssssssssassssssssssssasssssssesess 50
stringlDToTypelD 50
LOGGIEPAIETEES ..uu e rereereieiseiseeeiseississsesssissssssasss s s sssssssssssssssssssssassssssssssssssssssssssssssssassssssssssssssssssssssssssssnsens 50
LY PEIDTOCRAID ... sssissesessssisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssesssssssssssnsens 50
LYPEIDTOSTINGID .ceeeerriirinriesinseiseissisississssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssssnes 50

ATTLAY RN ettt b bbb s s s RbR s R SRR b bR 53
PrOPEITIES .ttt essesssssesssesseasessessssse s s e ess et ss s s s bbbt e a s sse st s s ssss e sessaseasenseasassssss 53
AHLOCKE ..ottt bbb s bbb s b bR bt et R s bbb besn bt 53
DIENAMOAE. ...ttt ssssassssssssssasssssessssssssssasssasssssssssssssssssassssassssssssssssssssssssssssssess 53
DOUNGS ..ottt s s e e a s b s RS bR R R seERsab AR bR e s R baeee 53
DOUNASNOEFTECLS ...vereerreerreessessinsssssiss s ssssssssssssssssssssssssssssssassssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssssssees 53
FHIOPACITY . vvevveererereieseriseiseiesesisesissesssesssssassesssssasseassebasss st sas et s b st bsse et as sttt b st i s bssasasass 53
filterMaskDeNnSity ........cceeumereeesmeessnersseesssensanee 53
filterMaskFeather ..........cooovrrerrrerennnn. 53
GPOUPE .ervrerrerersiisesssissssssisssassssssssssssssssasssssssssssssssssssssssssssssssssssssssssssassssssssssssssssssssssssssssassssssssssssssssssssssssssssssens 53
ISBACKGIOUNGALAYET ...ttt sessssssasssssassssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasses 53
KIN .ottt sessssss s ssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssassssssssssesssssssssssssssssessassssssssssssssssssssssssanees 53
[QYEIMASKDENSILY....couevuereeiersriseiesssisessssisssissssssssissssssesssesssseses 54
[@YerMaskFEAtNET ... eeeeerseeieereceieressessessseesssessaessanes 54
linkedLayers......occveeereeernnens 54
DLAIMNEeeeeereeeereeeaeeessessesesstasesssssaseasesssssasessasssseasssssssasessssssseasssssssasesessssssssssssstasesesssssesssssssessssesstssssesssssessssesssssssesenens 54
OPIACITLY woeurereeureererensensisssessesssssssesstsssessassssssessssssssssesssssssssssssssssssssssssssssssssssstsssessssssssssssssssssssssssssssssssssesssssssssssssssans 54
parent eeeteaetet et sttt s h R e b et R et E ARttt E st e b Rt R et b bbb aes 54
pixelsLocked......... 54
POSItIONLOCKET ..ottt sasssasssensens 54
EEXEIEEIM ettt ss sttt s s s st R st et R Rt ene 54
trANSPArENTPIXEISLOCKEM. ...ttt sttt sass s sss s bbb sassassassasssssnen 54
TYPENAMIE .ttt sae ettt ettt bbb st sttt sttt et sets 54
VECLOIMASKDENSITY ...cvurreerererrreeresersssissssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssens 54
vectorMaskFeather ..o, 54
VISIDIE oottt st SRR 54



Adobe Photoshop CC

JavaScript Scripting Reference 7
XINPIMETATATA.....vve v ssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnsens 54
IMIEEROMAS oottt sis st b s e e bsse st e a sttt R s b 55
adjustBrightnessContrast................. 55
adjustColorBalance........coeeceneeereerenne. 55
QAAJUSTCUIVES ...ceereeisieeesseisssssssssssssssssssssssssssssssssssssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssens 55
QAAJUSTLEVEIS ..ot ssssisssssesssssssssssssssssssssssssssssssssssssssssssassssssssssssssssssssssssssssassssssssssssssssssssssssssssssens 55
APPIYAAUNOISE .. sssissesssssissssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssens 55
APPIYAVEIAGE cocceeerisrisesiseisesisssissisesassssssesasssanss 55
APPIYBIUL coer ettt i s sis s ssses b sase s s base sttt Rkt b sttt i 55
APPIYBIUIMOTE ..coeeeeeeeeeisesssississsssssssssisssssssssssssssesssssssssssssssssssssssssssssns 55
APPIYCIOUS ..ottt ssssissssssssssisssssssssssssssssssssssssssssssssssssssssssssssssasssssssssssssssssassssssssssssssssssssssssssssssess 55
APPIYCUSTOMEFIITET .cuverirrereirereiseississssessssisssssassssssssssissssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssess 55
AP PIYDEINTEIIACE ettt bsssess s sss s ssss s s s ss s b s s ssn s s s e b s s e ssanssasssssenseness 56
APPIYDESPECKIE .cueeeeriretiseiserisesiseisesassissesasesanne 56
applyDifferenceClouds 56
APPIYDIFFUSEGIOW ..cueereerrreerrirseesssiseissesssssissssssesssssssssssssssssssssssssssssssssssssssssssssenes 56
APP Y DS PIACE ccuetrrerrereirseissistisssissssssissssssssssisssssssssssssssssssssssssssssssssssssssssssssssssasssssssssssssssssassssssssssssssssssssssssssssssens 56
APPIYDUSTANASCratChes....cecererreiseseessissssssessssssssssssssssesssssssses 56
APPIYGAUSSIANBIUL ....ererrererrrererersssisssesssssssssssassssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssesssssssssssssens 56
applyGlassEffect............. 56
APPIYHIGNPASS .c.coeeeercercereeerernisesssesssesesssessssessssesssasessasesssaens 56
APPIYLENSBIUL ..o sesseississessssssssesssessssesssssssssssssssssssssssssssssssssssssssssnes 57
APPIYLENSFIAIE....eeeriertireseiseisseisesssissessessssissssssssssssssssssssssssssssssssssssssassssssssssssssssssssssssssssassssssssssssssssssssssssssssssess 57
APPIYMAXIMUM .t issessesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssessssssssssssssssssssssssssssssssssssssssssssssssssssens 57
APPIYMEAIANNOISE ...cverreeevrrerrisseiserssissesssssissssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssssssessssssssssssens 57
applyMinimum ......cccoecveeenn. 58
APPIYMOTIONBIUT ..ot issessssisstsessssssssssssessssssssssssssssssssssssssssssssssssssassssssssesssessssssssesssesssassssssssassssssses 58
APPIYNTSC oo eeereeereeeesssasssessssssssssssssssssssssssssssssssssssesssasssssssseses 58
APPIYOCEANRIPPIE .. erereirirrensersssisssssessssississsassssssssssisssssssssssssssssssssssssssssssssssssssssssssssssassssssssssssssssssssssssssssssess 58
APPIYOFFSEE ettt ss st sssssssssasss s s sass s s s bR bRt R s e a s bas bR sbens 58
APPIYPINCI ottt sesssss st s sssssss s s ssssssssssssssssssssesssssssssssssessssssssassssssssssssssssesssssssssssssens 58
apPlyPOolarCoordinates.......crnseuneeseresseesesssesssssssseens 58
applyRadialBlur ...... 58
APPIYRIPPIE oot ssssssssssssssssssssssssssssssssssssssssssssssasssssssns 58
APPIYSNAIPEN ettt issssssssss s s sssssssssssssssssassssssssssassssssssssassssssassssssssssesssssssssssssssssssens 58
APPIYSNANPENEAGES ...t ssssssssssssssssssssssssssssses 58
APPIYSNANPENMOTE ...cerrrsrirerssississssssssssssssssssssssssssssssssssssssses 58
APPIYSNEAT ettt ettt sttt s st as st saees 58
apPlySMartBIUr ... 59
applySpherize................. 59
APPIY YO st s R R R R RS R Rt 59
APPIYTEXLUIEFTlL.cerreeireerereisrisreresssissesssssisssssissssssssssisssssssssssssssssssssssssssssssssssssessssssssssssssssssssssssssssesssssssssssssens 59
QAPPIYTWIT Lt ssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssssssssssssssssssssssssssssssssssens 59
APPIYUNSNAMPMASK..c..ceeeerirririsristiseisesisssisssssesssssssesssessssssssesas 59
APPIYWAVE....cc et ssssssssssssessssssssessssssssssssssssssssssssssssssssssssnes 59
APPIYZIGZAG e wturerrrrerrrerrirererseeraerissenssessssesssasessasessssens 59
AUEOCONTIAST .. eecereeerereemseenerenseesessensseassesseessesssesssessesssesssessessstssesssesssessesssesesessesssesesesssassessessssessessesssssssasessesans 59
AUEOLEVEIS .ottt sasse b sssesbss bbbttt sttt 59
ClAT ettt ettt bbbttt 59
COPY cerrrreenernsensemsissenstssesssssessesssasesstsstssesssssssasssssastastsstsstssssssssssssesssasessssstssesssssesssssssastassasessssstssssesssssssssssassasssstsssssseses 60
Lo U OO 60



Adobe Photoshop CC

JavaScript Scripting Reference 8
AESATUIALE ettt sssssss s s s sasssssssssssss b s s ssss s s s s sass st ass e s R s asa b s b nssn b s s sasessss s sessssnssasassssseness 60
AUPIICALE ottt bbb s s ass s ess bt s s s A s R s bR bR e bR e sn s bass st entn 60
EQUANIZE ettt b st s b st sssbass b s e e b s e b e R AR R s s bR bR AR R bRt R e tn 60
INIVEIT oerteeiestsetsistssssessss s sstsssss s sstssssessssssssssssssesssssstssssssssastessssssssssessssasssssasassosssssassssessssssssssssssssssessssssssssssassassensassssensns 60
FINK erterrerereserssesssssesssssisssssessssssssssessssssssssssssssssssssssssssesssessssssssssasssssssssssssasssasssssssssssssssssssssesssssssssssssessssssssssssssessssssssssssssssons 60
INIEITC cuceuereureerrerreessessessesessessesssseaseasassssessessssessassssasessessssessesssssssesssssssessesssssssessssssesstssssssstssssasesssssssesssssssesssassesssesssssssenss 60
MNIXCNANNEIS ..ottt ssssssssssssssssssssssssssssssssssssssssssssssssssssasssssessssssssssassssasssssassssssssssssssessssssssssens 61
INIOVE....cueeeueeeneusentsssiessastasases s ssts st esssaseassstas s bt as st e ss st et st et as s bse s st s sst et as st ee s s bt et st et as st e sst et ass st seas st assstssasssesenssssases 61
PROLOFIIEEN oottt sttt sassssssasssassssssasssanees .61
POSTEIIZE et tssssesssss s tssssssssstssssssstsssssssssssssssssssssssssssessessssssssssssssssssesssssssassessssssssssssassassessassssnsns 61
FASTEIIZE ouueererererinereresseasesseissssesssssssssesssssssssassssssssssssasssssssessssssssssssssssasssssasssssassssssssssssassassasssssssessssssssssassassssssssssessssssssssasses 61
FEIMIOVE ... ceeeetreureerreasessssessensesssessessssessessessssessasssssasesssssssesssssssessesssssssesssssssessesssssssesssassssstssssssstssssssssssesssssssenssssssensssssssnn 61
FESIZE «.evereeurreeeuseessesseasasassasasssseasesssssassssassssessssssssasssssssassassessssssssssssasssssssssssssssasssssssssssssssssssssasssssssssessssssssssssssssens 62
FOTATE ottt ase st ss s s st sss s s s e b sttt as e b st st R bRt s e s A st b s Rs bRt as b st a st ssa s setnaens 62
selectiveColor ... e 62
ShadOWHIGhIIght ......ceeeeeecececeirececeereecesecesaennns 62
TNTESNOI. ...t asss s s st ssss b s s s s bss s sssabssa s e s s bR s s bbb s sssnssnsans 62
EFANSIATE vt bsssssesss s s assssssssss s s sssabsss st ssabss e sssaRsse s e R s R bR s R bbb bs st sens 62
UNTINK cottrtetrrieresetssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssessssssssssssssssssssassssassssssssssssssssssssssssssssssons 62

ATTLAYEIS ..ttt ssessassesse st b s sa s s st st R SRR bbb 65
PrOPEITIES ..ottt esse s s sssessaasessesssssesssssssasesssasessessssse st sssasasesessassssensessessesssssssassasensenseasessssss 65
LENGEN et srae s R RS RS SRR SRR RS0 65
PAENT ..ttt sstsssssstsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssessssessssesesssssssssesssess 65
TYPENAIMIE c..eeetrerestseasests st sssssessassssessesssssasessasssssssasssssssesstssssssstsssssssesstssssssssssasessssssssasssssasssssssssssssssans 65
IMIEBENOMS ..ot issesssssisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssesssssssssssssssssssssssssssanses 65
A ettt R AR AR AR AR R R R e bRttt aes 65
GEIBYNGIME ..ottt s e s ass st s s bbb s st b asse s bans 65
FEIMOVEAIL ..ottt s s bbb e s s bbb b e bbb e b A bbb e e s s b e banene 65
BATCNOPIIONS ..ottt s bes st aas st es s bes s a s s s e bes st as A E AR e A s R e e bbbt asbas s e s ansss b s bansensas 66
PrOPEITIES ...ttt ssssassssssssssessssssssssssssssssssssassssssssssssssssssssssssssssssssssasasssssssssssssssssssssssssessassssssssssssssssnsons 66
AESTINATION ot i s b ssss s s s s b s s b s bes s s s s b e s e bR bR e s b asn b s bssn bt ens 66
destinationFolder ..................... 66
EITOTFII ettt ettt s s s bR bbb a st bass e et bR bbb R bbb e e sn bt e 66
FHENGMING coeovrveirreseriecieeeeseesse s sssessssssssssssssesssse s s as s bR bR bbb essees 66
macintoshCompatible. 66
OVEITIAEOPEN ..t ssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssens 66
OVEITIAESAVE ....veeesresisressiss s ssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssessasssssssssssssssssssssssssesssssssssssssens 66
STAMTINGSEIIAL ettt et bbbt bbb e e ass e bbb s st be bt 66
SUPPIESSOPEN ... eerteerierisireiresssssssssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses 66
SUPPIESSPIOTIIE ..ottt ssss s s s s s s s sssssssssssse s s s ssbssessssssssasssasssassssnsas 67
TYPRNAMNE c.ceeeeteeerereeeseaseste e tsessessassssesseassssseasesssssasasssssssensessssessesssssasensessssesssssssensessssnsessssssenssssssssens 67
UNTIXCOMPATIDIE ettt ssss s sssssssssssssssasssssssssssssssssssasssssssssssssssssssasssssanees 67
WINAOWSCOMPATIDIE ...t sssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssesssssssssssssens 67
BitmapConversionOptions................ 68
PrOPIEITIES ettt eerss et essesss s sssessaasesse s s s s s ess e s s s s e b a s as b s s s s s s s s e seseaseasenseasessssss 68
ANGIC ettt R R SRR R R 08 68
FTEQUENCY .ottt st sssssssssssssssssss s ssssssssssssssssssssssssss s s ssse s s s s s s s s s s s s s s s ssnsssassnsssnssasassnnes 68
IMNETNOU ettt ass s s sssass bR b s s AR R s bR SRR AR R AR s R bRt Rnbanes 68
PATEEININGIMIE ... erieeeseseseisesesessts s esssssssas s ssssasassssssssssssssssssessssssssasssssssasssssssssssssssssessssessssssnsssssens 68
FESOIUTION ...ttt iertsss st tsssasstss st s ess st b s s s b s e s b st ass bR e b e s R e R bbb as At as e bt e banene 68
SN ettt SRS RS R AR AR e e 68



Adobe Photoshop CC

JavaScript Scripting Reference 9
TYPBNAIMIE ....eeecreereciersteteaesesssessessssesse s asssssasesssssssaas s s s s sss st s assssssstas s st sssssssesstasssssssssesssssasessssssssasssssssssnssnnes 68
BIMIPSQVEOPTIONS «.ccerveetsieississsiseessisssssissssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssssssssssssssssssssssssssesssssssssssssssssssssssssssassasses 69
Properties... ettt st st st A s AR RS ee AR Eee R s RS A e e R s R AR A RS R e R st e ARt b et b et ne 69
AlIPNACRANNEIS ... ssssssse s ssssssssssssssens 69

o 11 0] o OO P PR 69
TIDROWOIAE ...ttt sss s s ssssessassbasssessass s sasssssssssassbass s s e s s b e e b s R bass bR bbb e e e tes b e bes 69

OS TY P eeeeereeeeasisieasessssssesssss s assssssssassssassasasssssaseas s sssess s s aassas st asasasssstassse st asessssa st asssssstasesssssasessssssaasssssssssnssnses 69
rleCompression ........coveervene. 69
EYPENAME ..ttt sssstssssssstastssssssassssssssssssssssssassassssans .69
CameraRAWOpenOptions........cceeee... 70
Pl OPEITIES ettt st a s s sttt se st s et Rt E R et ettt e et nes 70
DITSPEICIANNEL ...t bsssssssssesssssssssssssssssassssssssssssssssssssssssssssssssesssssssssssssssssessssssssssssssssons 70
DIUBHUE ...ttt ssssss s ssss s s s ssss b s s s e s s s bss s s s s s e s e s ase s e b s s s s e b sasesssssessssssssnsons 70
DIUESATUIALION ..ottt st sassssssasssassssssasssanees 70
brightness .70
ChromMatiCADEITAtIONBY ......ceveereeirerreesseesssessssssessesssssssssssssssssssssssssssesssssssseses 70
chromaticAberrationRC.........cvveeenrneesernnernersssesesns 70
COlOrNOISEREAUCTION. ....cucverrrrrirreeeserissreseesssssssssessssasessns .70
COIOISPACE .. ertererereseissseessssiss s ssss s s s s s st s as b a s s e R s AR R bR st R R bR Rt et R e bRt ba e n e tn 70
CONTLAST ettt sttt sttt st s a st st s s st st s st sttt s b e s bt s st st as st asasbstassnbssassns 70
EXPOSUNE c.cemeincriisniessiesesisssstsssssssssssssssasssssssssssssssssassssssssenss .70
GrEENHUE ..o ttcrrceensesesssasesessseseens .70
GrEENSATUTATION wouvereecereneeeereemeresseesesseeseasraseessessesssessessse s s asstssssss s esses s s asseassesesesssessessessessastasssssesssesssesness 70
[UMINANCESMOOTNING ..veretrrrrreierssrsrierrsssersssssssssssssssssssesssssssssses 70
FERAHUEB .ttt ssss s s sss s ssss s ssssssss s sssebss s sess s s s sss s s s s e e sssasasasessasessasssnsassssasssesssssasssssssnsons 70
FEASALUrAtION ...ttt ssssesssasssessens 70
FESOIULION..cer et .70
SALUFATION eceeeeecereneecreseesensessssesesssesseasessesessnes .70
SEELINGS covureerrenrrseseseesesssisesssesssssesssasessssssssssssssssssesssssssssssessssssssssssssssssessssssssssssssssssssssssssssasesssssessssasssssasssssssssssssssssssssassans 70
SNAUOWS ..ottt assssss s ssssssssssssssssssbssssssssssbessssssssssssssssssssssasssssesssssnsesssssssssssasssssassssssssnssnssessssssssnsens 70
SNAUOWTINT cuuvrvevrrerrsississsessesrr s asssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssons 70
SNAIPINESS ...ttt tsssss st s sasssssssssasssssssssassssssasns .70
SIZE wreurrrreeurisrsesses sttt sttt st R AR AR AR A AR E e AR E A ee AR ARt E AR AR e e AR R AR R bR e Rt ten 70
temperature......eeeeeereesesesnsenene 70

BINT certereicreeceensesseisesssssessessessessesssssesssssssssssssssesssasessesssssssssssssasesssssssssssessssssssssssssssssssssssessssssssssssssssasssnsssssssssasssssssssssssanes 71
TYPENAIMIE .ttt sttt sttt s st sttt st s bbbt sttt sb e s et 71
vignettingAmount ................. 71
vignettingMidpoint ................. 71
WhiteBalance.....ererrrreenssrsseiseesesesssesseens 71
CRANNEL ..ttt b s bbb e s b e e b a e A b b A e b A bR ane bR ba s bt R e banetes 72
Pl OP EITIES ettt sttt sttt st et s st ettt et A sttt Rttt nen 72
CONON ettt s s b s s s e b s s ssss s s s s s s e RS AR s SRR R AR bR RO R AR R AR bRt R e en 72
RISTOGIAM et e s s s b st sss s bt sse e s s bR AR SR e R e A et Rse e Rt s snbnsnsns 72
KIN oottt tsss s s s s s s ssssbsss s ass st ass s e st e b s R s b AR bR bR A bae AR bae bt Rt ans b ennbanntens 72
NTAIMNIE. ... ceeeuenenrereeeeeneeessaseseeeesessasssssassssasasssssssssaststsssssssssssssstetessssesssssssatetetsnsssssssssstessssesssssssssstsssssssessssassssssossnsssessssses 72
OPACHTY cerrrerereimeenenetseestsessesestsessessssssssssssssssssssssssssssesssessssssesses .72
PAENT.c.oeeieeerreerireesaseersesasssssesstsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssesssssssssssessssssssssssssssssssssssssssssssssssssssssssonsess 72
TYPBNAIMIE ...eeecieireeierstsieastseessessesssesstasasssssaseassssasass s ssaas s st s assssssstsssssssssssssssssstasssssssasesssssssesssssssssssssssssssssnees 72
visible ceeteretase iR AR AR e RO AR R AR AR RS R AR AR AR e AR R R R AR AR bR AR bR R e en 72
Methods ceeturetssues et A A bR AR E SR AR R AR RS A e AR Ao AR AR R e A AR bR R bAoA bR et R en 72
AUPIICALE ottt b st b s bbb s as s s A e R bbb bR s R e b ns b bans b st s bass bt entn 72



Adobe Photoshop CC

JavaScript Scripting Reference 10
INIEITE ceceuueerieresreessessessassssessesssseaseassssssessessssesstsssssasssstssssssstssssssstsssesssssstssssssstassessstsssasssssstassssastsssssssssssesssssssassessssasssssssass 73
FEIMIOVE..u.uueeririrenriessessesssssssessessssssssssssssssssssssssssssssssssssstssssssssssssssssssssssssssssssssssassssssssssasssssssassssssssssssssssssssssssssasssssesssssssonsss 73

CRANNELS ..ttt st ss st b s s s s s e b s ss b aebenbsRe a b e b A AR Rs bR e e R ban bt Rt anbes 74
PrOPEITIES ettt s st st st b s st st st bt st st £t et e et ettt e bt 74
[ENGEN et s RS ER s R s R SRRt bR RER0s 74

PAENT .c.eeeireetreeerrtnesiseerseeasssssesstsssssssssssssssssssssssssssssssssssssssssssssssssssssssessssssssssssssssssssssasssssssssssssssssssssssssssssssssssssssssssessens 74
TYPENAIMIE .ttt sttt st st st bbbttt sttt sttt sb e s et 74
IMIEBENOMS ..ottt sttt s st sss s b s s b s st s s R bR e s e e bR e bt a s e s Rt s s tanbasn st 74
A e s s s RS R R bR bR R bR AR Rt an et R e en 74
getByName ..., 74
FEMOVEAIL ..ottt sssssssssssssssssssssassssssssssssssssssssssssssssassssssssssssssssssssessssssssssssssssssssssssssssessssssssssssssssons 74
CIMYKCOIOT cauerrerirenersnsisssssessssssssssasssssessssssssssssssssssssssssssssssssasssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssssssssssssssssssssssssassssss 79
PrOPEITIES ...ttt isssssssssssssssssssssssssssssssssssssasssssssssssssssssssssssssssasssssssssssssssssssssssssssssessssssssssssssssssssssssssssssssssssnssssans 79
BIACK ettt st s s bbb AR AR R AR AR At R et R et ARt 79

(03 2= ] OO 79
MNAGENTA ceuvererrnerserrsriasessesssssssessssssessssssssssesssssssssssssssssessssssssasessssssessssssssssesssssasess .79
TYPENAMIE ...eeeeeeeeereeeensteaesstaseess s s ssse s s ess s aas s st as st ss st as Rt a e R e st as et ase e st asessseseasesesssaserssnees 79

VERIIOW ettt sssssssssssssssisssssssssssssssssssssssssssssssssessssssssssasssssssssssssssssasssssssssssssssssssssssssassssssssssssssssssssssssssssssssssns 79
COlOISAMIPIET c.oeuerererrrissrerississssssisssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssssssssssssssssssssssssssssssssssssssssssssssssassens 80
PrOPEITIES ottt ss s st sss st s sse s s b s s st s st s st s st et st sttt s s bansans 80
CONON ettt st s s s bbb e s bbb e R AR AR SR RS A b e R AR R bR e bR et R e tn 80
position ..80
PATENT..ceerireeireeristesiseerseessssesesstsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssessssssssssssssssesssssssssssssssssssssssssssossens 80
TYPBNAIMIE ....eeeecieerectersesiesstseessessessssssst s asssssastsssssasass s s s s ass st s assssssstassse st s sssssssstasssssssasesssssssessssssseassrsssssssssnses 80
IMIEBENOMS ..ot sssss s ssssbssssssssssssss s s sssssssssssssssssssssssssssssssssssassssssssssssssssssssssssssasesssssssssssnssessssssssssens 80
INIOVE ...eieruenririessesssssssessssssssstsssssssessssssssssssssssssssssssssssstasssssstastssssssssssssssssasssssssassssssssssassesssssssssssssssssssssssssssssssassassssssssssnses 80
FEMOVE.....ceeerereeeenenenens ..80
COIOTSAMPIELS ...t sasesssssssssssss s sssssassssssessssssssesssesssessssssssasssassssssssessssesssassssssssssssassssssssassssssssssssasssassssssssesess 81
Pl OPEITIES ettt st e s s sttt b s st et se e st e ARttt bR n e testenen 81
LENGEN oot s s R AR AR AR bR R bR R s 81
PAFENT..c.ceuirreeerenrierseusesssessessasssessesssssssessessssessasssssastsstssssesstsssssastssssssssssssssssastassssssessssssssastassssssssssessssssssssssssssssssssassnsssans 81
EYPENAIME .ttt ssesssasessess s s s sssasssassasessessessssssas 81
IMIEBENOMS ..ottt bbbt b s s bbb s s bR A bbb bR bbb R e b b Rt ns s sassbanntns 81

= T Lo PO P TP 81
FEMOVEAIL ..ottt ssssssesssstsssssssssasssssssssssssssssassssssssssssssssssssssssssssssssessssssssssesssssssssssssssssessssssssssssssssons 81
CONTACISNEETOPTIONS ..ccverrreerrrrerrirnsirerssissesssss s sssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssens 82
PrOPIEITIES ... eueeretreirisississessessesss s ssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssssssssssssssssssssssssassssssssssssssssssssssasssssssnssssssssssans 82
ACTOSSFIST.uiuieerericrririeieisssiseissssssssesses st ssssssssssssssassssssssssssssssssasssssssssens 82
bestFit.....cccceerrrnnen. .82
CAPLION..cereeeerererrereesensenseaseneens .82
COUMNCOUNT c.erererirrsisnsisssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssns .82

FIATEEIN oottt ses s s s e s bbb eSS R AR R RS e AR AR AR AR bR R s 82

0] | PP OT TP TP OP RSP TOP PP 82
foNntSize..oereererrresrenres .82
height....ccccoveceuneenn. 82
NOTZONTAl ..ottt sensens 82

INOTE c.errererriersseesrssessssssssssssssssessssssssssssssssssssssssssssasssassssssssssasssssssssssssssssasssssssssssssssssssssessssssssssssssssssssssssssssessssssssssssssssons 82
FESOIUTION c..vuecteeteresiseesesesesssssssssssssssssssssssssssssssssssssessssssssssesssssssssssssasssssssssssssssssssssssssssssssessassssassssssssssssssnssssssssssssssnsons 82
FOWCOUNT ceucvurierinerenesssseseissssisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssessssssssassssssssssssssssssnsassasses 82
EYPENAIME .ttt ssesssasessess s s s s s saseasesssssesssssssens 82
useAutoSpacing............ 82




Adobe Photoshop CC

JavaScript Scripting Reference 1
VEITICAN courreeisresrseesssiss s sssasssssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssessssssssssessassssasssasassssssssssssssessssssssnsessens 82

WIAEN ottt s s bR bbb e bR e e e bbbt R e e bbbt 82
COUNTIEEIM ottt sss s bss s s sss st ss b s s b s s st s sss b s bt bes b b a s s e Rse R bbb ba e s snnasnssnbnes 83
PrOPEITIES ettt essesssssesssessaasessesssssesssssssasess s esse s s s s s e ase s e bssassesse st ssesssssasassssensesseasessssss 83
PPOSITION .ottt as s st aas s s s sas s s s s s s st ss s b st s s s s s s st essssas st en s s sastse s sasssssesasssssenssssstsssasesansananees 83
PATENT..ceerieeireerrtrtersesesrsserststssstsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssessssssssssssssssssessessssssesssess 83
TYPENAIMIE c.eeeererereetseaseetsssestssssssessassssessesssssessssssssasasssssssasstsssssastsssssssesstsssssssssssessssssssassssssssssssssssssssas 83
IMIEENOMS ..ottt s s s s s b s s st e st b s s e A s a b A s bR e e a et as bbb e et ee 83
FEIMIOVE....ueurrrerinriersessesssssssssssssssasssssssssssssssssssssssssssssasssssssssssssssssssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssns 83
COUNTIEEIMS c.oeeereneneaeaseneesessessesessessessessssssssesssssseasessesssssesssssesssessessessesssssesssessssssessssssssssessesssssesssssssssssesasesseasessessssssss 84
PrOPEITIES ...ttt ss st s st as s s st b ss st ss s b st a A b At E et e e R b b e e R bR bt R s e At es e et st st s e s astnsanaen 84
[ENGEN oot s R s R SRR SRR SRR bR R0 84
PAFENT..c.ceeieriererenricrsesressasssseastsssessessasssessesssssssassassssessesssssssesstessssssssstessssssssssssastassesssssssssastassssastassssssssssssssssssasssssssssssssosan 84
EYPENAIME .ttt es s bbbt et sa et bbbttt ne 84
IMIEENOMS ..ottt st st ss s b st s s bt s s bR et R s e bR e bR e et e et as s bt baeee 84

- T Lo ISP 84
GEEBYNAIME ..ottt it sssessssssssssssssssssssssssssssssssssssessssssssssassassassssssssssssssssssssssssssssssassassssssssssnss 84
FEMOVEAIL ...ttt sssssss s sssssssssssssssssssasssssssssassssssassssssssssssssssssssssssssssesssssessasesssssssssssssssssssssssssses 84

DS T _SAVEOPTIONS cecvereerrinirirsinserserssessissssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssses 85
PrOPEITIES ...ttt sse s s sssssssssssssssssssssassssssssssssssssassassssssssssassssasssssssastassssssesssssssssssssssassassonsssses 85
UGS ettt RS R R AERRRR Rt 85
eMbEACOIOIPIOfilE...rrirrrisrirerisssiseesssesesssssssasssssssenns 85
ENCOAING courrtrrirrrnrersniisisssesesssisssisssssessssisssssesssssssssssssssssssssssssssssssssssssssssssassssssssssssssssssssssssssssassssssssssssssssssssssssssssssens 85
NAITLONESTIEEN ..ottt s s s s st s s ass R e b st s s s b e s s s ten 85
INEEIPOIATION ..ttt s ssss s st ass st ass s s s e b s b s R s s s bR bR e s s s s bese b s s baees 85
PIEVIEW ..uuierreeriersensississsessissssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssss 85
EFANSTEIF UNCLION ettt sssssssssssssssssssssssssssssesssasassssssesasasassssssesssssnns 85
TYPENAMIE .ottt bR bR bR bbb 85
VECTOIDATA ...cuvurierererresersescisessessessesssasssssssssssesssssessssssssssssssssssssssssssssssesssssssssssssassassasssssssssssssssssssssssssssassassssssssssnss 85
DICS2_SAVEOPTIONS ceceereerrircierirsinerserssississssssssssssssssssssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses 86
PrOPEITIES ...ttt sssssssssssssssesssssssssssssssssssssssssssssssssssasssssssssssssssssssssasssssssssssssssssssssssssssessassassasssssssssnsons 86
ACS et s s s bbb s R AR AR AR AR R e AR R R e et R sttt e 86
€MDEACOIOIPIOfIlE.rrrrcersirerisssisesssstsssssssssessesasssanns 86
ENICOTING courrvvreernserraseerssrissessssesssssessssessssessssessssse st sesssessss e b e as R RS RS R RS SRR R b R R0 86
NAITEONESTIEEN ..ottt st s s s s s s s s RS s s s s s s sns b s e s s s s ssnses 86
INEEIPOIATION.coe ettt s s ss s sss st sssass s s b s s sss s s s s s s s asn b s e bssn s s s sasnssassssbanens 86
MNUILIFIIEDICS ..ot sssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssassssssssssssasses 86
PIEVIEW ...uuiereinirrsensessisssessisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssss 86
SPOLCOIONS c.eereerierreneiresessssssssssesssssassesssessssssssesssssssssssssssssssssssssassssasssesssessssasssassssssssesssssssassssssssasssssssssssasssssssseses 86
EFANSTEIF UNCLION ettt ssse s s s s sssssssssssss s sssasssassssssssasasasassssssasssssnns 86
TYPENAMNIE .ottt asssseasessssessessssaseasesssssasasssssssensessssessesssssssensessssesssssssensesssssnsesssssssenssssssssenss 86
VECTOIDATA ...cuiereeriereirriserssssissssssssssesssis st ssssssssssssssssssssssssssssssssssssssssssssssssssssssassassssssssssssssssssssssssssssssasssssssssssones 86
DICOMOPENOPTIONS ..cvrvrrnrninninerserserssissssssssssssssssssssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses 87
PrOPEITIES ...ttt sse s assssassssssssssssssssssssssssssssssssssassas s ssssssbasssessssssssasssssssasassssssssssssssssssassonsssaes 87
ANONYIMHZE ccucoreecrnircenianesesstaseessesessssstssesssesestsssasse st asse st sastasst s sas et ssebsse bR R s b st Rt s st et asse s ebass 87
CONUMINS .ottt essessss st ssse s s ssse s st s sss s s s s s bR bR a s s sasasssns 87
FEVEISE ..eereeeeereureessessesssssssessesssseasesssssasessasssstssssssssasessssssssassssssssessssssssssssssssssesssssstassssssessssssstasssesssssessssesssssssessesens 87

FOWS wereereresearesessaseasssssssasssssssssssssssassasssssssssssssssssssssssssasessssssssssssssssasssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssess 87
SNOWOIVETIAYS c..vurerrrrrsieneissiseississeressssisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssessssssssnssssens 87
EYPENAIME .ttt es s bbbt st b a bbbt bbbttt 0e 87
WINAOWLEVEL ... sssssisssssssssssssssssesssssssseses 87



Adobe Photoshop CC

JavaScript Scripting Reference 12
WINAOWWIATN .ottt sssssssssssssssssssssssssssssssssssssssssssssssssssssssesssssssssssssssssssssssssesssssssssssssasssssseess 87
DOCUMEBNT c.cceectrerectsetsesesssessessssessesssssssessssssssssssssssssassssssssssesssssssesssssssssssassssssssssasssssssssssssssssssssssssssssassssssssssssssssssssssssssssssssnss 88
Properties... ettt st st st A s AR RS ee AR Eee R s RS A e e R s R AR A RS R e R st e ARt b et b et ne 88
ACtIVECNANNEIS ..ot sesssessessssanns 88
activeHistoryBrushSOUrCe ......nesnenersersnsesensnns 88
ACTIVEHISTONYSTATE ..ceecrceireseseserseisesssssssssssssssesssssessesssssssssssssssssssssesssasessssssssnes ..88
ACTIVELAYEN .eeeeerecieereeieasestsessessesssssseasssssssssesssssasass s ssassssssssasssssssssesssssssssssssssssssasssssssasesssssssesssssssssssssssssssssseses 88
AFTLAY OIS ottt ss st bbb s s RR e ReRRseR sttt 88
backgroundLayer. 88
bitSPErChannel ... 88
CRANNELS .t ss st assssssssss s s sssssssssssssss s s s s e R s ssabss s s RS bR R b sen s e R s s sssasssssass 88
COIOTPIOfIIENAME ...ttt ssssssssssssssssssssssssssassenns ...88
COIOTPIOfIETYPE ettt st sss st s ssss s ssss s s s bass s s b ssessssbasessssaesssesbsse s st s s basssasssenssanns 88
colorSamplers.............. 88
componentChannEls........eeernsiensinssesssesssessesssenns 88
COUNTIEEMS et seeseaesseaessens .89
FUIINGIMIE ...ttt sessssssss s s s ssssssssasssssssss s s s s s s s sss s s ssse R s st R s s s s s ssssssasesssnsssnes 89
GUITES ccerreeieeeenseisnessssssassssssssssssssssessssssssssassssssssssssssssssssssssssssesssssssssssssssssssssssssssssssssssssssesssssssssssssssssssssssssssssssssssssssssssess 89
NEIGNT et s s s s bbb RS R AR bR R R b R ns 89
RiStOgram ......ecerneeesienreesssnesneens .89
RISTOTYSTATES ..uvveevreenrereerrieriseriessiesssessaesssssssssessssessssessesessassssssssssasssssssesssessas ..89
IO ettt esse s ssss s ssssssse s s s s s s R A AR AR RS R R R ARt 89
[QYEICOIMIPS oevvreereresissenssessessssssessssssssssssssssssssssssssssssssasssssssssssssssssssssssssssassssssssssssssssssssssssssssssssssssssssssssssssssessssssssssssssssons 89
JQYETS c.oerreersressessissssssssssasssssssssssssssssssssssssssssssssssssssssssssassssssssssessssssssssssssssssssssssssssssssssessssssssssessassssasssssassssssssesssssessssssssnsns 89
JQYEISELS c..vererrrrereressissesssssssssasssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssessassssasssssassssssssssssssessssssssnsens 89
MANAGE. ... irierererrsiesserssss st sssss s ssssssssssssssasssessasssassssssasssessssssssssassssssassssssans .89
measurementScale .....cernneeensennnnnn. 89
INOTE c.coterieereseeseeesesssssassesssssssssssssssssssssssssesssessssesssessssssssesssesssassssssssessssssssesssasssessssasssassssasssasssassssesssessssssssessssssssesssassssess 89
MAMNEetreeeeeereeenseessessesssesseasesssseaseesssessesssssssessasssssasesssssasesssssssessessssessesssssssessessssessesstsssssstasssssseasesssssasesssssssesssessssnsesessnne 89
PAFENT..c.ceeirieeerereerseasesesesseasisssseasessssssesssssssessasssssasssstssssesssssssssstsssssssssssssssesstassssssssstsssssastasssssssssssssssssssssssssassesssssssssssans 89
PALNce sttt R R R AR R AR R AR s R bR ns 89
PAthItEMS ... .89
PiXelASPectRatio ...o..covverrerreerrersrreens 89
printSettings......c.coecuu.... ..89
quUickMaskMode......eeeeeeerenrrerrnsensensennes ..90
FESOIUTION ...ttt issesesesstssssssssssssssssssssssssssssssssssssessssssssssesssssssssssssasssssssssssssssssssssssssesssssesssssssasssssassssssssssssssesssssssnsons 20
SAVE w.ouerieerieresissssesssssisssssssssssssssssassssssssssssssssssssssessssssssssssssessessssasssasasssssssssssssiesssssssssesss s asessesese s s sasessssensesnsssnsens 20
SEIRCHION .ttt sttt bbb bR bbb SRR R AR A E R e bRt Rt ens 20
EYPENAME c..erteeeceseesresesasssessssssssssssssssssessssssssssssassssssssssssssssssssssssssssssssssasssees .90
WIATN oottt bbb s s et s a s bR A s s bR bR e b s R e b e Rt e s R en 20
XINPIMETATATA ...ttt st sssses s st ass s a s st ss bbb e bas s s s bbb basbasssesaesassbsbessassansanen 20
IMIEBENOMS ..ottt ss s bssass s bsssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssssssnssssssssssasssasansssssssnsanssessssssssssens 91
QUEOCOUNT «.ccerreeereereresietsssssssssssssssssesssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssases 91
changeMode. ....vecnnienrnriiseinnnen, 91
ClOS Bttt AR R R AR AR R 91
CONVEIPIOFIlE e seseasensssanns 91
CPOP ctuturrnererrrsersesessssssesssssessssssssssssssssssssssssessssssssssssssssssassssesssssssssssssesssssssssssssssssssssssssssssssssssesssssssssssssssssssssssessssssesssssssssasess 91
AUPIICALE ottt s s sssssssssssssss s s s ssss s s s bsss s e s R bbb s R st s b s ase b n s seessnssasssesenseness 91
EXPOITDOCUMENT ....eeerrirrririnneeserssisersissssssssssssssssssssssssssssssssssssssssssssssssssnes .92
TALEEN ettt sttt bbb bR R AR AR AR AR AR AR bR bR e bR bt 92
FHIDC@NVAS «.coureeereevnrerraeesaseesasesssesessessssessssesssssessssessssessssesasssessssesassssssssessssesesss s s bR bR R bbb e bbb ssansssas 92



Adobe Photoshop CC

JavaScript Scripting Reference 13
IMPOTTANNOTATIONS «.ccveeereicreenrerieersensiersessesisssessesssessessssssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssass 92
MEIGEVISIDIELAYEIS ....eeeeiereeiseeiretiseisesesssiseesesisssissesasesassssasssasens 92
PASTE .ttt ettt st s E s s R s R SR st s R E AR s s E Rt e b sttt 92
PIINT coeeetetreteeeiseeesessessessessssesssssessessessessssssssssssssssssessessessesssssssssssssasesstssesstssssssssssesessessessesstssesssssesssssssasensessessesssssessssasses 92
PHINTONELOPY c.ouvverereurererserersesssssessasssssssssssssssssssssssssssesssssssssssssssssssssssssssssssssssssssssssssssassssssssssssssssssssssssssssssssessssssssssasses 92
FASTEIIZEAIILAYEIS couuveerereerrsreeessenessssisssssssssssssssssssssssssssssssssasssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssessssssssssssssssons 92
recordMeasurements........ceeererererernsennes .92
resizeCanvas......oee. .92
FESIZEIMAGE c..ueuirrerrercreiresestsesesssssssssssssssssssssssssssssssssssssssssssssssssssases .93
FEVEAIAIL ..ottt ssssessssssssssssssssessssssssssssessssssssasssassssssssasssessssasssasssassssesssssssssssssssssssssssssasssnses 93
FOTATRLANVAS ...cvureeururenserresesssssesssesssssessssssssssssssssssssssssessssssssssssssssssssssssssssassssssssssssasssssasssssssessssssssssassassasssssssessssssssssasses 93
SAVE ..eeeeeuseaeeesseusesssseasessssssseasassaseasasssstas e st a s e AR RS R SRR SRR AR SRR RS ERe AR AR AR R AR R R AR Ren 93
SAVEAS c.cceeeeretrenrestseasessssssessasssessasssssas s s s st st as st R s R RS sRsEASER AR R RS R e AR R ARt R AR R e ARt een 93
SPHECRANNEIS ... s s s s sssasssessens .93
SUSPENAHISTOIY ...cuviieeieerereeieteseeesetiseissesssisssissssasssissesssesssssssssssssssssssssasssssanss 93
L] © J OO PRO 93
EEIM ettt etecieceieeasesseasessssse s sess e esseassasesssssesssssssestassssessasssssesssssssasesssssassessasssssstssssssssessesssssessssssssssssssssssssssssssssssesssssssssssssaes 94

DOCUMENTPIINTSETIINGS ..ovuveeererenrensiereiseeisessesessesssssesssssssssesssssessssssssessssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssessssssssssssses 96
PrOPEITIES ...ttt isssssssssssssssssssssssssssssssssssssssssssssesssssssssssssasssssssssssssssssssssssssssssessssssssssssssssssssssssssssssnssssssssssans 96
backgroundColor........crnereneieneennes 96
bleedWidth ... .96
CAPTION.cceeeeeeeeerereeerseersesseaseasess s st s s asssestsseasessasssssssssssssasessassassesstssesssssssessssessesstssesssssesssssesasessssnesseastasesssssessssassaes 96
CEONEEICIOPIMAIKS ....eoeeeveresisissssessesssstesssstessssassassassssssssssssessessassassasssssssssessessessessessasssssasssessessassassansassassanssssessessessanes 96
COIOIBAIS vt isssss st ssssss s ssssssssssssssssssssessssssssssssssssssssssasssesessssassssssssssssssesssssssssssssssssssassssssssasssssenseness 926
COPIES curereerenreerseasisessasesssssstasssssssassssssssssssssssstasssssssasessssssssssssssssassssssssssssssssssasssssssssasssssssssssssstssssssssssssesssssssssssssssssssss 96
COMNEICIOPIMAIKS c.cecvverererrrersinstsssesssssssssassssssssssssssssssssssssssasssasssssasns 926
COlOTHANAIING oot essesssessssesssssessasessssesssssessssesssssssssssssssessas 96
QACTIVEPTINTEL ettt sssessesss s s easesss st sssssssssasessessesseasesssssssestasessasssssessssssssnesseaseasesssssesssssssases 96

Tl ettt ses st ass s bbb e bbb AR R AR R AR AR bR bR bR R AR R bR bR bR bR bR bRt 926
NAIAPTOON ...ttt s bt sssss s s s e e bR b AR bR a s e s R s e e b bt s s en 96
INEEIPOIATE oottt sssssss s ssse bt sssbsss bt s e s s b s R s AR A s R Rs R e bR e Rse e R b s s basntns 926
JADELS oottt st s st s AR bR AR AR AR ARt st R bRt 926
MAPBIACK oottt sssssisssssessss s ssssssssssssssssssssssssssssssssssssssasssssssseses ..96
NEGATIVE ..ot sseastasessse st ss st asse s s s b s bR bR bbbt s n st s 96
FENAEIINTENT c.vueerreeiriesreserssiseessssessssissssssssssssssssssssssssssssssssssasssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssssssssons 96
PPOSX cureertererenriseessesesssssessasssssasesssssssessessssessesssssssessssssssssssssssssssstssssssssessssssssssessstassssssssstssssssssassessssussassesassssssssssastassssassssssans 96
PPOSY eetrerenristessessssssessasssseasesssssasessasssessesssssasesstsaseastssssssstsstssssasstsssse s s et R s AR s Rt R AR st u s E st e s se bt eeae 96
PIINTBOIAEN ...ttt ssssass s st sasssasssessans ..96
printerName ........oveeeevevrersensenensennes .96
PHNTSPACE c..eeeenrerenrenrerensesessesesessesssssesssssssssssseasesseasessssseses ..96
FEGISTIATIONIMAIKS.....concunrenceueerrreareesseeiasesssesssessseesseess s sesseesssebase s ssssesasesssessasesssessssssssesssessasesssessssesasesasssssesasesssess 96
SCALE ettt SRR bR AR AR AR AR R R bR R bbb ARt es 97
VECTOIDATA ...cuieeereerersriseissisessissssssssesssssessssssssssssssssssssssssssssssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassassasss 97
Methods ............... ceetuestssae st e Re bR AR R AR SRR R R AR AR bR R AR R AR AR Rt R st At 98
SEIPAGEPOSITION....cec ettt sssessessesesseasesse s sssssssssessessenseasessssss 98
DOCUMEBNTINTOD c.ceerierreeiriireeissiesssesassssssessssssssssss s sssssssessssssssssssassssssssssssssssssssssssssssssassssssssssssessssasssasssessssssssesssasssssssssssssssses 929
Pl OPEITIES ottt st a s sttt s s s et s st st ARttt ARt s n bt nee 99
QAUENOT ettt ssse s s st sssssssssssssssssssssssssssssssssesssssssssssessssssssssssasesessssssssssensssesssnsssssssssssssssssssassssssssasasssssseness 99
QAUENOIPOSITION couuteecirreeressissssessssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssseess 99
CAPLION..rrcrrercieseereaeans ..99
captionWriter ................. .99




Adobe Photoshop CC

JavaScript Scripting Reference 14
CATEGOIY ceeereeerenriceeasesiessesssssstasassssssesssssastasssssssasesssssssassssssssasssssssassssssssssassssssssssssssssssasssssssssesssssasesssssssssssssssssssssseses 99
CITY ettt sttt bbb s eSS RSt b st 99
COPYHIGNEE ettt sssesa s st asssbssesassssssssssesasess .99
COPYHIGNINOTLICE e eereirecresisssesesesesasssesssssssanns 929
country eeeeeeees st s R e E R e E R et E et e st as 99
CrEATIONDIATE ... eueeererereicieiciseseisesesseasssssssssssseasessaassssesssssssssssssssessasssssesssssesssssssssssssassssssssssssssssssssssssssasssssssssssssanes 99
CIEAIT cuurrurerreressesissssssssssssssassssssssssssssssssssssssssssssssssssssssssssssssssessssesssssssssssssssssssasssessssasssssessssssssssssssssssssssssssssassssssssasasssssseness 99
EXIf cerurteertretss s stes st s bbb R AR R A SR AR AR AR AR R e R R bR AR b et R e en 99
headline veereesrnsrensaeseaens ettt e R e AR A e R et s R et tR bR ns 99
instructions rreeeeenseaensntaees ..99
JODNGIME .ottt bssssssssssssss s sssssssssss st ssssssesssassssssassssssssssssssassssssssssssssssssssssssesssassssssssssesssasons 99
KEYWOIAS...ouverrereisrisisneessesssissssssssssssssssssssssssssssssssssssssassssssssssasssssssssssssssssassssssssssssssssssssssssssssssssssssssssssssssssssessssssssssssssssons 99
ownerUrl..enneennnnn. . st st bas b ase s e ees 99
PAFENT..c.ceceierieeereriersessisiseasesstssssesstsssssssssssssssesssssssssssassesssesssssssssssassssssssssssssssssassessssassssssssssassessssssssssssstsssssssssssssssassnsen 100
PrOVINCESTATE ...ttt isssssssssssssssssssssssssssssssssssssssssssssssssons 100
0 U of R ettt bR RS seS R SS R S R s RO e b bRt st 08 100
supplementalCategories eerteersrs s aesees 100
EIT1E cruretre ettt s st s s s s s s R RS EsRER HERER R R AR RS R R sRe 0 .. 100
traNSMISSIONRETEIENCE ...ttt ssss s sssssssssassees 100
EYPENAIME .ttt ssesssasessess s s s sssasssaseasaasessessessssens 100
urgency SR . 100

DOCUMENTS ...eeeeeereeninreneeesseessensesensessessesssssssssssssssessessessssssssses . . 102
PrOPEITIES ...ttt sttt sttt sttt et st s st st st st s st et ensst st s sstastassenassastnsatans . 102
LENGEN oo s s AR R R R R AR bR bRt R bR en 102

parent veeeeeeaseasanrenanes setetetuse sttt sttt R AR R R e s a et ne 102
EYPENAIME .ottt sssesssasessess s sssssssasssassasassensssssssses 102
Methods .............. ettt et e sttt s e e s Rt an e . 102
QA s .. 102
GEEBYNAIME c.cereereisrieieicinessesesesssssesssssssssssssssassssssssssssssssssssssssssssssssssassssssssssnes . 102
EPSOPENOPTIONS c.ccvereeiererrrirereissississsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnes . 103
PrOPEITIES ...ttt ssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnsons . 103
antiAlias.....oeeererrveerenenen. . . 103
CONSEIAINPIOPOITIONS .ouceeeereereiereneeseseeeesessesessesssssesssesssssessessessessssssssssssssseaseasessesssses 103
PEIGNT oottt ssae b sss bbb R SRR RS RS R AR 103
mode.... creersersseissaasans . 103
resolution ceerserssaesssssssens . . 103
EYPENAMIE ..eeerenrerresseseesssaseessessessssssssasesssssaseasssssssssesssssassasssssssassassssases . 103

WIER ottt ss b ssses s b sases st bsss bt s ssbasesasess .. 103
EPSSAVEOPTIONS....cuereeeeerereerereeeeseseensensenesssssenns . 104
Properties.......ccccoveveuees . 104
embedColorProfile.................. 104
ENCOAING courrrrrerrrrsrsressrsssssesssssssssens . 104
halftoneScreen........ cersreens e saseseansees . 104
INTEIPOIATION. ...ttt sssesssasssenees 104
PIEVIEW ...eueeererecereresenseasessenssssesssssssssessessessesssssessessessessssasessessessssseses 104
psColorManagement. cerreesesnessrasesanes 104
transferFunction.........ccoeeuen.... 104
traNSPAreNtWhIteS......cerveirernsrreissrisssseessssssssssssssesssens 104
EYPENAMIE ...eeeeereereeiessesesaseasesssessessssssssasssssssaseasssssssassssssssssssssssssssssssssases . 104
VECTOIDATA . ..veeercrrenrierseisesiseisesesssessessssssssssesssssssssssssssssssssssssssssssssssssssssssssssases 104

EXportOptionsIUSTrator ........eneeeseeseeeeseseesenesneenne 105



Adobe Photoshop CC

JavaScript Scripting Reference 15
PrOPEITIES ...ttt issssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssnsons . 105
path veerre st tenrans .. 105
pathName............. 105
EYPENAME .ot sssssssssssssssssssssssssssssssassssssssssssssasssssssssssssssssssasssnes 105
EXPOrtOptionSSAVEFOIWED ...ttt sassassassasssssenes . 106
PrOPEITIES ...ttt sttt st ss sttt s s bbb et s st as st e s st ss b s st astassenassastnsatans . 106
DU ettt s s sssssssssssssssssssssssssassssssssssessssssssasssssaees . 106
COIOTREAUCTION ettt st s ssssssssssssesssassssssasssassssssanns 106
colors... .. 106
dither....eneneee . 106
AItREIAMOUNT .....eerirersereissiseissississsessssssssssssssssssssssssssssssssssssssssssssns .. 106

(0] 40T | ST .. 106
INCIUAEPIOSIIE .ottt sass s ssass s sssss s ssssssssssanssassssenns .. 106
INTEIIACE oottt bttt st sessesssasssanees .. 106

[OSSY wreuerureeireinsesisseisesssesssesissessssssssasssissssassssssssasssssens .. 106
MALECOION oot ssesesesssesssesssssassssssssssssanes 106
OPLIMIZEA ettt s s s s ss bbb bbb ass s assassssens .. 106
PNGS.....ovrerrrrrrrnseissrssesssssesssssssnns .. 106

Lo [V L1114 . 107
ErANSPATENCY ...ttt sssssesssessaasessesssssessssssssssssssseasesssssssseses 107
tranNSPAreNCYAMOUNT .....cociececerereenersteesersessesesessessesessssessses 107
transparenCyDIther ... reeceeeeeceeresennns 107
EYPENAMIE c...eeeeeerenreeeeeseseesssaseessesseasasesseasesssssaseasssssseasesssssasessssaseasssssssases . 107
WEDSNAP ottt ssssssssssssssssssssssssssssssssssssssssssssssssssssassessssns . 107

L@ rtureeerereeereretssessessssssssssssssssssssssssssssssssssssssssssssssssssssasssssasassssssssesssssssssssssasssesessssssssasssssessssesssssessessssassasessssssssasasesesssssssssensassens 108
FOIART cuuerteeetrrtse ettt s sttt bbb s s st eSS Ae bbbt e bR bbb R bt R e b s s baeee .. 108
GalleryBannNerOPLiONS .......oeeeereeeneesseessssassssssssssssssssssssssssssssssssssesssssssseses .. 109
Properties... . . 109
CONTACHINTO coureeeerrereeeseeeers st ssss s sssssssssssssssssssssssssssssssssssssssssassnnes .. 109

[0 11 (OO .. 109

FONMT ettt e s e b s s s bR s e e b s s e s s b tan .. 109
fontSize....oveeverererenrenres .. 109
photographer.......oecnseensinnes 109
siteName 109
TYPENAMIE c.ceeeeeeeeeeeeerseseesseaseessessessasaseasesssssaseasssssseasesesssassssssaseasssssssases . 109
GalleryCUSTOMCOIOIOPTIONS .....cveeerrrrierisrisssssisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssessens 110
PrOPEITIES ...ttt sssssssssssssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssensans 110
ACTIVELINKCOION ottt sssssss s ssssssssassbessssssasssessssssasssassssssessssssssssassssssssssasssassssssssssassasssssnssssanssanees 110
DACKGIOUNACOION ..ot sssessssssssssssesssssassssssesssssssssssssssssssssssssssssassssssssasssasssessssssssasssasssss 110
DANNEICOION ettt bbbt s s s e e bR bbb a s bt ase A b e bass b s e bans s banes 110
[INKCOIOK cuttetseseseieseetsstrs st ass s es s s sasssssasssss s bbb s e s s s s ass s bbb et b b as e a R s R et basbassaseanssstessentas 110
EEXECONON courtrereerssrisssessississssssassssss s ssssssssssssssssssssssssssssssssssssssssssssssasssssssssassssesssssas sesssssssasasssssssssssssssssssssssnssssassssnnes 110
TYPENAIMIE ...erterietrereetsesestesseassssssesstsssssssasassassasesssssassasesssssasass s saseas e st sasesssosssa st sasessssssstasssssssassassosassassssssanes 110
ViSTEEALINKCOION. ...ttt sssss st s tasssss s sasssssssssssssssssassbesssssssssbasssssssssssssassssssssssssssassanssssssessassanees 110
GaAllEIYIMAGESOPTIONS ...eeevererrrrserrnseesssessseesssesssssssssesssssssssssssssesssssessssssssesssssssasessssesssssessssessssesssssssssessassssssessasasssssssanens 111
PrOPEITIES ..ottt st es s sssesssasssasessess s s s s essaas s s s s s e R bbb s st s R s s e s baseaseasassessnssnsss 111
DOIAET ot s s sssssssssssssssssssssssssssss st asssasessssassssssss s s sssasssassssssasssssssssssssssssesssassssssesssns 111
CAPTION ettt tsts s tss st sass st e sssssesssss st asass st ase s b s s st R b s st ase A st st s ee st s ess s s s st asbsssssasesssnastasssssssanen 111
AIMENSION. ettt ssss s sssssss s sssstssssssssss s s s sessbsssssassss s s s sass e e ssnssasssa s e e basssesase b ssssssnsnsssnsanees 111

FONT ettt st s b s s s bbb bR R R AR e R AR AR AR R e Rt R ettt 111
FONTSIZE ettt s bbb e bbb s bbb A e e R s b bR et bRt s s 111




Adobe Photoshop CC

JavaScript Scripting Reference 16
IMAGEQUAIITY ..vevrvrresrrrecrersrssessserssssssssesssssssssssssssssssssssssssssssssssssssssases v e s a Rt nnees 111
INCIUAECOPYIIGNT ettt tssesisssbssessses s sttt bbb st b s bsse st basasasasanss 111
INCIUAECIEAITS c.vvurrerierrereressiessrssssss s ssssssssssssssssssss s sssssass s sssssasssessssssssssessssssassssssasssensasssasssessansssssssssasssanssnssanns 111
includeFilename.........coouvn. reeeseaser st s i sasees 111
includeTitle ceeteretst iR RS R SRR AR R SRR R AR RS RS E R R RS R AR R0t 111
NUMETICLINKS w.veveveviriereisserssienseeesssssssisssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssssssns 111
FESIZECONSTIAINT ouceureeerrrirerssietssessessesserssissississsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassassssssssssnssnses 112
FESIZEIMAGES ..ereeeeereerienreeresstsesesisessessesssessesstsssssstssssssesstsssssssassssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnas 112
EYPENAIME .ttt ss s sttt bbbttt bbbt bbb bbbttt as 112

GAIIEIYOPTIONS....courreenrcersserrsseeesseessessssesssasessssesesssesssssssssessssessssessssssssssessssessssssssssessssessssesssssessssessasessssssssssessasesssssessasesssssssssnens 113
PrOPEITIES ettt st bbb st st ss s e e b st R bbb Rs et s et e b e Ae bR eE A ARt E bttt et b en e as 113
AAASIZEATIIIDULES ..o everrieiereieenserseisesessssisssssssssssssssssissssssssssssssssssssasssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses 113
DANNEIOPTIONS ..ot ssssssssssssssssssssssssssssssssssssssssssssssssssssessssssssssssssssssssssassssssssasssanns 113
customColorOptions.... 113
EMAIAAAIESS ...ttt sttt sssassess b st sss st a s b e s e s b ass b e bRt as bR et R s bt s e banen 113
imagesOptions ettt SRR R RS RseRasssRnReRetes 113
includeSubFolders .......neeniennes ceetase iR AR RRER s R R R AR RS Rt R s RS R e AR s 113
layoutStyle.............. ceetseet iR RS s e R R R R R ER R R R SRR R R RS R R AR R R R0t 113
preserveAllMetadata ceerserss s sssassens ettt st et Re bR R bR anrans 113
SECUTTEYOPTIONS eccureereveeiereenrerseeseessessetuse s essetasesssessetasessstasstss st sas st sse et ss et sse bttt skt b s bt sasessesasesanees 113
ENUMBDNATOPTIONS c.u.eoerrrrire ettt sssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssssssssssssssssssssssssssasssnes 113
TYPENAMIE ..t bbb R R bR R R R R bR 113
USEShOITEXTENSION ...euveveererererneerernnas OO TP PEOE PP TP OPEOTPOTOROPRRION 113
USEUTFBENCOMING .vurererereinreerneississssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssans 113
GallErYSECUIEYOPLIONS «.euverevrrerrereisrissssssississsssissssssssssssssssssssssssssssssssssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssessens 114
PrOPEITIES ottt sessesss st assssssssasssssssssassssssssasssssss s bsssss st s sssssbasssssassssssssssssesssssessssessssssssssssssssssneas 114
content . ceet iR R R ARt 114
[{0] 2} S eeetestst sttt ettt E ARt b et a s s R R R tenen 114
fONESIZE.ceereeerrrrre et rsssesssssessssas s sssssssssssssssssssenes cerersessees s sansaanes 114
OPACILY .veceeereerrennene reeeeesraseeneasesaeasens eeeereeasesesnaseaseasasnaes 114
TOXE ettt ettt st s b Rt E bbbttt st e s s eeas 114
textColor ... ceetreetss e et Ree e e A e et a s bbb e bR R 114
EEXEPOSITION ettt sss st as s s s s s et ess s s s bbb ss s s s s b e sasesseasessessessssncs 114
LEXEROTATO ...ttt ss sttt ss s s bt aase st s s s st b e baseasease st ssnsnsacs 114
typename................ seeereea ettt et R R R R R s a R Rs e st aeas 114
Gallery TRUMBDNAITOPEIONS ... rerireerrrrsisrsrsisssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssessens 115
PrOPEITIES ... eueeretreisisisiesenseeseissiseisssssssssssssssssesssasssssssssssssssssssssssssssssssssssssssssssssssssssssasasesssssssssssssssssssssssssassssssssssssssssssssssnsans 115
DOIUEN ottt ss s ass bt b ass s ss b a s bR e Rt ase A bt Rs bR bt R e e b tans 115
caption reetetaet e R AR AR R R RS se R E s R R Rt es 115
columnCount........ ceets et s st eeveees ettt s tanen 115
AIMENSION ettt sssssssssssssssssissssssssssssssssssssssssssssssssssssssassssssssssesssssssssssssssssessssssssssssssssssssssssssssssssssssess 115
FONL sttt st b b s s e s s e R A e R e AR AR AR RS AR AR A AR e bRt en 115
FONESIZE .ottt s s s s s e e ss b sss bR SRR R SRR A AR e et en 115
includeCopyright ceetree s bR et aenbannen 115
includeCredits TP OT OO TP OPEOP P TP O OPROPEUEOPROPEPROPROPOPROPION 115
includeFilename.........cooevun.. eeeeees ettt ntanen 115
INCIUAETITIE oot ssssssssssssssssssasssssssssessssssassssssssssssssssssssssssssssessssssssssesssssssssssssssssessssssssssssssns 115
rowCount........c....... . ceereeeerssassassaeaes ceerseeerssssassaserniaes 115
SIZE weerereerrereersesesssensesrssseaseaes sttt sttt E s AR RS st E s Rs e R AR AR s Rt e s se R et ensstan 115

1877 7= T 0 11O 115

GIFSaveOptions ettt e R R ettt as 116



Adobe Photoshop CC

JavaScript Scripting Reference 17
PrOPEITIES ...ttt issssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssnsons . 116
colors... . 116
dither..eeeeneee . 116
AItNEIAMOUNT ..ot ssssssesssssassssssssssssssssssssssssssssssssasssnes 116

0] el =T BSOSO P ST TT 116
INTEIIACE oot ssssisssssssssssssssssssssssssssssssses . 116
Matte....cvveeerrrenenne . 116
PAIETEE ettt s s ssssssaens . 116
preserveExactColors....nrnnennns 116
TrANSPATENCY ..t sssssassbssssssssssssssssssssass 116
TYPENAMIE c.ceeeerenreeeenseaseesssaseessessessasssseasesssssasesssssssessesesssassssssasessssssssases . 116
GrAYCOI0N . iirrirriseisseiseissesessssisssisssssssssssssssssasssssssssssssssssssssssssssssssssssssssssssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssess 117
PrOPEITIES ... eueeretreieirinsisenseissississsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnsans 117
GFAY ceeirinicininierissiessssissssstsssas s sttt st st bR bbb b0 117
EYPENAME c.iiririirciirertsiersstssssssssssstastsssssaasssssstassss s ssssssssssssaess 117

GUIE ettt sas s ssse s s RS s s R RS R ettt R bt . 118
PrOPEITIES ...ttt sttt sttt bt et s s bbb st s s et ssa s et ensssss b s sesastassenastastessatans . 118
AIFECTION oottt sssssssssssssssesssssssssssssssssssssssssssssssssssssssssssssns . 118
COOIAINALE oo sesesssens . 118
GUIAES oottt ssssssssasssess s sass s ssssssss s s s b st s e e e AR A AR ARt A et asn s R besn bt e . 119
Properties... . 119
LENGEN ettt R SRR RS R AR AR 119
PATENT...ceeieerreererteireeesstessassssssesssssssssssssssssssssssssssssssssssssssssssssssssssssessssssssssssssssssesssssssssssessssssssssssssssssssssesesssssssssesasses 119
EYPENAMIE ..ceeeeeeeereeressesissseasesssessessssssssasssssssasensssssssasssssssssssssssssassassasases . 119
IMIEENOMS ...t ssss s ssssssssssssssssssssssssssssssssssasssssassssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssns . 119
AAd st . 119
getByName ..., 119
HISTOPYSTATE ...cceeeeereecrrerernsennenseseasesessssssssssesssesassssenases . 120
PrOPEITIES .ttt sttt s st st sss s es s ses s s ssssanses . 120
NMAMNEeteeeeeerreerenressssessessesessessessssessesssssssessessssessessssssssssesssssssesssssssssssssssssens . 120
PAFENT..c.cecuirreerrereeereasestseasessassssessesssssasesssssssessessssssstsssesssessesssssassssssssssssssssssssesssssssssstsssssassasssssssssssssssssssssssassssssssssssnses 120
SNAPSNOL .ottt bsssass st sasnssnsans 120
EYPENAIME .ottt sasesssssssssssssssssessssssssssessssassssssssssssessssssessses 120
HistoryStates.......cocoeecunen. . 121
Properties......cccoeveurenne. . 121
[ENGEN oo s s s s R R R R R bR AR bR en 121
PAFENT..c.cecuirieetrereeersensesesessesstssssessesssssssesstssssessessssssstsssesssssssssssssstssssssssssssssssasesssssssssstssssssstsssesssssssssssssstassssasssssasssssssnses 121
EYPENAIME .ttt ssesssasessess s sssssssasssaseasessensessssssses 121
Methods .....eeovreereereenneann. . 121
getByName ..., 121
HSBQOIOT . cuieeieereinneissiessissenssisssssssssesssssssssssssssssssssssssssssssssssssssesssssssssssssssssessssssssssesssssssssssssssssssssssssasssssssssssssssssssssses . 122
Properties......ccooveveurenne . 122

D IIGNTNESS ettt ssssasssssssssssssssssssssssssasees . 122

RUE ottt ettt e s e . 122
SALUFATION eceeeeercereneecreneeseneesessesesasesseasessesssssees 122
EYPENAIME .ottt ssssssssssssssssssssessssasssssasssssssssssssesssassssssessses 122
INdexedConVersioNOPLIONS ......eeeerereesreneesesensessessesssssasssssassseseens . 123
Properties.......ccoevereunenne . 123
CONOTS cuuterrerssreresssisssessassssss s asssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssns . 123
dither..eeeennes . 123
AIENEIAMOUNT ..o essessssssssessssssssssssesssssasssssssssssssssssssasssnes 123




Adobe Photoshop CC

JavaScript Scripting Reference 18
FOTCRA .ottt b s bs s e s bR R AR 123
Matte .....oeceeeverrennee . 123
PAIETEE ettt ss s ssssessaens . 123
preserveExactColors.....rerreennes 123
TFANSPATENCY c.uureereeereneeesenseersessesesessessesssessessessssessassssensassssssensassssensesssssssanss . 123
EYPENAMIE c.ceeeerenreeeerseaseesssaseessesseasasesseasasssssasessssssseasesssssasessssasessssssssases . 123

JPEGSQVEOPTIONS ...cveveeieriereirirersnississsssssssssesssssssssssssssssssssssssssssnsens . 124
Properties... . 124
embedColorProfile . 124
formatOptions ceeensersenssasenaes . 124
Matte....ccorvcrercenne . 124
QUANILY wverrererrreeenrerseissseseessenenens . 124

£ er=] 0 OO . 124
typename reeveeesnseasentaenes 124
LADCOION wouerrtireeretiseiseiisetissisetsssissesesassiasssaens . . 125
Properties... . 125

Qererrerarerseesrenssese e eass e s s seene reeese et R R seees . 125

D ettt ss s saens seeese et e R R setes . 125

ettt ettt sttt ettt ettt et bRttt santes . 125
typename reereeeersaasentaenes 125
LAYEICOMP.ouiuireimeenercineenensessesstasessessstsssssesssssssssstasssssessssssssssesssessssasssssessessss . 126
Properties.......ccccovevenees . 126
APPEANANCE w.cereeerererreererseessssssssssssssssssessssssssssssssses . 126
COMMEBNT et sssssssssessssssssasssssessssssssssssssssssasssssssssssssaes . 126
NAMIEccieiinininersiersesssssesssssissesssssessssssssasssssassssssssssssssessssssssssssasssssssssssssss . 126
PAIENT...ccicrreericrsensesesessesssessessassssesens 126
position . . 126
selected cerreressrseeasesaaseses 126
TYPENAMIE c.ceeeeereneeeerseseeassaseessessessasesseasesssssaseasssssseasesssssassssssssensssssssases . 126
VISIDIITY wvververrereississsnsisnnssnsinssnsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssns . 126
IMELROMAS ..ottt sssessssesssetssesssssssseaasssssssbasssssssasssbasesasess . 126
APPIY ettt issssssisesasesassssasesas . 126
FECAPTUIE «.eoereeerereceneeesessesessesssssessssssssseaseasessessessssss 126
FEMOVE.....erricrrecnensinenee 126
FESEIITOMUOMP oottt sssssssssasssssesssesbassssssasssessasssassbsssssasssesssessassaesssnssaes 126
LAY O OMIPS.coucveierrerinsereusersississsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssssssssssssssssassssssssssssssssssassssssssssssssssssnsons . 127
Properties......ccoovereunenne . . 127
[ENGLN e 127

(S T=1 £=] 0| R 127
typename ceeensersenssaenanes 127
MELNOMS ..ot issssssssssssssssssssssssssssssssssssssassssssssssassssess . 127
add....... ceeeeueeiseeasesiaseeas . 127
getByName ceerereesssassassaeaes . . . 127
removeAll ... ceseesesissisesaens 127

Layers et R RS R S R R R S RS R R RS R R R S R R RRbt . 128
Properties.......ccccovevuunes . 128
[ENGEN oo s s R SRR RS RRRRR R RS RReR08 128
PAFENT..c.cecuieereeererieersesseetsessessessssessesssssasessessssessessssssstassessssssessssssstassssssssssssssssstsssssssssstessssassasssssstsssssssssstassssassssssssssssnses 128
EYPENAMIE ..ceeeeereereeressesesaseaseessessesssssssassssssaseasssssssssssssssssssssssssassassssases . 128
Methods ......ceeoreeereereerecann. . . 128

getByName ..., 128



Adobe Photoshop CC

JavaScript Scripting Reference 19
removeAll et e Re e e AR R bR R R Rt rRes 128
LaYerSet ....eeeenneesereeeeesessennne reeturer s eaetaseaetans 129
PrOPEITIES ettt ssssst st assssssssasssstssssassssssssassssass s bssssssst s ssssssasssssssasssssssasssesssssassssessssssnsssssssssssssneas 129
AIILOCKE. ...t sassssssssssssssssssssssssssssasssassssessssssssssssssssassssssssssssssssssssssssassssssssasssessssssssssssssssssssssssnes 129
ATTLAYEIS.cucveeereersrieississessessesssssssssssssssssssssessessssssssssssssssssssssssssssssssssssssssssssassssssssssssasssssssssssasessssssssssssssssassassassssssssssnsans 129
DIENAMOAE. ...t isssssssssssssssssbsssssssssassssssssssassssssassssssssssassssssasssssssssssssssssasssasssssssssses 129
DOUNGS .ottt ssss s s s s st s s RS Rt R AR R s SRR bRt R s R e e Rt ans 129
ENADIEACNANNEIS ...ttt b st bess s sassbass s sassbass s sassssss s st s bt esssass s s assasnsensassbanees 129

JQYEIS oottt tesesissessse st asssasss st bbb AR bRttt 129
[YEISEIS ...oerrereerenereireeserreessssesssessssesssse s ssssesssssssasessasesssasssssnessanes TP 129
[INKEALAYEIS c.uererrririnreessssssississsssssssssssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssssssssssssssssssssasssasssssssssses 129
DMAIMNEeeeeereereerreaseessesseasessssessessssessessessssessessssessessessssessessessssesstssssesstsssssssessessssesstssssssstssessssssstsssssssasesessessessssessensesessessens 129
OPIACITLY wevurrerenreeresensessisssessesssssssesssssssessesssssssessssssssssessssssessssssssssesssssssssssssssssassssssssnss reeereeraseeaeaseasasasens 129
PAr€NT.cceceecirereerereseerensesssenseseens . . 129
EYPENAIME .ttt ss sttt bbb s bbb bbb sttt bt as 129

ViSIDIE oo . 129
MELNOAS ...oueerrireiseisseseississssesssissssssssssssssssssssssssssssssssssssns ceerserssa st ssassseees 130
AUPTICALE ottt sas s assasssesses s sessassassasssessestensans eertereesres s aesaestens 130

FINK ettt bbb R R ettt 130

INYEITC cuvuruierrreenseessssasesssssassasssssssasesstssssssssssssssssassasssssstassssssssssssssssssessessssassssssssssssssssssssssasssssssasssssossssssssssssss 130

L0 010 =R 130
(=] 0 001 130

resize . ceeteeu ittt s AR R AR AR AR SRS R RS R R RS RS eE AR s R R AR AR SR b s 130

FOTATE coueereeereeeerereetseesestessease st sssessessase s e sssessa st s sse st s sse st st s s et sssse st sesssassbsasssssesssssssesstssssssasssnsssensenessssneas 130
EFANSIATE oo sss s sssssssssssssssssssssassssssees . ceevserss st asssesees 130

unlink . . 130
LAYEISELS .ceereircentrercentatiesststsessessssassesssssssasssssessse e tasessse et sas st s e s s e bR e R 131
PrOPEITIES ..ottt s eetseaseasesse s sssesssesssasensessssse st sss s esssaseas e s s e s ssss e e s s sesesseasessesssssesesssssasesseasessessessssss 131
length.......coverernnen. ceeteseh s eSS R RS R R R AR R AR E AR R R ARt . 131
PAFENT..c.cecuieieeeenreerseasessissaessessseasesssssseasesssssasessssssssastssssasssssessssassassesssssssessssassessssassessssasssssssasssssessssssssssssases . 131
TYPENAMIE ...eeeeeerereetsesestesseasasssess s ssssssssassassasesssssassasasssssaseassssaseastsssssasesssesssasesssasessssssstassssssssssassssssassssssanes 131
IMIEENOMS ..ottt sttt b s s bbb bbb s R e s R e bR e R e a e et bes s b as s tans 131
QA s RS AR bR 131
getByName ... e RS R s R R b 131
FEMOVEALL c...eeeterrriseeseeiseisesssssessssisssssesssssssssssssssssssssssssssssssssssssssasssssssssssssssssassssssssssessssssssssesssssssssssssssssessssssssssesssns 131
MEASUTEIMENTLOG ..ceveeerierieerenrerenenreseseasensesssessessessssessessssessessessssessessessssassasssssssessesssssssesssssssssssssssessssssssssesssssssssssssssassasssssssens 133
MELNOAS ...ooererrreisesrsesssissesesssssssssassssssssssssssssssssssessssssssns ceerere i et s R b en 133
exportMeasurements... 133
deleteMEASUIEMENLS ......covvvrrrenriererensrssessssssssssssssssssssesssssanns 133
MEASUIEMENTSCALE ....ucvereererreeeeeeesesseesssissssssssssssssessssssssssssesssssssseses sttt sttt s et aetaes 134
Properties eeteetetuetstestet sttt ettt et AR R Aot A e E A e AR AR AR e R AR e e e A bt et AR A en R e b s R s R st enaeen 134
PIXEILENGTN oouceterrrrnetserssisssessessssssesssssssssssssssssssssessens ceerererss s assens 134
logicalLength veeveserseressasraens ceerere s rassassens 134
[OGICAIUNILS «.eueeerrresiesrtsssesssssissssssssssssssssssssssssssssssssssssssssssssasssessssssasssessssssssssenssssssssssssassssssasssssssessassssssssssassanssnssanns 134
INOCOION caeereerireeeersseississsissssssssssessssssssssssasssessssssssssssassssssssssssssssssssssssssssssassssssssssssasssassssssssesssessssssssesssssssesssassssssssassssssssssssases 135
PrOPEITIES. ...t ssessessee s enseasessensessssaes reeeeeraseene s aeneens 135
TYPENAMIE ...t ssensessssessessassssensessssessensessssensessesesssnens rreereraseensenseasaeasens 135
NOTIIEF cvuurvureerrierressisssessssssssessssssstssssssssssssssssssesssssssssssssssass s R e e SR s RS esbA s R es R SRR bR AR e e s s bR s s banten 136
PrOPEITIES ...ttt sssssssssssssssesssssssssssssssssssssssssssssssssssssssssasssssssssssssssasssssssssssssssssssssssssssssssssssssssssssssssssssnsans 136
EVEN T cirieereeristsensisasesse st sssesststssssssssssssssssassssssssssssassastssssssssassssssssssasssssssastesssssssasssssssssssssssassensssassssssssssassesssassessesaes 136

eventClass ettt a st sttt st e R Rs Rttt e s eneas et b bataen 136




Adobe Photoshop CC

JavaScript Scripting Reference 20
EVENTFIIE ottt sttt et bbbt R R bbbt as bR R bbb e b bassaesbesbenbans 136
PAr€NT...cceicerereerereseesensesaeasensens . 136
EYPENAIME .ttt sttt bbbt st sttt b sttt s 136

IMIETNOMS ..ottt bes bbb s s bbb bR R s bR bbb bR AR bbb b bR s s R s b s sbenen 136
FEIMOVE u.eieerrienresisessissssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssesssssssssssssssssssssssssssssssssssssessssssssssssssssessssssessssssssens 136

NOTI RIS vtrreerrerisseesresiessessisstessses st ssssbsssssassbess e sassb s s s bass b s bR bass b bR bbb bR bR b bRt ba s bR an bR R bR e bR b A b e bR basa b b e e ee 137
PrOPIEITIES . ... eueereireirririsiesensesseississ s issssssssssssssssssasstssssssssssssssssssssssssssssssssssssssssssssssssssssssesssssssssssssssssssssssssassssssssssssssssssssensans 137
[ENGEN et b st as s . 137
PAr€NT..eicerirenrerrseerenseseenseneens . 137
TYPENAMIE ..ot s bR R bR bR R R0 137
IMIETNOMAS ..ottt st ass s st bbb s s st bt bbb AR s bbb bbb as e AR bR s s bbb e b an e s s s st esssbanen 137

= o o ST P TR O OO 137
FEIMOVEAIL ..ottt et bbb e bbb bbb s bbb b b a bR b bbb e b sassass s s tensenbas 137
PAtRITEIM .ottt bbb e bbb e bbb AR a bR s bbb a b b s R R b b bas 138
PrOPEITIES ottt st sss s ssssssasssssssssassssssssassssssssstsssss st s sssssssssesssssssssssssssssssssssssssesssassnssssssssssssnens 138
KIN oottt bes bbb sas e sss bbb bbb e bR s bbb bbb R AR R s bbb e bR bR R R b b bes 138
NIAIMNIE.c.uieeurireerseesesstessssssssssssssssssssssssssssssssssssssssssssssssssssssssssessssesssssssssssessssssassssssesssssssssssesessessssssesssssssssssssssesessssessssssesens 138
PATENT..cueieerreertrtersisesssesassstsssesesssstsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssessssssssssssssssesssssss . 138
SUBPATNITEIMS ...ttt essassas s tesses s bbb s s ass s es b st bes b b e s s s assass s s s b s b s besbasbasbassasssessstensans 138
EYPENAIME .ttt ss sttt bbbt bbb bbbttt s 138
IMIETNOMAS ..ottt se s ss s s s s bbb bbb bR bbb AR AR bbb b e bR s s s s b s s benen 138
AESEIBCT ..ttt sttt bbb bbb s s s e bR b A bR A e e bR e bR bbbt s e e te 138
AUPTICATE ettt sttt b s bbb e st b s bbb et bt as b AR s R s e b s besbasbassasssessestensans 138
FIIPATN oottt ss s s s s s b s s ssas b s s bbb e bR bR bR bbb R bR bR bR bR bbb R bbb 138
MAKECTIPPINGPALN....c.cerereretsrssressrssss s sessssssssssssssssssssssssssssssasssssesssssssssssssassssssssassssssssssssanns 139
MNAKESEIECTION ...ttt bbb sss s bbb s s s s s bbb b e b s s s e e s b b basbassassasaesaessentes 139
FEIMOV . ..ucieirtererereeeeststssssssssesesessssstssesesssessssssststssesesssessssssstsstasessssssssststssssssesesssssssessssesesesessssssssstssesesesesesssssssssssseseseses 139

SEUBCT ettt bbb bbb e bR AR R R e AR R bR bR b e b e bR Re s R benbas 139
STIOKEPALN ..ttt ettt bas st s a s R bbb bas et s asssessesbentans 139
PALRILEIMS ..ottt sttt as s st A bR s b bbb A s ARt bbb et b e s ass s ts b bas 142
PrOPEITIES ...ttt sssssssssssssssesssasstssssssssssssssssssssssssssssssssssssssssssssssssssssasesssssssssssssasssssssssessssssssssssssssssssssssensans 142
[ENGEN oot b s sstaens . 142

Parent..... e . 142
TYPENAMIE ..ot s R R 142
IMIETNOMAS ..ottt st b s st s st s st bbb A s b s bbb et es e e s R s AR bbb e b aseanssestessesbenen 142
A ettt e bbb bbb AR AR R bbb bR AR R R bbb et A s ARt n b s bans 142
GEEBYINAIME .ttt st sssssstsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnsans 142
FEIMOVEAIL ..ottt et se s s s bbb b bbb bbbt b e bR R s bbb e b sassas s s aessenbes 142
PAtIPOINT ...ttt bbb se s s s s bbb R R bR bR AR bbb A b ae s e s s b sentes 143
PrOPEITIES ..ottt st essesssssesssessaasessessssse st sss s e sas st s s s s s s e e s s s esesseasessassssesessssasessensasssssessssss 143

= Vel o 0TSO PR OR OO RPRTRTROTTN 143

KIN ettt s s s ssses st s s bas s s s et bbb bbb et st bbb b bes b A b AR s Rt bbb et s e b A s st s b tes 143
[EFEDITECTION cou.vevvererreerestes s tseses s s sessaes s s s s s ss s st s b s A s s bR bbb R s a s bR bRt b e bR R bR e s e baes 143
PAIENT..c.ceeieierireerietseaseeissssssstssssasessssssssssssssssssssssssssastssssssssasssssssassassossssassssssssssssssssssssssasssssssasssssssssasssssssasss . 143
FIGNEDIIECTION c.c.eeereeeeeeeeriieerseeieessasesseessssssssesessssssesassssssss s s ass bbb R bbbt eb e 143
TYPENAMIE ..ot bR R R R R R R 143
PAtIPOINTINTO c..veeceteecrtes st s st ssbsssass s b s sass b s b b s bbb A e bas st s R e b b asbaten . 144
PrOPEITIES . ... eeretreisinisiesenseiseissisesssisssssssssssssssssssstssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssssasssssssssssssssssssssssssssssssssssssssnsans 144
ANCNOT ettt s s st bbbt bbb AR b bbb e bbb a b b AR bbb e b e b e st n s bens 144

KIN ettt bbb s s s s bR bR s R bR R bR s bR bR bR b s bR s bR ba b naeas 144
LEIEDIIECTION ..ottt se bbb e s s bbb bas e a b e s R R bbb bas b e sassassesaessentes 144




Adobe Photoshop CC

JavaScript Scripting Reference 21
FIGNTDITECTION ...ttt sssssss s s ssss s s ssss s sssssssssssssssssssssssssssssssssssssessassssssssssassssssssassssssssesssssns 144
TYPENAMIE ..ttt b sttt st s b bRt bR bbb R bbb st 0n 144

PAENPOINTS ..ottt sttt setssesssessssesssesasessssessse it s st be s st a s st bbbt 146
PrOPEITIES ...ttt astsesseases s sssesssassassessess s st s sesassaas s s s s s s s e e s s s et sseasessasssssssesesssasesseasesssssessssns 146
[ENGEN oot s s R R R eR st bs . 146
PATENT..ceerteerreertrtcrriseessesastseesstsessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssesssssss . 146
TYPENAIMIE ...eeeeetrereeeseseetessestsssseastsssssssssassassasesssssassasssssssasess s saseas s ssstasesssessstssssasessssssssasssssssasssssssassassssssanes 146
PDFOPENOPTIONS ecerirteiesisisesnseeississessissssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssessssessssssssssssssssssesssses 147
PrOPEITIES ottt ssssst s assssssssassssssssssssssssssas s sss s bssssssst s ssssssassssssaassssssssstsesssssessssesssassasssssssssssssneas 147
ANTIATIAS oottt sass s s st ssesssessssesss s s s s s R e R S Rsee SRR AR AR bR s 147
DITSPEICIANNEL ...t ssssbsssssssssssssssssssssssssssssssssssssssssssasesssssssssssssssssasssassssssasssns 147
CONSTTAINPIOPOITIONS ..ottt sttt st sss st ssssssesssssstsssssss s sssasssssessssassessessssassesssassessasanes 147
CLOPPAGE ... eeeeerreireississsessesssaseississsssssssssssssssssstsssssssssssssssssssssssssssssssssssssassssssssssssassasssssassassssssssssssssssssassasssssssssssnsans 147
REIGNT et benees . 147
IMNOTE .ottt sttt e asse st ese s bbb s ARtk st s et bbbt b 147

L =1 0 1O 147
PAGE c..eeerereureeereneeesesseasesssessesese st s s e e s RS s e REER RS e R eeRenEeReReRsseReeRne et Rtas 147
FESOIUTION cuucvereeeteresisseessssssisssissssssssssssssssessssssssssssssssssssssssssssessssssssssassssssssssssssssssssssssssssessssssssssesssssssssssssssssessssssssssessses 147
SUPPIESSWAININGS c..eveerrrenrirrsersensisssessessassssensessssssesssssssessesssssssasssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssss 147
TYPENAMIE ..ttt bttt bbb bbb bt bbb R bbb bbb R bbbt 0n 147
usePageNumber ...... . 147
WIATN ottt bbb a s s b bbb as s bR a s s e bR e bR b bR bbb e e te 147

PO F SQVEOPTIONS ..uererrererrsistsesisssisssssssssssssssssssssssssssssssssssssssssssssssssssesssssssesssssssassesssssssesssssssessasssssssesssssssessessssessessassssessanes 148
PrOPEITIES ... eueeretreirsirisiesenseiseissise s sssssssssssssssetssasssssssssssssssssssssssssssssssssssssasssssssssssssssssssssssssssasssssssssssssssssssssssssssssssssssssensans 148
AIPNACNANNELS ...t asse s st s s s s s sssbsss s s b s s s e bss R b b s s b asn s s bssn b s sasnbanees 148
ANNOTATIONS ..ottt ettt bbbt s s bbbt bbbttt nbas 148
COIOTCONVEISION c.ccerrreerreerreesssessessssssssssssssssssssssssessssssssasssassssssssssssssssssssssssssssssassssssssssssasssasssessssasssssssssssssssssssssssssssssnes 148
CONVEITTORIGRTBIL.....ceoreerierrerieseeiseiseisesesssssessssssssssssesssssssssssssssssssssssssssssssssssssssssssassssssssssssssssssssssssssssssssssssssssssnes 148
AESCHIPTION ettt st ss s bbb s st s b s bbb as s st s bbb e e st e b as b AR sbes b s besbasbassasssnssessentans 148
AESTINATIONPIOFIIE vttt ssss s sssss st ssses st b sssessssssssssesbssesssssessssessssessssaes 148
AOWNGIAECOIOIPIOfIlE ...ttt s ssssssssssssssssssssssssssssssssssssssssssssssssassssanssassssssssassssnes 148
AOWNSAMPIE ..ttt ssst st sssass s bt bbb s e bR e ettt R bbb R et s e e en 148
AOWNSAMPIESIZE ..ot sssesssesssssssssssssssssssssssssssssssssssssssssssassssssssssssasssasssssssssssssssssssssssssnes 148
downSampleSizeLimit .....cc..coouvene.. 148
EMDEACOIOIPIOTIIE ..ottt sessssssassssssssssssssss s s ssssssssssssasssssssssssssssssssssssssssssssssssssssssssanes 148
EIMDEAFONTS «.corereeieeieisetieeise ettt ssse bbb ssbssebass bt as bbb bbb bbbttt bbb sasaes 148
EMDEATRUMDBNGIN ... ettt ettt ees e tass bt sbss bt ss et b sessset st sssebsse bbbt sssebasesases 148
ENCOAING ottt s tsss st st ssssss b s s ssbsssass s b s s s b s b e b e e b e e b E R bR bR bbb R et sassbanee 148
INEEIPOIATION. ..ottt ss s sses s sssssesssssssss s s bese s s s s s b b s s s s assnsssasssasasss 148
JPCGQUANITY wveuveerrerncrieerisesietisseessssesssesssssssssesssssssssesassssssssesasssssssessssssssss s ssssesass s bR b st s sasasbasnsssss 149
JQYEIS c.oerrererreersenserssisssssssssssssssssassssssssssssssssesssssssssssssssssssssssssssssssssssssssssssessssssssssesssssssssssssesssessssssesssssssssssssssssassssssssssassses 149
OPLMIZEFOIWED et sssssssssssssssssssssssssssssses . 149
OULPULCONAITION coureereevrrersiseisrersissessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses . 149
OULPULCONAILIONID ... ceieereeeresreeeerstssstssessississssssssssssssssssessssssssssssssssssssssssssssssssssssssassssssssssassssssssssssssssassssssssssasssanses 149
PDFCOMPATIDIITY cvvunereerressersaeriaerrneeeseesaeesssesssssessaesssessssssssssessasesssssssssessasessssssssssssssesssssessssessssesssssssasessssesssnss 149
PDFSEANAAIT ..cooveeereeeeeeeeecesecississssssssissssssssssssssessssssssssssessssssssssssessssssssssssssssssssssssssssssssssssssassssssssssssassssssssssssasssasssss 149
PrESEIVEEQITING w.cuvvueererreiriniissississsisssisssssisssssssssisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssssses 149
PIESELFIIE ottt sss s ssss s s s ssss s sssssss s e ssssssss s ssssssassssbsssssasase s sesesssn s st s ssnssasssasassasssanns 149
PIOfIlEINCIUSIONPOIICY courverrerreerieessesssississstssstsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnsssssssens 149
FRGISTIYINAIME ettt bbbt bbb s bbb sttt bes 149
SPOLCONONS ..ot ssseassesssss s ssssssssssssassssssssssssassssssssasasasssessssasssasssssssss s ssssssssasssassssssssasssassssssssasssasssss 149



Adobe Photoshop CC

JavaScript Scripting Reference 22
LI ESIZE vt s ass s st s s b s s s st b s s s bR bR AR R RS R et 149
EFANSPATENCY c.ceneererreerieeisensiesissesessessssesesstssesst s s aas st s s bbb s ess st se bbb s bR st b s basaasasst st ssebssacs 149
EYPENAIME .ttt sttt bbbt st sttt b sttt s 149
USEOULIINES «.ceoeveeveeceeeeseeeseeessisssssssssssssssssssssssssssessssssssssssassssssssssssessssssssesssesssssssssssssssssssssssssassssssssssssessssssssssssasssasssss 149
VECEOIDATA ... curueereereicrcineseiseaseissssssssssssssessesssssesssssssssssssssessasssssesssssssasssssassssssssssssssssssasssssasessssssssssssssssassssssssssssssssnsans 150
view cetteeeets s e s AR R RS RS R R RS SERS R SRRSO R SRR R RS E SRR RS ERS R R SR AR R ARt 150

PROTOCDOPENOPIIONS ...cvrreererissrersrsssisssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasees 151
PrOPEITIES ottt essesss s assssssssssasssssssssasstsssssasssssss s bssssssst s sssssbassesssassssssssssssssssssesssssssssssssssssssssssssneas 151
COIOTPIOFIENAME ...ttt b st b st b s s s b s s e b st R bbbt e baeen 151
COlOISPACE ...ttt st bbb ss b s sass s b s sass st b a s bbb a bR A bR e b s R e bR e s bR et s s e e te 151
OFIENTATION ceceureeerriereicisessessesserssasssssssssssessesssssesssssssssssssssessasssssasssssssssssssassssssssssssssssssssssssasessssssssssssssssasssssassssssssssnsans 151
PIXEISIZE oottt et s s s bbb et s bbb AR AR b AR R AR ARt 151
FESOIUTION ... veerveeteristesresssissssssesssssesassssssessssssssssssssssssssssssssssssssssssessssasssssessssssssssssssssssssssssssssessassssssssssasssssssasssssasssssssnns 151
TYPENAMIE ..ttt b sttt st bbb bR bbb bbb R bbbt 0n 151
PROTOSNOPSAVEOPTIONS ...ttt isssssasssssssssssssessssssssssssssssssssssssssssassssssssssassssssssssssssassasssssssassssssassssssesssanees 152
PrOPEITIES ..ot rsssstseaseasesse s sssesssessaasessessssse st s sssesssaseas s s e s s s s e e s s sesesseasessesssssssesssssaseaseasessessessssss 152
AIPNACANNELS ...ttt et s s bbbt s s bbb st e R s bbb e b e s assans s sentas 152
ANNOTATIONS. ..o veeereiereicisensenseasessssssssssssessessesssssssssssssssesssssessasssssssssssssssssssasssssssssssssssssssstsssasessssssssssssssssasssssassssssssssnsans 152
EMDEACOIOIPIOfIE ..ottt st s s st s sssssssss s sasssssss s s s s b sssssss s s sssssbass e ssasssasssannes 152

JYEIS oerteeieeeieeisetsse sttt e ssse st bbb AR AR bbbttt 152
SPOLCONONS c..eereerreerrereieresesssiseassssssesssessssssssssssssssssssssssssssssssssessssssssasssasssessssasssasssssssssesassssssssasssassssssssesssessssssssasssasssss 152

1877 L= T 0 T 152
PICTFIESAVEOPTIONS ....eceeetetrierereeressesstsstsssssesssssssssasssssssssssssssssasssssssssssssssessessassasssssassssssssassassassassassssssessessassassassansasssnsssses 153
PrOPEITIES ... euerretreisisisiesenseiseissise s sssssssssssssssetssasssssssssssssssssssssssssssssssssssssasssssssssssssssssasssssssssssssssssssssssssssssssssssssssssssssssensans 153
AIPNACKNANNELS ...ttt st s s s b s s sssbsss s s bt s s e bss R b b s s n s s s s s bssnssnsasnbanees 153
COMPIESSION c.eereuierieasississseasssssssssssssssssssssssssssssssssasssssssssssssassssssssssssssssssasssssssssssssesssssssssssssssssssssssssssssssassossssssssssssses 153
EMDEUCOIOIPIOFIIE ..ttt s s s bs s b e s s s s bess b s bbb e basn b s e beneee 153
FESOIUTION ...ttt sttt tssses s s ss st e s s ses s e s sss s e s b a s s R e b s A e R a s s ase e s b e bass b b e banssentanes 153
TYPENAIMNE ...eeeeeerereeestaseeeess st easessse st assassasesssssaseasess s e ess st et asess st aseas s s e e et s asesessssseasssssssasesssssaseasssesssanen 153
PICTRESOUICESAVEOPTIONS .....cuveieeriereissississsssissesssssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses 154
PrOPEITIES . ...ttt issssssssssssssesssasstssssssssssssssssssssssssssssssssssasssssssssssssssssssesssssssssssssassssssssssssassssssssssssssssssssonsans 154
AIPNACKNANNELS ...ttt s b s b s bbb e bR s bbb R bR bt s e e en 154
COMIPIESSION c.eerrerrerieisisisssssssssssssssssssssssssssssssssssssssssssssssessstsssssssssssssssssssssssssssssssssossssssssssssssssssssasssssnsssssssssssssssssessss 154
EMDEUCOIOIPIOFIE ottt st s s s s b e s s s s s bbb e ss s e b s e banese 154
DMAIMNEeeeeereereeereaseessesseasessssessessssessessessssessessssessessessssessesssssssesstssssessesssssssessessssssstssssssstssssessssstsssssssassssssessessssessensesessssens 154
FESOIUTION ... reerveetereesiessessssssssssesssssessssssssessssssssssssssssssssssssssssssssssssessssassssssssssssssssssssssssssesssssessasssssssessasssssssasssssssssnssssns 154
FESOUICEID .uveieireerirerseieiseisetssissssssessssssssssssssssssssssssssssssssssssstsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssssssssnssnses 154
TYPENAMIE ..ttt b sttt s b R bbb bRt b R bbbt 154
PICTUIEPACKAGEOPTIONS.....ceeveeerceraeerneresseisessssesssssesssse s ssssesssessssessssssssasessasssssss s sesesasss s ssse bbb assesasssssssassssenssass 155
PrOPEITIES ...ttt sesss st easeases s sssesssessaesessessssse st st aasaas st ase s s e e R s s s ese st ssasssssesesssseasesseasasssssessssss 155
CONTENT «.cceeeeeeeeareaseeeseasessseasesaess s assssssseasssssssasassassasesssssastasesssssaseassesaseasesssssaseassesasssesssasessssssstasssssssssessssssseassssssanes 155
LA oottt ssss s s s e b sssbessba s ase RS es b aseb RS R s R s b et aens .. 155

FONL sttt st b b s s e s e s A R e s R AR A AR AR AR AR e AR bRt en 155
FONTSIZE ettt s bbb s st e ass bR SRR AR bR bRt 155

[QYOUL oottt sssessssssssesssssassssssssssssanns .. 155
MO ..ottt sttt st ess s s sass b s s s b ss st s bR s s e b s A b b A bee b bR s et et R e ass s ane e s bt aebase b s b e bans s baes 155
OPACITY wveveererernresersssesssessessessesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssssssssssssssssassassssssssssssssssssassassassssssssssnsans 155
FESOIULION ...ttt sssssssssssssssssssessssssssssssssssssssssssssssssssssssesssssssssssssssssssssssssssssssssesssssessssssssnssssssssssssassssssssenssssns 155

TOXE ettt ettt s e bR E bR a RSttt bRt s s eeas 155
EEXECONON ettt sttt bes s sassbs st ss s s b s e bt e bR Ass e e bR bR e bR basn b s e baeen 155
TEXEPOSITION ettt st bt s st s s s s st st ss b s st s b ss s es b s s e sstsnssnssbssssnasssssnsssasssssnsnes 155




Adobe Photoshop CC

JavaScript Scripting Reference 23
EEXEROTATO .ottt eseessesas s asses s s ssesasenssesssanss .. 155
EYPENAME c.iiriririiciiicstssiesssissssstsssssstastsssssssassssssssssssssssssassassssans 155

PIXQISAVEOPTIONS ..cerevereetrisisessseseiseississssssssssssssssssssssssssssssssssssssssssssssssassssssssssssssssssessssssssssssssssssssssssssssssestesssssassasssssssssesssses 156
PrOPEITIES ...ttt estaseaseases s sssesssessaasessessesse st s s esssasess s ase s s s et Rse bbb esesse s sssssesesesseaseaseasesssssessssncs 156
AIPNACANNELS ...ttt bbb s st as bbb as b e bR s bbb e e s assanssessensans 156
TYPENAIMNE ...eeeeeeeeereseerseaseeaesseasaesseasesssesseas s assasesssssastasesssssasess st e s e st asessses st sestasessssssseasssssssasesssssaseasssessanen 156
PNGSQVEOPTIONS ..ccvurevrirerrrieississisnessessssssissssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssstsssssssssssssssssssssssses 157
PrOPEITIES ottt ssessesst st ssssasssssssssassssssssas s ass st s sss st s sssssbasssssasstsssstsstsessssstssssessssssasssssssssssssneas 157
COMPIESSION c.etreeieriearieseessessissssssssssssssssssssssssssssssssassassssssssssassssssssssssssssssassssssassassossssssssssssssssssssassssssssssassosssssssssssssss 157
INEEITACEM ...t s et s s ses s s ssse s R e e R s AR s s s s anns 157
TYPBNAMNE ...eeeeeeeerereeeseaseeaees s s easeassse s s assas s s s s s ass s e st as s e s st aseas s s s e e st aseses s st asssssssasesssssaseasesesssanen 157
PIEFEIENCES ...ttt ssssssssssssssssssssss s s s sssssssss s sssa s s s RS e s AR A SRR e AR bR n s b st 158
PrOPEITIES . ...ttt sssssssssssssssssssasssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssssssssssssssssssssssssssssssssssssssssssensans 158
AddItioNAIPIUGINFOIAEN ...ttt sesssss s ssssasssasssssasssanees 158
appendExtension ceeteeetst ittt s AR Ae e bR A e bR AR R e AR e R R AR AR R E R At A AR s R e e s tRns 158
askBeforeSavingLayeredTIFF..........eneerneceneresneenns 158
autoUpdateOpenDocuments ........eeeeeeenensensennenns 158
DEEPWINENDONE ...ttt sttt st b s s s st s s s et as s s st basbassas e s s s sessntas 158
COIOTCNANNEISINCOION «.ouceeiereeeieetiseiseteseeisetssetse i tess e st bssesase s sbssesssetsssssssesssessssesssebasesbasebasassssebasesasass 158
CONOTPICKET ccovtreeeteeeeietstiss sttt bs st st st ass bbb st st s bbb st b ases 158
COIUMNGUELET c...eereereeeeesseesssissssssssassssssssssssssssssssssssssssesssassssssssasssssssssssssssssssssssssssssssssasssasssessssasssssssssssssssssssssssssesssnes 158
CONUMNWIALR oottt s s s s s s s s s st s s s st ass s s s s s ssss s sassssssnsssnes 158
CrEATEFIISTSNAPSNOL ...ttt s st as s b as s as s bbb e b e sassanssestestans 158
AYNAMICCOIOISIIAEIS ...t issessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasees 158
EUITLOGITEIMS et ssssiss s sssssssssss ssssssssssssssssssssssssssssssssssssssssssssssssasssssssssssssssssssssssssnsssssssssnes 158
EXPOITCIPDOAI ...ttt st b sss s b sass s s sass s s s s sttt R s et R basn b s e bannen 159
FONEPIEVIEWSIZE ..ottt sssss s sssas s s s ssses s st st s ssssssese s s as s s s ssssssssases 159
FUIISIZEPTOVIEW. ...t ssss s sssss s sssssssssssssssssesssassssssssssssassssssssassssssssssssssssssssassssssssassssssssssssases 159
GAMULWAININGOPACITY c.cvureveemnemerneercemeeeerensteeessesssesssessessesssessesssesssessssssessssssessssesssssesssssssessesssesssssssessessesssesaees 159
GEIASIZE ot st sss s b ss s ss b s ssss st b s s bR bR SRR R s R AR bR bR bR bR n R bR en 159
GEIASTYIE ettt sss st s s s bR bbb SRR R R AR AR bRt R bRt 159
gridSubDivViSiONs......ceeeerrerienersnnen. . 159
GUILRSTYIO oottt isse e s sssse s s sssessss s ssse s s s R bR st ass s s s s s s ssssssasessses 159
TCONPIEVIBW ...ttt ssessaasessesssssesssssssesessessessessessssssssssssesseasensessessessessssssssasssssssasensessessssseses 159
IMAGECACNELEVEIS ...t sssssssssssssssssssssssssssssssssssassssssssssessssssssssssssssssssssssssssassssssssssessses 159
IMAGEPTEVIEWS ..ceeeeeeeeirerssissississssissssssssssssissssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssssssssssses 159
INEEIPOIATION.ccue ettt ssss st ss st ssss s s e bess s s sssssss b s s s s s s sesnbsss s e sssnssnsassssnssasssasassassssnns 159
keyboardZoomResizesWindows... 159
macOSThumbnail 159
maximizeCompatibility ... 159
MNAXRANMUSE c...ceereenreierseiessssssessissesseasssssssssssssssssessessessasssssssssssssssssssssssssssssssssssssssssassassssssssssssssssssasssssassssssssssssseses 159
NONLINEATHISTOIY .eretreeeeereresienresesiseseseessesestssssesesssessessessssessesssssssesssssssessasssssssessssssssssssssssssassssssssssesssssssens 159
NUMBDEIOTHISTOIYSTATES ....veoeverrisrtssrerestsssssssssstsssessssssssssssssssssss s ssssssassssssssssssssssasssssssssssssssssssssssssssssssssssssssssssens 160
OLNEICUISOIS .ottt bs bbbt sttt b asaes 160
PAINTINGCUISOTS c.u.oneeriererrcreimeenerisetseressssstasessesssassssesssessssssesssessssssasstssessssssstssesssessssssessssssessssasssssesssssesssssssses 160
Parent..... e . . 160
PIXEIDOUDIING .cerveririerrenseisissesseississsssssssssssssssssssssssssssssssssssssssssssesssssssssssssssssasssssssssssssssssssssssssssssssssssssssasssassssssssssns 160
POINTSIZE c.vriireireireneiseiserssissssssssesssssissississssssssssssssssssssssssssssssssssssssssssssssssssassssssssasssssassasssssssssssssssssssssasssssssssssssnsseses 160
FECENTFIIELISTLENGTN ettt ssssssssssssssssssssssssssssssssassssssssassssssssssassssssssassssssssssssssns 160
FUTEIUNIES oveveeeeteeteeceetisetese st tasss st b bssesssssbsssbssessssssssesssesassssssesase e sbsse e asa s bssetssesbssabssasssassssesasasasssnss 160
SAVELOGITEMS ..ttt s sss s s esseaseasesssssesssssssesessaasenseasessesssssessssassasessensesssssessssns 160



Adobe Photoshop CC

JavaScript Scripting Reference 24
SAVELOGIEMISFIE c.uveeeeerrerrs et sssssss s sssssssbssssssssssssssssssssssssssssssssssssssssassssssssnsssssssssees 160
SAVEPAIETLELOCATIONS .cveveetrrtee et sssiesessssstssssss s ssssssssssssssssssssssssssasssassssssassssssssssanns 160
showAsianTextOptions cerreesress st tesrans 160
showEnglishFontNames ........ccccoveeeveceecernenens 160
SNOWSIICENUMDET ...t ississssssissssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses 160
SNOWTOOITIPS .ottt tsessessasssessss s sssss s sassssssss s s bs s s b sassasssss s s b s besbassassassassassssssesbessesbassassassasssnssstassans 160
smartQuotes..... ettt sttt sttt R e s R et en 160
EEXEFONTSIZE ottt st sttt b s bt s s sttt bbb a skt e bR b st ss st entas 160
EYPENAIME .ttt ss s sttt bbbttt bbbt bbb bbbttt as 160
typeUnits ................ et bR R R RS R R R RS RS R R S R R RS RS R R R R R 161
useAdditionalPluginFolder OO OP PSPPSR UPOROPOPPROPOPION 161
USEHISTOIYLOG c.uveriureeeerererereisensessessessssssssssssssssssesssssassssssssssssssssssssssssesssssssnss . 161
USELOWEICASEEXTENSION ...cuuvuevererriseissinsisssssensssssissssssssssssssssssssssssssssssssssssssssssssssssssssssssons 161
useShiftkKeyForToolSwitch............... 161
USEVIAEOAIPNA ...ttt sassssssasssanees 161
WINAOWSTRUMBNGIL ...ttt sssass st s s sasssensans 161

PresentatioNOPTIONS ...t sssasss s s sssssssssesssssssessssassassesasss . 162
PrOPEITIES .ttt sttt s st ss st ss s es s s s assssssnsas . 162
AUEOATVANCE ..ot ississssssssssssssssssssssssssssssssssssssssesssssns . 162
INCIUAEFIIENAME......eeeee sttt sessens 162
interval . . . 162

ToToY o JENNIN 162
MAGNITICATION covereeeerereereessess st ssssssssssssssssssssssssssssssssssssssssssssssssssssssenes . 162
PDFFileOptions............... OSSPSR . 162
PreSENTAtION ....ccceeereeeerereerseseeeseasesesessesssssssssessssssssaes . 162
transition...... . . 162
typename cervenerens s tensans 162
RawFormatOpenOptions reerteast st sttt a e s R s R e s e e R R AR e e R s s e R s e R s e e asten 163
Pl OPEITIES ettt sttt b s s st s bt as st As st b et bbb as AR e RS ARt E bR e bttt en et et s e as 163
DIESPEICIANNEL ...ttt ass s s sessssss b s s s sssssssssssssssssssssn b s sasssssnssssassssssssasssssassasssssns 163
DYLEOIUET ..ottt ssss s ssssssssssssssssssssssssssssssssssssssassssssssssssssssessasssssssssassssssssasssssssssssssnns 163
channelNumber-... ceete sttt aesbanees 163
NEAUEISIZE ..ottt e s e bbb bbbt ase et as e b e e s s baes 163
REIGNT..coeeeereeeerrecteniersesieesieesssesssessanes . .. 163
interleaveChannels ......cnenninneneenns ceetee e s RS sRseER s bR R R AR R RS RebeeR s R R 163
FEEAINHEAUE ...ttt ssss s st s s sssssssssss b s ssassss s ssssbsss s sasesssnsessassssnssasssssassasssssns 163
typename................ . ettt sttt AR et a s s s s R e R e s e aens 163

Width .. ettt s e R AR bR R et 163
RAWSAVEOPTIONS ... eirirerisicisisisieisssistsssssssssssstsssssssssssssssssssssssssssssssssssssssssssssssssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssnes 164
PrOPEITIES ..ottt sesss st esse s ssses e aasensess s st sss s e sasaas s sass s s s s e R s s sesesseasesse s st s sesasssasesseasesssssessssss 164
AIPNACANNELS ...ttt b st a s s bbb s e bR s bbb e e s assanssessentans 164
spotColors.......... . ettt e AR bR bR Rt 164
typename................ . ettt st h Rt R R e R Rt s R s e s s aens 164
RGBColor ceeteeetss it et s AR s A AR R SRR R AR R R AR A e R e A SRR R AR R e b s AR R bt 165
PrOPBITIES ..ottt st esseases s sssesssessaasessesssssessssss s s aaseas s tsse s s s e R s s s e ss s s s st e sessssasesseasesssssessssss 165
DIUE ettt s bbb R AR AR R bR b AR bR R R bR bes 165

GECEIN cecreeeeereureeeseaseasesessessesssseaseasssssseasasssssaseasssssstasassassasesssssastasesssstaseasssssstasssssstasesssatasssssssasessssssstasssssssssesssesastasssesssnen 165
hexValue ettt e R R AR AR R RS R AR AR R AR AR bt 165

FEU couvereerereinsisssessssssissssss s sssssss st sssssssssssesasssssssssssssssssssssssssssssssssassssasssssesssssssssssnssssssssssesssssessssssssnsessasssssnssassssssssssssanns 165

1877 1= =1 0 1= OO 165

SRIBCTION ettt e s e s st sss et s st s s ss bttt s st s s st et assseasasestassstetasssbasassstasassesasesaasnssssassstsasestasnsssnssssasnssaen 166




Adobe Photoshop CC

JavaScript Scripting Reference 25
PrOPEITIES ...ttt issssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssnsons . 166
DOUNS.....oeeerteeeeeetes et sseeesesaesaesaesaens . 166
PATENT ..ttt ettt ss st st a sttt ARt R bR st e R ARt s sttt s et aen 166
o] 1o I . 166
TYPENAMIE c.eeeeeerenreeeersesiesseaseessessessasesssasesssssaseasssssseasesssssasessssaseasssssssases . 166
IMIETNOMAS ..ottt bbb s s ss s s e b s s s ARt b s ass AR b s bbb as b s s assassntanen .. 166
ClBAN ettt s b s ae sttt bbb a s s s b s benaens . 166
CONTIACT ettt sesssss s e sessssssssssnss s s s sssssessssnsssssenns .. 166
[a(o] o )OO . 166

QU vtereeeeeeeretesesesesesssesesesesesessssesesesssesessssssesesssesssesensssnsesessesesesssssssssssesesessnsnsanes .. 166
AESEIECE ...ttt sttt ssss s s s bbb sassassaessessesaans .. 166
EXPANG ettt st sss s ass s ses s st sessassassassass s sesaenes .. 166
FEATNEN ettt ses s sas b s b ssa b ss b et s s sassaessaesbaens .. 166

FIlL oottt bes bbb assaes s bbb s s s s aes st naens . 167
GIOW ceenieenneenenesusetessaessassesaseseassnes . 167
invert... . 167
1Y Yo [ . 167
MAKEWOIKPALN ...ttt sssssssassasssss b sessassassassssssessenes . 167
resize eetetetetet et ettt et et R et et bt R A e e SRS e R RS et e e e R e e R e R R e R RS R E R Aot AR b e R b e e R et n AR et e Rt n Rt etanes 167
FESIZEBOUNTAIY ..ottt sise bbb st bssessse st b s s st base bbb sinss 167
FOTATE civuurrereteereesteest s st sss b s ssss s bes s e b ss s a s bR e s R At SR A RS R b A s b b A bR a e ane bR b A bas b b A b s R baes 167
FOLATEBOUNUAIY ..o ssse s sssssssessssssssssssesassssssssssssssssssssssssssssssssssssassssssssasssessssssssssssesssasssss 167
SEIECT ettt sttt s bbb bR AR AR AR AR A e AR a AR e ARt bae AR e s AR st s tans 167
SEIBCEAIL ..ottt s s bbb s bbb e bbb e b e b st as e AR st b es b b e b e b assasstes st enbans 167
SEIECEBOIAE ...ttt et ses st bbb bbb as s s b bbb b e b s b a s bRt b es b besbasbassasssesssbenbans 168
SIMIlar... e, .. 168
SITIOOTN ettt sttt s b s bbb s a bbb A e s R bR bR A e bR bR AR A b A baeee 168

SH O ettt sttt sttt e e R e S E RS R S eeReReE Rt e R e R Rt e e e R R e R a e naen 168
STIOKE ettt sttt st b s bbb bbb AR AR e e R AR R e AR AR RS R et be A bR s se R s Rententans 168
EFANSIATE .ottt sttt b s bbb bR AR b bbb e bR R bbb et as b e Rt entenbans 168
EFANSIATEBOUNAIY ...t ssssssssssssssissssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssees 168
SGIRGBSAVEODPTIONS ...eveieeeeeernsissississssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssssessessanes 171
PrOPEITIES ... eeeeeeeeeererenenreasenseserssaetsessessessessssesssesssasessesssssesssssssesesssaseas s asse s ses e e s s sesesseasessesssssssesssssasesseasesssssessssss 171
AIPNACKANNEIS ..ttt sssse s sssss s asss st ssssssssas s s s st st s sassasssasassssssssasassssssssnsssnes 171
SPOTCOIOLS .ottt sssssssass s assssstss st ssassassassses s s b b bassas b e s s s aes s ss st s b e bessas e s basssss s s ses b s benbasbasbassassasssnssestessans 171
TYPENAIMIE .ttt st sttt sttt s s sttt sttt 171
SOlIACOION ettt sas s b s bbb et bbbt a s AR bbb bt es AR AR bt bbb e b st ses b s s benen 172
PrOPEITIES ottt sssassssssssssasssssssssassssssssassssass s bsssssssa s ssnsssasssssasstsssssssssssssssassssesssassnssssssssssnssneas 172
MY K ereetieaeeiseesseesss s ssssesssssessaessssssssesbsse s R e R RS s R RER RS R RS R R S R R SRR 172
GEAY et R R R R S R R E R S R RS R SRR R0 172
PSDce ettt s e sssRess b esaRaA AR AR b bbb AR R a b A s AR AR b tas 172
LDt e bbb bbb bbb AR AR bbb At a ARttt 172
NOAE ..ttt ss st bbb st b s bbb as e as bR bbbt et b en b bbb e s ansanststestans . 172
NEATESTWEIDCOION ...ttt bbb sass s s bbb b b e s s s bbb sasbassassassaesaessentes 172

FOD ettt bR RS R RS RS RR R R RS RSB R R 172
TYPENAMIE ...t bR R R bR R R R0 172
IMIEENOMAS ..ottt ettt ss st et s bbb b as s s s b s bbb b bes e s s A s AR bbb e b an e s st st esssbanen 172
ISEQUANL ettt sssssssess s ssssssssssssssssssssssssssssssssessssasssssessssssssssssssssssssssesssssessssssssssessassssssssasssssassessssnns 172
SUBPATIINTO ...ttt sass s s s sass s s s st s a s s bess s R bbb bR bR bR bR bRt bR bRt bR bR bbb 173
PrOPEITIES ottt st st sssssssssas s sssasassssssssassssass s bsssss st s sssssbassssstssssssstssssesssssassssesssassnssssssssssnssneas 173
ClOSEU .ottt s st essasssasssessasssenees . 173




Adobe Photoshop CC

JavaScript Scripting Reference 26
entireSubPath ceereee st a s e baees . 173
OPEIALION .ceererrenrrcrensesreesessrsssenseans . 173
EYPENAIME .ttt sssesssasesstss s s sssasssaseasassessessssssses 173

SUBPAtIEEM ... eirecreeeesessesessssessssssssasssanns . 174
PrOPEITIES ...ttt sttt st st b ss e st st s s st st s st s st st ensssss b s st astassenastastssntans . 174
ClOSEA ottt ssssssse s s s ssssssssssasssabsssssassssssasssesesa s s s bss s R SRR SRR RS RS R R bbb 0 174
OPEIALION eceerreeeiecrenrereeesessenssensenes . . 174

PATENT ..ttt ettt s sttt a sttt et A st ARt s eteRs bt Rt s sttt s et aen 174
PALNPOINTS ..ottt s ssssss s sss s sassssssssssasssesssssasssassasssasssessans 174
EYPENAIME .ottt sssessssassssssssssssessssasssssassssassssssssssssassssssesses 174
SUBDPATIITEMIS ...ttt isssssssssssssssssssssssssssssssssssssssssssssesssassssssssssssssssssssssssssssssssssssssssssssssssssasssnsons 175
PrOPEITIES .ttt st ss st sss st ss s s s s s s ssssansas . 175
[ENGEN oo s e AR AR R R AR bR AR bR en 175

PATENT ettt ettt ettt st bt sttt et A st R s s et E st s st a et s et aen 175
typename SRR 175
TargaSaveOptions..........creeeenncns . 176
Properties......ccoceeurenne. . . 176
AIPHACHANNELS ...ttt s aesanes 176
resolution ceerererserssasraens . 176
rleCompression ........coeeeevene. 176
typename cereeneesansrasesaees 176
TextFont rreeeeenreaensnetaees 177
Properties......ccoeeeurenne. . 177
FAMIY oot ss s sessseans . 177
name.............. sttt nees 177
PArENT...cterereeeeeseeeereesaeeenee 177
postScriptName . 177

style corseresesnaessnasens 177
TYPENAMIE c...eeeeeerenreeeerseseesssasesessessessasssssasesssssaseassssssessesesssasessssasessssssssases 177
TOXEFONTS cuceteereieerereerseresasessestsssesstssssasesssssssessassssessesssssssessassssessesssssasssstssssessssssassssssesstassssssesssssssastsssssasssssesssssns . 178
Properties......ccooveveunenne . . 178
[ENGLN oottt 178

PAreNt.... e 178
typename cereessssasseesesaees 178
MELNOMS ...oorerieereireiniseesseisssessisssessssssissssssssssssssssssssssssssssssssssssssssssssssssassssass . 178
getByName ceeveresrssassassaeaes . . . 178
TOXEITEIM ettt ssesseasssssessassssssasssssssessassssessassssessessasssseastsssssssesseastssssesstsssssssessssssesstassssnsssssenssans . 179
Properties.......coccverenne. . 179
alternateLigatures ........ceeeeneerenecennne 179
ANtIALIASMETNOM. .. sessasesssssenns 179
autoKerning ceetseser s s st aasaasessnssntes . 179
AULOLEAAINGAMOUNT ...evreteerreresesesessisseresssssssssssssssssssssssssssssssssssssssssssssssssssssessens 179
baselineShift.........ccrcenrenrrcnsrensiensrreseenens 179
CAPItAlIZATION .ottt se s sesseseanns 179
color..... . . 179
contents....ceeicnenes 179
deSiredGlYPNSCalING. .. iinesrireissssissesssssissssssssssssssssssssssssssssssssssssns 179
desiredLetterScaling ettt sans 180
desiredWordScaling .....rsisssrsinnes . 180
direction............. .. 180

L= 10D 4210) (o SRR .. 180




Adobe Photoshop CC

JavaScript Scripting Reference 27
fauxltalic cersesise st sisees .. 180
firstLinelndent......eeeeeverreeeerereersenne. 180
FONT ettt sttt b sssesbssesas .. 180
hangingPunctuation cereemeemeenaserans 180
NEIGNT et ssss b s s b sbss R s R ER RS RsERRsER AR R RS RReR0n 180
horizontalScale.....neniicnrnneneenneinnns .. 180
hyphenateAfterFirst cersreens e raseseaneees . . 181
hyphenateBeforeLast ..........cenneeneresseenseenseesseisessesisssisssasens 181
hyphenateCapitalWords .........nenneensenseseseeens 181
hyphenateWordsLongerThan cereereersenaennaseens 181
RYPNENATION ... issssessssissssssassssssens . 181
Y PNENATIONZONE ... crerecreineissssississssisssisssssssssssssssssssssssssssssssssssssssssssssssssns 181
hyphenLimit........cc........ ceerererserssasraens . 181
JUSTIfICAtiON ettt ressessens . 181
KIN ettt s s ssse s b sase s s sasasasssanss .. 181
language...... rertre e RS R R R Rt .. 181
[EAAING ueeeterrireiretissiseisseeseissssssssesssssssssssasssssssssssssssssssssssssassssssssssssssssses . . 181
[EFLINAENT .ottt sssssss s ssssssssssssssssssssssssassssssnns . 181
[IGATUIES ecerecieeeressissesnesssssasssesssssssssssssasssssssssssssssssssssssssassssssssssssssssses . . 181
MaximuMGIYPhSCaliNgG ... 181
maximumLetterScaling cereemeersenasennaseens 182
maximumWordScaling certeeenserasesaens 182
MINIMUMGIYPRSCAIING ccouveeirrireirrisrisensssisesesissssssssssissssssessssssssssssssssesssns 182
MINIMUMLETLEISCAlING couucverrrrerrrssrreisesssssissssssssissssssssssssssssssssssssssssasses 183
MIiNIMUMWOrdSCaling.......cceveernerenrensrnersssenseens . 183
NOBIEAK ...ttt bsse s ssssssssesssessssssssssasasassssnss .. 183
OlASTYIE.eeeeereerecrieiieesierisesssesssensasessanes .. 183
S = 1 L= 0 TR 183
POSITION .ottt et tes s ass s ss st s sssssssstsssessssassssssassassessses . 183
FIGhtINAENT . sessienees . 183
SIZE et ssaes . 183
SPACEATLEN ettt b s bss st ess s sass b ssssss s s s sasssassasssans 183
SPACEBEIOIE ..ottt s s sa bt asbass bt asssanees 184
SETKETRIU oottt sassssssessss s s sssssassssssssssnes . . 184
TEXECOMPOSET .cereereerieererresistesessssssssssssssassassessssassassssssssssssssssssssessssassassesaass . 184
tracking ceevnerssassasssssens . 184
EYPENAMIE ..eeeerenreeressesissseasisssessesssssssasssssssasessssssssasssssssssssssssssassassssases . 184
UNAEITINE oottt sesssessssss st sssssasesassssasssasess . .. 184
useAutolLeading certemeenserasenaaens . 184
VEITICAISCAIE ettt ss s sssesssessssssssssssssssssssssssssssssssssasasens 184
WarpBend ..., . . 184
WAIPDITECTION .uveercicrreerenseiseissississssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses . 184
WArPHOMZONTAIDISTOITION ... ivereererersresseeretssissessssssssssssasssesssssssssssssssssssssssssssssssssssssses 184
WAIPSEYIE ettt sisse b sssessssssssesssessssssssesns .. 184
WArPVErtiCalDiStOITION. ... .vverrerreerreeneeseessesisessssssssssssssssssssssssssssssssssssssesssesssssssseses 184
WIATN oottt s st b s bess b sasssens s bans . 184

IMIEEROMAS ...conveercerenrieei et seessess s ssesseesse s sesse s s asa bbbttt saats .. 185
CONVEITTOSNAPE .ot ssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssens . 185
CreatePath ... .. 185

TiffSaveOptions.....ccceeeeercnrieererernsinens .. 186

Properties... . . 186




Adobe Photoshop CC

JavaScript Scripting Reference 28
AIPNACNANNELS ...t sssssss b s s sss b s s b ss s s e bss s b b s ssasasn s sssssnbsnsasnbanees 186
ANNOTATIONS ..ottt s s b a s et bbbt bbbt snbas 186
DY LEOITET ettt sss bbb ses st s s bsse s e s s bbbk a sttt bnss 186
€MbDbEACOIOIPIOfilE. s ssesessassesasssanns 186
IMAGECOMPIESSION c.cccurrurrerrirrrerssessissessessssssssessssssssssssessesssssssssssssssssssssssssssssssssssssssssssssssassssssssssssssssssasssssassssssssssssseses 186
INTEIEAVECNANNEIS ...ttt sssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssessses 186
JPEGQUANILY «ovureerceireriseriiesietissessssessssessssssssssesssssssssessssssssssesssssssssses s sssssssssse s st s s s bt bas s s sbsses s ssssasssssssses 186
LAY EICOMIPIESSION...cureerrenreeeeiiseiessissesissesssessssssssssssesssessssesssesasasassesasesasss s et st besssasas i bssesssat s sabssasssassssssssasasassnss 186
layers.... it ta et a e a s AR AR AR AR SRR RS A ARttt 186
SAVEIMAGEPYIAMIT. ... ssssssssssssssssssssessssssssssssesssssssssssssssans 186
SPOTCOIOLS .ttt ess s sss s bes b s sassassassses b s es st as s e b e s ssass s es st besbesbasa s bassass s sesbsbenbesbasbassassasssessstassans 186
TFANSPATENCY c.eureeeeeereareeesenseesssseaseessessessssssseasesssstasesssssssessesssstasessssssseasssssssasessssssssasssssssasssssssaseassssssssesssssssasssssssses 186
TYPENAIMIE ..ottt eetessestssssessesssssssasassassasesssssassasasssssasess st astas e s st asesssesast et sasassssssseassssassassssssssssassssssanen 186
UNIEVAIUE ettt tiss et i st bbb e e bbbt 187
XIMPIMELAALA ..ottt sssssssssssssasssssssssssssssssssssessssssessssssssssassssssssssassssssasssssssessssssssssessasssssssessassssssssasssansssssanns 188
PrOPEITIES ...ttt estsessessesse s sssesssessaasessess s st s s assaaseas s sse s s s s e R s s s esesseasessassnssesessssasessensasssssessssss 188
PAENT..cevrieeireerrrtersisesssesssssssssssessssssssssssssssssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssessssssssesssssssssesssssss .188
FAWDIATA coeveeeeereerceneeecsee et sss s esse s as e sas et as s R R et nen 188
TYPENAIMIE ...eeerieerereersesestsssessssssessessssssessassassas st sassasasssssasess s sasaasbsssssasesssessstsssssasessssssseasssssssassssssssssasssssssnes 188

3 JavaScript Resource . ..189

JAVASCIIPT FESOUITE SYNTAX.cuuerereurrerenrenersersesssessessessessessesssssssssessessessssssssssssssssssessesstssesssssssssssesssesssssessessssssssessssasessessasssssssssss 189
BasiC JAVaSCript rESOUICE EXAMPIE ... vcereceeetseisisisesssstss st sassassass s s s sessasssssasssessessessessassassassassassasssessnns 190
ENADIE-INTO GramMIMAr ..ot ssssssssssss s sssssssssssssssss s ssssssssssssasssssssssssssssssssssssssssssssssssssasssssssssssnases 190
Undefined values in enable-info evaluation ..., 192
Using the "in" function........ccenrneeensecnssssssssssssssens . 193
Action Manager QULOMATION .....c.civecereererinesesissesesesssessessesssssssssssssssesssssssssssssssssssas 193
Terminology dictionary ................. .. 193
Value type defintions ... orrnneensensssssessssssessssssssssenns .. 194
Uniqueness rules for termMinolOgy ENTIES........orrnrrrneenserssessssssssssssssssssssssssssssssssnes 195
Terminology definition EXAMPIE ...ttt sessssssssassssssssens 195

4 Scripting Constants ......ccceccennneeee ..197
AdJUSTMENTREFEIENCE ...ouvveerceereererrireceieineessieessesssessssessssessassssssssassssasessssens 197
ANCROTPOSITION «.ccoverreeriereesrinsiesssississssssssssssssssssssssesssasssssssssssssssssssssssssssssssssssssssssssessssssssssssssssssssssssssssssssssssssssssnes 197
ANTIATIAS ovvrevrreernrerrsississeisssssisssssssssessssssssssesssssssssssssssssssssssssssssssssssssssasssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnes 197
AULOKEINTY P cceerereriresesiesseasisissssesssssssasasssssssessssssssassssssssssasssssssasssssssassasssssssassasassasssssssasssssssasssssssssasssssssses 197
BatChDESTINATIONTYPE ..cuuvreeerrrtrsresssessisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssans 197
Bt AP CONVEISIONTYPE .. eeeeeeeeeeuseenseesetsesstuseessesst et s essst st asst s sss bbb st b s st asesasesastasesases 198
BitmapHalfToneType ... 198
BitsPerChannelType.......eeeeenseeenseerenecesnnens 198
BIENAMOTE......coeeeeeeeceeenecmeeineesecss e ssase s ssssesasesssessssssssessse s esase s s e s R R s st bbb s et b s basassssense 198
BVIPDEPINTYPE ouveriereereerserseessesssissssssssssssssssssssssssssssssssssssssssssssssssssssssesssssssssssssssssssssssssssssssssssssssssasssssssssssssssssssssans 198
BYLEOIUET .uceeieeterersiseesesississsssssssssssssssssssssssssssssssssssssssssssssssssssesssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssasssssassassssns 199
CameraRAWSettingsType......c.c....... 199
CAMEIARAWSIZE ...ttt sssse sttt ssssse s s aasesstasesssssssssesssssasseasessensesssssssssssssasesssasessesssssssss 199
CRANGEMOAE....... e ssase s sssasessssessssssssssessass s st sse s bR R R bR bt b s ssaans 199
CRANNEITYPE ettt ssssissssssssssssssssssssassssssssssssssssssssssssssssassssssssssessssssssssssssssssssssssssss 199
COlOrBIENAMOAE ...t tisssiseessesssssssesssessssssasesns ..200
COIONMOEL ettt eissesasetssebasetssessssebssetas et s st bbb sttt bbb basaes 200
COIOTPICKET ettt ssiasesasssissssssesssssbssesssesass bt bsss st st bss st b st b st basebasasisssbasesases 200
ColorProfileType .....c.oeeeveeeeeeereevennee ..200




Adobe Photoshop CC

JavaScript Scripting Reference 29
COlOTREAUCTIONTY P .. ererersresrssetsssisssssssssssssssasssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssees 200
COlOISPACETYPE .ceererreeeiestissiasssissiasesassssssssssessssssssesssasassssssssssssasssssssssssssssssssassssssssesssesssessssssssesassssssesasassssssasesssass 200
CopyrightedType......cccuvvunnee. 200
CPEATEFIEIAS ..ottt s s s sssssssse s st s s st s s s s s st assasssasassssssassssssssssssssssnes 201
CrOPTOTYPE oecreeerriereincinensenseassissasssssssssssessesssssssssssssssssssssessssssssssssssssssssssassssssssssssssssssssssssassssssssssssssssssasssssassssssssssnsans 201
DS TY P e rrerrreisensisensessssssisssssassessessasssassssssssssssssssssssassssssssssssssssassssesssssssssssssssssssssssssassasessssssssssssssssasssssassssssssssssseses 201
DEPTNMAPSOUICE ...cverrereeinresresesssisssessssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssssssssssssssssssssssssssssssssssssssssassssns 201
DESCVAIUBTYPE .ottt seisse s sbssesssesssss s ssssses st ssse b et st s s st b s base st basasasasanss 201
DIAIOGMOAES ...ttt ssss st s s ssss s sssssass s sssssassssssssssessssssasssessssssasssessasssasssessassssssssssasssanssnssans 201
DIFQCLION .ottt sss st s ssess s sssesssssesssasssasessesseasessessssestssassess esesseasessessessssesssasasessaasensessessssseses 201
DisplacemMENTMAPTYPE c.veerreereeserssrsseissssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssns 202
DTN ot sssssssssssssssssssssssssssssssssssesssassssssssssassssssssssssssssssssssssssssssssssssssssssesssssssssssssses .. 202
DOCPOSItioNStYle .. reererrererrererenns . 202
DOCUMEBNTRIL ..ottt bssess st s ssse s st bbbt s st bsse st bbb asasanss 202
DOCUMENTIMOTE ..o isssisssissesasssisssssessssssssssssessssssssesss 202
EditLogltemsType.....ccovevenreererevennens 202
ElEMENTPIACEMENT ...ttt assssssssssssssssssssssssssssssssssassssssssssesssassssssssssssssssssssssssesssassssssessses 202
ElIMINATEFIEIAS «.ouverereeeerreiseieeiseiseisssisessssissssssssssssssssssssssssssssisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssasssssssssses 202
EX P OTETY PO ottt ssessessessssesstssssessassassssessasssssssssssssssessasssssastssssssassssssssssasssssssensesssssssens 202
EXEENSION ottt ss e sttt bbb sttt bbbt bbbttt bes 202
FIENGMINGTYPE c.oeerreneriiceieiraerissesssesssssesssssssssssssesssssssasessssssssssessasessssssssssessasessssssssesssssessssessassssssssssessasesssase 203
FONPIEVIEWTYPE ccoueercrccceeieecaseeiessasstssesssessssssesssessssasenases 203
FONTSIZE .o ereiieirereseiseisesseiesssessessessesssasssssssssssssssssessssssssssssssssasssssssesssasssssssssssssssssssssassasessssssssssssssssasssssasssssssessssseses 203
FOTCERATOIONS ..ottt sisebase s s st s b ssse st bsse st Rt bbbttt seass 203
FOPMATOPTIONS cucvueeeererrrieisisinessessssseisssssisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssseses 203
GalleryConstrainType... 203
GallEIYFONTTYPE cccoureenreraeriaeersseessessssesessessssessssssssasessssesssssessssessssssssssssasessssesssssessasesssssssssssssssesssssssssessasesssssssanens 204
GallerySecurityTeXtCOIOITYPE ....weereeemeeereesseesssressenens 204
GallerySecurityTextPositionType........cccvevrrvenens 204
GallerySecurityTextRotateType .....cvevrverrersersseeneenns 204
GallerySecurityTYPE ...ovnenernerssereressesnees . 204
GalleryThumbSizeType......coucvrinrerrnerns 204
GEOMEBLIY .couereerrrcenieeiesestseesesssesssasssssssssssssssssssesssensssssessses 204
GIIALINESTYIE c.erreeeeereereeceiseesessasesessessssessssesssssessssessasessssssssasessssesssanens 204
GridSize ceevrsersssissaasans . 204
GUIELINESTYIE ... sessssssssssssssssssssssssssssssssssssssssssssssssssssssssssns .. 205
[HustratorPathType.....eeeerneecnernneenernns . 205
INEENT ettt esse e s s ss st s snes .. 205
JUSEIfICAtION e .. 205
Language 205
LAy ErCOMPIESSION...ccvereirererreseiasessessessssssssssssssssssessessassasssssssssssssssssssssesssssssnss 205
LAYEIKING ..curereeireresinsisssissisnsissssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasses .. 206
LeNSTYPE.reeerereeeenreseenseasesesseaens .. 206
MagnificationTYPe .....oeceereereereeeeeeseensecanne 206
MATEETYPE ..ottt tssessesestassssessstssssssessessssssssasesssessssasessses 206
MeasurementRaNge ... ccereccesceeensessesenenane 206
MEASUIEMENTSOUICE ..eovererrenrerenrinsessesssseissssssssesssssessssssssssssssssssssssssssssssessssssssssses 206
NEWDOCUMENTMOME.....couiirerrieiieeiseiasetiseisesssetsessssesssesssssssssssessssssassssssssssssssesssess 206
NoiseDistribution.......c...cc...... .. 207
OffSEtUNAEfINEAAIAS ...ttt sssssissssssessssssssesns 207
OpenNDOCUMENTMOAE. ...ttt ssssssessssssessasssesssssanss 207



Adobe Photoshop CC

JavaScript Scripting Reference 30
OPEND OCUMENETYPC.coueeerieirrrieissisisssssesssssessssssisssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssssssssssssssssssssssssssssssssnsans 207
OperatingSystem.......coccoeeeeeeveeneennes 207
OFENTATION c.cv ettt eeas s tasesss st bt ss st b st bbb as bbbt bbb bbb b s banees 207
OtherPaintiNnGCUISOIS ......cueeuueererrmseesserssseresssessssessssesssssessasessssens 208
PAINTINGLUISOIS c..uceurrerenrriiereireseissessissesseasssssssessssssssssssassesssssssssssssssssssssssssssssssssssssssssssssssassssssssssssssssssasssssasssssassssssseses 208
PalETIETYPIE c.euvereeresrisseessesseisssssesssssssssssssssssssssssssssssssssssssssssassssssssssssssssssssssssssssassssssssssessssssssssssssssssssssssssssessssssssssesssns 208
PATNKING..c.eeeiteieietieciretsecie ettt it bases b b ss st bs bttt sttt bbb sbass 208
PO COMPALIDIILY..rvvurienereeeeeeineiseiesseisssisesiseissesssssissesssesssesssssasse s sasss s sssssbsssbssessssssssasssassssasssasssassssssssasasessnss 208
PDFENCOTING....ctiiiterirriinrississiesssssssssssasssssssssssssssssssssssssssssssssassssssssssassssssssssssssssssssssssassssssasssssssessassssssssasssassssssasns 208
PDFRESAMIPIE «..oceereeeeeeeeceseisissssssssessssssssssssssessssssssssssesssessssssssessssssssssssssssssssssssssssssssssssssassssssssssssesssessssssssasssasssss 209
PDFSTANAAIA ..conevreeeeceeeneenecnnreaseesssesssesasesssesssesssessssssssesssessssesssesssessssssssesssssasssssesssssssssssesssessssesssesssessasssssesssessass 209
PROTOCDCOIOISPACE ... ereeeeeretsrsiseesessess st sessasssssas st sssses s ssssassasssss s sssses b s bessassasssssassses st s sassassasssnssnssssessas 209
PROTOCDSIZE ...coueeneeeeeeeeneesetiseessisseissesasesssebssesasesssstbssessset s sase bt ass b et b s s sttt bbb s et b bt asatease 209
PICTBitsPerPiXels.....eeereereereeerseesersesanne ..209
PICTCompression... 209
PICtUIrEPaCKAgETEXITYPE..coureeereernrrsseessesseesssssesssessssssssssssessasessssessasessssesssnes 209
POINTKING «.ooveveereresisneiseesssineissessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssssssssssssssssssssasssssssssssssns 210
POINTTYPIE cocverrieirencisesensesseissssesssessissessesssssssssssssssssssssssssssassssssssssssssssassssssssssssssssssssssssassassssssssssssssssssssssssasssssssassssseses 210
POlarCONVEISIONTYPE c.ureerrrerrreisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssesssans 210
PIOVIBW ...ttt ss bbb sasess s b bbbt s bbb sttt bes 210
PrintColorHandling .......cceceeeeecensenesecnnecenens 210
PUPGETAIGET ...ttt sasessssssssasssssessse s sssessse st sssasstssessssssssssesase s sasssssssssssssasstasesssesassasessses 210
QUETY SEATETYPC .cecrrenrensensernsisessesssessessesssssesssssssssssssssessasssssesssssssssssssassssssssssssssssssssssssasessssssssssssssssassassasssssassssnsans 210
RAIAIBIUIMETOM. ... .ottt saseisetssesssssssesssetsssssssesssstsss e sasssssse s basesssetsssbssatssasssssbasasasassass 210
RAIAIBIUIQUAIILY ..vuvereeeeerernreseereississsessssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssssssans 210
RASTEIIZETYPIO ..ttt sttt sttt st bbb sttt bes 210
ReferenCeFOIrMTYPE ... ceeeeerseeieeseessesessessaesssssessaseesanessanse 210
RESAMPIEMETNOM ...ttt sesssssanes 211
RIPPIESIZE oottt ses s s ss s sasssss s bbb s e s s bbb e bbb as AR Rttt bas b e s assans s s tessentas 211
SAVEBENAVION ...ttt eiass e sass b sssetbasesases s bbb bass s ettt bttt st tbase 211
SAVED OCUMENTTYPE «.ocvuerrieirinnisnensensenseisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnsans 211
SAVEENCOAING .ottt isstsesess st tes s sassssssass s ssssass s sesssssbesssesssssbasssesssssssssasssassssssssssassssssassssssasssanees 211
SAVELOGIEMSTYPE ...eeerereneerrereesersesesessesssssesssssesssesseasessessenns 211
SAVEOPTIONS ..cceeeeeuenenrirersesersessesessessessesssssesssssssssesseasessessesssssssssssssssessesssssesssssssssssssssesssssessesssssssssssssasesssssessssssssssses 211
S O LT IONTY P errrneirsiesesserssssssassssessssssssssssssassssssssssssssssssssssssesssassssssasssassssssssssssssssssssssssasssassssssssssassssssssssssssssssssnss 212
SNAPEOPEIALION ..t st sssssss s ssssssssssssssssssssssbasssssssssbasssssssssssassssssssssssssnsassssssssnsssssssssnees 212
SINAMBIUIMOE .ttt eiasesasetasse bt s b st st bass s sttt sttt b 212
SMNANBIUrQUANILY .oveeeveeeereteeciretsetiseesetse s sssesissesssessssssssssssessssssssssssasenss .212
SOUICESPACETYPE cecereeercerersensensensenssssesssesessesseasesssssenss 212
SPNEIZEMOAE ...ttt ssssssssesssas s s s s s e s et b st R b s s s s s s sssasasasases 212
STIKETIIUTYPE cooveereeisresinseisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssssssssssssssssssssssssssssses 212
SETOKELOCATION. c..cevieeeieeieectneesetseeessetase sttt s sss b ssse st ase b base bbb s bbbttt tbase 212
TArgABILSPEIPIXEIS ettt sssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnsessens 212
TEXECASE ccuueuerneeusreneueeuessesetasess e ess st bbbttt e e bRttt st et 213
T OXEC OMPOSEN c.eceueeeciierinrisesissrstsssssssssssssssssasssssssssssssassssssssssssssssssassesssssssssssssssssssssasssssssessssssssssssssssssasssssssssssssssssnes 213
TEXETYPIE ettt ssssss st s s s sss s s s ss s s b bR bR et 213
T OXEUIETY P cueeeeereurensrareissessesssasesseassssssssssssssesssasessssssssssssssssasssssssssssssessssssssssassassssssssssessssssssssssssssssssssssssssasssssssessnss 213
TIFFENCOQING.cuitrrirerereinsessssisssissssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssessens 213
TOOITYPE cecrtrerrrisseresssisssssssssssssssssssssessssss s ssssssssssssssssssssssssssssssssssssssssssssssasasssessssssssssessssssssssssssssssssssssssssassessssnsessens 213
TrANSTHONTYPE ettt b s ssss s es st s bbbt s bbbt st benen 213
THIMITY P ettt res st st s s b e et 214



Adobe Photoshop CC

JavaScript Scripting Reference 31
TYPQUNIES .o ereeereiceeesissiessessesesssasesssessessssssssasessssssssasssssssasasssssastasssssssasssssssasessssssssassssssssssssssssstssssssssssssssssssesssssssens 214
UNAEIINEAATEAS ..ot issesssessssssssessssssssssssesasassssssasssassssssssssssassssssasssesssassssssssessssssssssssasssasssss 214
UNAEITINETYPE ottt ssssssssssssessssssssesssessssssssesasesassssssesasassssssssssassssssssssasssassssasssasssessssssssasssasssss 214
U NS eniieereireeieeeisessesessesesssssesssessessessesssssssssssssasessasstssesssssesssssssasessessessessessssessssssssssssssnsensessessessssssssasasssssasessessessssseses 214
UIGENCY werrieierrinrennennennsssesssssesssesssssessessssssssssssssssssssssssssssssssssssnss veereeesssassaseaseassaaes 214
WATPSTYIE ceeereirniissinsiseississsisssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnss 214
WaveType....enereeesennenes ettt et b R E RS seR R AR AR AR s R et e s s un e s e Rstans 215
W NItEBAlANCETY PO ..ottt sttt sttt b st as st bt s s bbbt isss s sasaes 215
ZIGZAGTYPE ceeeerereeeeeesensensissesssssessssssasesse s st sasesssasess s s s a st s s bbb sttt 215

Appendix A: Event ID Codes ...... cessssssnsnnseessne cessssssnnnnsesesne cesesessnnnnnanee 216

(111 (=) QPP . ceeee 224




Introduction

This reference describes the objects and methods in the Adobe® Photoshop® CC® JavaScript™ type library.
A companion document, Photoshop CC Scripting Guide, describes basic scripting concepts and the
Photoshop object model. This document provides reference details of the Photoshop object model, and
additional information on JavaScript-specific features.

Adobe Photoshop CC uses ExtendScript, Adobe’s extended implementation of JavaScript. See JavaScript
support in Adobe Photoshop CC for additional information.

This book contains the following sections:

e This introduction, which describes scripting support in Adobe Photoshop CC, and lists changes to the
JavaScript interface since the previous release.

e JavaScript Object Reference, which provides a complete reference for all Photoshop DOM objects and
commands.

e Scripting Constants, which lists all enumerations used in the Photoshop type library.

For a JavaScript file to be recognized by Photoshop as a valid script file, it must use eithera .5s ora .jsx
extension.

On the Mac OS, there is no difference in the way scripts with the two extensions function. On Windows, if
the script files is opened from inside Photoshop, there is no difference between using the .js and . jsx
extension. However, if the script is launched by double-clicking on it, a script with the . s extension is
interpreted with the Microsoft JScript engine, and it cannot launch Adobe Photoshop CC. For Windows,
using the . jsx extension is preferrable, since it interprets the script with the ExtendScript engine.

All of the Adobe Creative Suite 6 applications, including Adobe Photoshop CC, use ExtendScript, Adobe’s
extended implementation of JavaScript. ExtendScript files are distinguished by the . §sx extension.
ExtendScript offers all standard JavaScript features, plus additional features and utilities, such as:

e Adebugging environment (the ExtendScript Toolkit)

e Alocalization utility

e Tools that allow you to combine scripts and direct them to particular applications

e Platform-independent file and folder representation

Many of the JavaScript objects and methods use objects defined in ExtendScript, such as the File object,

the Folder object, and the unitvalue object. For that reason, using the . jsx extension for your script
files is preferable.

For details of these and additional features, see the JavaScript Tools Guide CC. This document is installed
with Creative Suite 6 applications at these locations:
e In Windows:

C:\Program Files\Adobe\Adobe Utilities\ExtendScript Toolkit CC\SDK
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e InMacOS:

Applications/Utilities/Adobe Utilities/ExtendScript Toolkit CC/SDK

The latest versions of this document and of the ExtendScript Tookit, can also be downloaded from Adobe
Developer Center, http://www.adobe.com/devnet/.

The Adobe Photoshop CC interface includes a Scripts menu (File > Scripts) which provides quick and easy
access to your JavaScripts. Scripts can be listed directly as menu items that run when you select them, or
you can navigate to and run any JavaScript in your file system.

If Adobe Photoshop CC encounters an error during script execution, it displays the error message.

To install a JavaScript in the Scripts menu, place it in the Scripts folder (Photoshop CC/Presets/Scripts).
The names of the scripts in the Scripts folder, without the file name extension, will be displayed in the
Scripts menu. Any number of scripts may be installed in the Scripts menu.

Scripts added to the Scripts folder while Adobe Photoshop CC is running will not appear in the Scripts
menu until the next time you launch the application.

All scripts found in the Scripts folder and sub-folders are displayed at the top level of the File > Scripts
menu. The addition of sub-folders does not add a hierarchical organization to the Scripts menu.

The Browse item at the end of the Scripts menu (File > Scripts > Browse) allows you to execute scripts
which are not installed in the Scripts folder. You can also use Browse to select scripts installed in the Scripts
folder after the application was last launched.

Selecting Browse displays a file browser dialog which allows you to select a script file for execution. Only
.js or .jsx files are displayed in the browse dialog. When you select a script file, it is executed the same
way as an installed script.

On startup, Adobe Photoshop CC executes all . jsx files that it finds in the startup folders.
e On Windows, the startup folder for user-defined scripts is:
C:\Program Files\Common Files\Adobe\Startup Scripts CC\Adobe Photoshop
e On Mac OS, the startup folder for user-defined scripts is:
~/Library/Application Support/Adobe/Startup Scripts CC/Adobe Photoshop
If a script is meant to be executed only by Adobe Photoshop CC, it must include code such as the
following:

if ( BridgeTalk.appName == "photoshop" ) {
//continue executing script
}

For additional details, see the JavaScript Tools Guide CC.
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The JavaScript API follows JavaScript naming conventions in that all classes (object types) begin with
uppercase letters and have mixed case. Typically, in JavaScript, you instantiate classes using the new
operator:

new ClassName () ;
However, in the Photoshop Object Model, it is often not necessary to do this. Major object types are
collected into collection classes; for example, a list of Document objects is contained in a Documents

collection object. You then access the collection object through a corresponding collection property in its
container in the object hierarchy.

For example, the collection of all open documents is contained in the top-level application object. You
can access this through the global variable app, or simply reference its properties directly at the top level:

app.documents [0] // get the first loaded documented
documents [0] // this is the same

A collection property has the same name as the collection object, but begins with lowercase. For example,
a Document contains a collection of Layersets, and a Layerset contains a collection of ArtLayers. To
access one ArtLayer object in a set:

var myLayer = activeDocument.layerSets[0] .artLayers[0];
The collections, as in this example, can be treated as arrays, which is useful for iteration. They also provide
methods to create their contained objects, and to access them by name:

var newlLayer = activeDocument.artLayers.add(); // Create a new ArtLayer object
newLayer.name = "My Layer"; // name it for later reference

var layerRef = activeDocument.artLayers.getByName ("My Layer") ;

Some objects, such as the Font objects contained in the app . fonts collection, are created by the
application, and never by your scripts.

Your scripts do use the JavaScript new operator to create helper objects, such as those that encapsulate a
set of options for opening or saving a document in a particular format:

var opts = new PDFOpenOptions() ;
opts.page = 10;
app.open (myPDFFile, opts) ;

The following changes have been made to the JavaScript object model and language support in Adobe
Photoshop CC:

e New methods and properties:

e boundsNoEffects has been added to the ArtLayer object.

e amount parameter has been added to the resizeImage method of the Document object.
e Modified enumerations:

e AUTOMATIC, BICUBICAUTOMATIC and PRESERVEDETAILS have been added forthe
ResampleMethod enumeration.



2

JavaScript Object Reference

The Photoshop objects (the JavaScript type library for Adobe® Photoshop® CC) are presented
alphabetically and in tabular format in this chapter. Sample code for several object model classes is given
to help illustrate the syntax as well as usage of the object class.

Object properties and methods are described in separate tables for each object. The following sections
describe the conventions used in these descriptions.

The Properties table for an object lists the following:
e The properties defined in each object.
e The value type for each property.

When the value type is a constant or another object, the value is a hypertext link to the listing for that
constant or object.

e The property’s input status: read-only or read-write.

e Adescription that explains what the property does.

Property Value type Whatitis

displayDialogs DialogModes Read-write. The dialog mode for the application, which controls
what types of dialogs should be displayed when running
scripts.

For constants, like bialogModes in the sample, click the link to go to the table that shows allowed values.
Constants are represented by objects, and allowed values are properties of those objects. Specify a
constant value in the form ConstantName.VALUE. For example:

app.displayDialogs = DialogModes.ERROR;

The Methods table for an object lists the following:

e The method name.

e The parameters list.

e The parameter value types, on lines corresponding to each parameter.
e Return value type

e Adescription of what the method does, and further descriptions of parameters, if needed.

35
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Method Parameter type Returns What it does
crop Crops the document. The
(bounds %ﬁatixfzaolfu g bounds parameter is an array of
[, angle] number four coordinates for the region
E' K;(iitﬁ]t] ) Unitvalue remaining after cropping, [left,
r el UnitvValue top, right, bottom].

When a parameter type or return value is a constant or another object, the value is a hypertext link to the
listing for that constant or object.

Parameters can be required or optional. Optional parameters are indicated in the table by square brackets
(. In the example, the first parameters, bounds, is required. The remaining parameters are all optional.

You must pass a value for each required parameter. You can leave out optional parameters if there are no
remaining values to pass; however, if you wish to use the default value for any optional parameter that is
not the last one specified, pass undefined as a placeholder. You must enter the values in the order they are
listed, so that the JavaScript compiler knows which value you are entering.

For example, the following passes only the required parameter (using a previously-defined variable for the
bounding region):

app.activeDocument.crop ( myRegion ) ;

The following skips the angle parameter, specifies the width value, and omits the final height value:

var myWidth = new UnitValue( "500 pixels" );
app.executeAction ( myRegion,undefined, myWidth ) ;
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This object provides a dictionary-style mechanism for storing data as key-value pairs. It can be used for
low-level access into Photoshop. See an example of this usage in ‘Selection sample script’ on page 168.

Many configuration files use serialized action descriptors to represent their data. It is used, for example, to
encapsulate playback options in Application.playbackParameters, and is returned by
Application.getCustomOptions().

Property Value type What it is

count number Read-only. The number of keys contained in the descriptor.

typename string Read-only. The class name of the referenced

actionDescriptor object.

Method Parameter type Returns What it does

clear Clears the descriptor.
0

erase Erases a key from the descriptor.
(key) number

fromStream . Creates a descriptor from a stream
(value) string of bytes; for reading from disk.

getBoolean boolean Gets the value of a key of type
(key) number boolean.

getClass number Gets the value of a key of type
(key) number class.

getData string Gets raw byte data as a string
(key) number value.

getDouble number Gets the value of a key of type
(key) number double.

getEnumerationType number Gets the enumeration type of a
(key) number key.

getEnumerationValue number Gets the enumeration value of a
(key) number key.

getInteger number Gets the value of a key of type
(key) number integer.

getKey number Gets the ID of the Nth key,
(index) number provided by index.
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Method Parameter type Returns What it does (Continued)

getLargelnteger number Gets the value of a key of type
(key) number large integer.

getList ActionList Gets the value of a key of type list.
(key) number

getObjectType number Gets the class ID of an object in a
(key) number key of type object.

getObjectValue ActionDescriptor Getsthe value of a key of type
(key) number object.

getPath File Gets the value of a key of type
(key) number File.

getReference ActionReference  Gets the value of a key of type
(key) number ActionReference.

getString string Gets the value of a key of type
(key) number string.

getType DescValueType Gets the type of a key.
(key) number

getUnitDoubleType number Gets the unit type of a key of type
(key) number UnitDouble.

getUnitDoubleValue number Gets the value of a key of type
(key) number UnitDouble.

hasKey boolean Checks whether the descriptor
(key) number contains the provided key.

isEqual boolean Determines whether the
(otherDesc) ActionDescriptor descriptor is the same as another

descriptor.

putBoolean Sets the value for a key whose type
(key, number is boolean.
value) boolean

putClass Sets the value for a key whose type
(key, number is class.
value) number

putData Puts raw byte data as a string
(key, number value.
value) string

putDouble Sets the value for a key whose type
(key, number is double.
value) number

putEnumerated Sets the enumeration type and
(key, number value for a key.
enumType, number number

value)
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Method Parameter type Returns What it does (Continued)
yP

putInteger Sets the value for a key whose type
(key, number is integer.
value) number

putLargeInteger Sets the value for a key whose type
(key, number is large integer.
value) number

putList Sets the value for a key whose type
(key, number is an ActionList object.
value) ActionList

putObject Sets the value for a key whose type
(key, nuﬁer is an object, represented by an
classID, numoer i i
) ActionDescriptor Action Descriptor.

putPath Sets the value for a key whose type
(key, number is path.
value) File

putReference Sets the value for a key whose type
(key, number is an object reference.
value) ActionReference

putString Sets the value for a key whose type
(key, number is string.
value) string

putUnitDouble Sets the value for a key whose type
(key, nuﬁer is a unit value formatted as a
unitib, T double
value) number

toStream string Gets the entire descriptor as a

0

stream of bytes, for writing to disk.
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This object provides an array-style mechanism for storing data. It can be used for low-level access into

Photoshop.

This object is ideal when storing data of the same type. All items in the list must be of the same type.

You can use the "put" methods, such as putBoolean(), to append new elements, and can clear the entire
list using clear(), but cannot otherwise modify the list.

Note: The actionList object is part of the Action Manager functionality. For details on using the Action
Manager, see the Photoshop CC Scripting Guide.

Property Value type What it is

count number Read-only. The number of commands that comprise the
action.

typename string Read-only. The class name of the referenced

ActionList object.

With the exception of the clear () method, you use the methods of this object to either get the value of a
specific type of data in the list or set (put) the value type.

Method Parameter type Returns What it does

clear Clears the list.
0

getBoolean boolean Gets the value of a list element of
(index) number type boolean.

getClass number Gets the value of a list element of
(index) number type class.

getData string Gets raw byte data as a string
(index) number value.

getDouble number Gets the value of a list element of
(index) number type double.

getEnumerationType number Gets the enumeration type of a list
(index) number element.

getEnumerationValue number Gets the enumeration value of a
(index) number list element.

getInteger number Gets the value of a list element of
(index) number type integer.
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Method Parameter type  Returns What it does (Continued)

getLargeInteger number Gets the value of a list element of
(index) number type large integer.

getList ActionList Gets the value of a list element of
(index) number type list.

getObjectType number Gets the class ID of a list element
(index) number of type object.

getObjectValue ActionDescriptor Gets the value of a list element of
(index) numder type object.

getPath File Gets the value of a list element of
(index) number type File.

getReference ActionReference  Gets the value of a list element of
(index) number type ActionReference.

getString string Gets the value of a list element of
(index) number type string.

getType DescValueType Gets the type of a list element.
(index) number

getUnitDoubleType number Gets the unit value type of a list
(index) number element of type Double.

getUnitDoublevValue number Gets the unit value of a list
(index) number element of type double.

putBoolean Appends a new value, true or
(value) boolean false.

putClass Appends a new value, a class or
(value) number data type.

putData Appends a new value, a string
(value) string containing raw byte data.

putDouble Appends a new value, a double.
(value) number

putEnumerated Appends a new value, an
(enumType, number enumerated (constant) value.
value) number

putInteger Appends a new value, an integer.
(value) number

putLargeInteger Appends a new value, a large
(value) number integer.

putList Appends a new value, a nested
(value) ActionList action list.
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Method Parameter type  Returns What it does (Continued)

putObject Appends a new value, an object.
(classID, number .
value) ActionDescriptor

putPath Appends a new value, a path.
(value) File

putReference Appends a new value, a reference
(value) ActionReference to an object created in the script.

putString Appends a new value, a string.
(value) string

putUnitDouble Appends a new value, a unit/value
(classID, number pair.

number

value)
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This object provides information about what the action is refering to. For example, when referring to the
name of something you might use keyName. The reference would also need to know what name you are
referring to. In this case you could use classDocument for the name of the document or classLayer for the
name of the layer. It can be used for low-level access into Photoshop.Contains data associated with an
ActionDescriptor.

Property Value type What it does
typename string Read-only. The class name of the referenced Action
object.
Method Parameter type Returns What it does
getContainer ActionReference  Gets areference contained in this
0 reference.
Container references provide
additional pieces to the reference.
This looks like another reference,
but it is actually part of the same
reference.
getDesiredClass number Gets a number representing the
0 class of the object.
getEnumeratedType number Gets the enumeration type.
0
getEnumeratedValue number Gets the enumeration value.
0
getForm ReferenceFormType Gets the form of this action
0 reference.
getIdentifier number Gets the identifier value for a
0 reference whose form is identifier.
getIndex number Gets the index value for a
0 reference in a list or array.
getName string Gets the name of a reference.
0
getOffset number Gets the offset of the object’s

O index value.

getProperty number Gets the property ID value.
O
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Method Parameter type What it does (Continued)
putClass Puts a new class form and class
(desiredClass) number type into the reference.
putEnumerated Puts an enumeration type and ID
(desiredClass, nuﬁer into a reference along with the
I er .
emllmTi)/Pef nimber desired class for the reference.
value
putIdentifier Puts a new identifier and value into
(desiredClass, nuxer the reference.
value) numoer
putIndex Puts a new index and value into
(desiredClass, number the reference.
value) number
putName Puts a new name and value into
(desiredClass, number the reference.
Value) strlng
putOffset Puts a new offset and value into
(desiredClass, number the reference.
value) number
putProperty Puts a new property and value into
(desiredClass, number the reference.
number

value)
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The Adobe Adobe Photoshop CC application object, which is the root of the object model and provides
access to all other objects. This object provides application-wide information, such as application defaults
and available fonts. It provides many important methods, such as those for opening files and loading
documents.

To access the properties and methods, you can use the pre-defined global variable app. For example:

var docRef = app.documents.add (800, 600, 72, "docRef", NewDocumentMode.RGB) ;

The properties and methods of the application object are also available at the top level; you can omit
references to the application object altogether. For example:

var docRef = documents.add (800, 600, 72, "docRef", NewDocumentMode.RGB) ;

This usage can be somewhat ambiguous; for clarity, it is recommended that you use an explicit reference

to app.

Property Value type What it is

activeDocument Document Read-write. The frontmost document.
Setting this property is equivalent to clicking an
open document in the Adobe Photoshop CC
application to bring it to the front of the screen.
Tip: If there is no open document, accessing this

property throws an exception.

backgroundColor SolidColor Read-write. The default background color and color
style for documents.

build string Read-only. Information about the application.

colorSettings string Read-write. The name of the current color settings,
as selected with Edit > Color Settings.

displayDialogs DialogModes Read-write. The dialog mode for the application,
which controls what types of dialogs should be
displayed when running scripts.

documents Documents Read-only. The collection of open documents.
This is the primary point of access for documents
that are currently open in the application. The array
allows you to access any open document, or to
iterate through all open documents.

fonts TextFonts Read-only. The fonts installed on this system.

foregroundColor SolidColor Read-write. The default foreground color (used to
paint, fill, and stroke selections).

freeMemory number Read-only. The amount of unused memory

available to Adobe Photoshop CC.
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Property Value type What it is (Continued)

locale string Read-only. The language location of the
application.
An Adobe locale code consists of a 2-letter ISO-639
language code and an optional 2-letter ISO 3166
country code separated by an underscore. Case is
significant. For example, en US, en UK, ja_JB de DE,
fr FR.

macintoshFileTypes array of string Read-only. A list of file image types Adobe
Photoshop CC can open.

measurementLog MeasurementLog The log of measurements taken.

name string Read-only. The application's name.

notifiers Notifiers Read-only. The collection of notifiers currently
configured (in the Scripts Events Manager menu in
the Adobe Photoshop CC application).

notifiersEnabled boolean Read-write. True if all notifiers are enabled.

path File Read-only. The full path to the location of the

playbackDisplayDialogs

playbackParameters

preferences

preferencesFolder
recentFiles
scriptingBuildDate
scriptingVersion

systemInformation

typename

DialogModes

ActionDescriptor

Preferences

File
array of File
string
string

string

string

Adobe Photoshop CC application.

Read-write. The dialog mode for playback mode,
which controls what types of dialog to display
when playing back a recorded action with the
Actions palette.

Read-write. Stores and retrieves parameters used as
part of a recorded action. Can be used, for example,
to control playback speed.

Read-only. The application preference settings
(equivalent to selecting Edit > Preferences in the
Adobe Photoshop CC application in Windows or
Photoshop > Preferences in Mac OS).

Read-only. The full path to the Preferences folder.
Read-only. Files in the Recent Files list.

Read-only. The build date of the Scripting interface.
Read-only. The version of the Scripting interface.
Read-only. Runtime details of the application and
system.

Read-only. The class name of the referenced app
object.
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Property Value type What it is (Continued)
version string Read-only. The version of Adobe Photoshop
application you are running.
windowsFileTypes array of string Read-only. A list of file image extensions Adobe
Photoshop CC can open.
Method Parameter type Returns What it does
batch string Runs the batch automation routine
(inputFiles, air?f‘y of File (similar to the File > Automate >
action, string Batch command).

from string .

[, options]) BatchOptions The inputFiles parameter specifies
the sources for the files to be
manipulated by the batch command.

beep Causes a "beep" sound.
0
bringToFront Makes Adobe Photoshop CC the
0 active (front-most) application.
charIDToTypeID number Converts from a four character code
(charID) string (character ID) to a runtime ID.
doAction Plays an action from the Actions
(action, S’ér%ng palette. The action parameter is the
from) string name of the action, the from
parameter is the name of the action
set.
eraseCustomOptions Erases the user object with specified
(key) string ID value from the Photoshop registry.
executeAction ActionDescriptor Playsan Action Manager event.
(eventID number .
[, descriptor] ActionDescriptor
[, displayDialogs]) DialogModes
executeActionGet ActionDescriptor Obtainsinformation about a
(reference) ActionReference predefined or recorded action.
featureEnabled boolean Determines whether the feature
(name) string specified by name is enabled.

The following features are supported
as values for name:

"photoshop/extended"
"photoshop/standard"
"photoshop/trial"
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Method Parameter type Returns What it does (Continued)
getCustomOptions ActionDescriptor Retreives user objectsin the

(key) string Photoshop registry for the ID with
value key.
isQuicktimeAvailable boolean Returns true if Quicktime is installed.
0
load Loads a support file (as opposed to a
(document ) File Photoshop image document) from

the specified location.

makeContactSheet string DEPRECATED for Adobe Photoshop CS4.
(inputFiles array of File
[, options]) ContactSheetOptions
makePDFPresentation string DePRECATED for Adobe Photoshop CS4.
(inputFiles, array of File
outputFiles File . .
[, options]) PresentationOptions
makePhotoGallery string DEPRECATED for Adobe Photoshop CS4.
(inputFolder, E$l§
outputFolder File .
[, options]) GalleryOptions
makePhotomerge string DEPRECATED for Adobe Photoshop CC.
(inputFiles) array of File Use provided script:

runphotomergeFromScript = true;

S.evalFile( app.path +
"Presets/Scripts/Photomerge.jsx")
photomerge . createPanorama (
fileList, displayDialog );

Merges multiple files into one, with
user interaction required.

makePicturePackage string DePRECATED for Adobe Photoshop CS4.
array of File

(inputFiles . )
PicturePackageOptions

[, options])
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Method

Parameter type Returns

What it does (Continued)

open
(document
[, as]
[, asSmartObject])

openDialog
0

purge
(target)

putCustomOptions

(key,
customObject
[, persistent])

refresh
()

refreshFonts
()

runMenultem
(menuID)

Document
File
object or OpenDocumentType
boolean

array of File

PurgeTarget

string
ActionDescriptor
boolean

number

Opens the specified document.

Use the optional as parameter to
specify the file format using the
constants in OpenDocumentType; Of,
you can specify a file format together
with its open options using these
objects:

CameraRAWOpenOptions
DICOMOpenOptions
EPSOpenOptions
PDFOpenOptions
PhotoCDOpenOptions
RawFormatOpenOptions

Use the optional parameter
asSmartObject (default: false)to
create a smart object around the
opened document.

See the Application sample scripts for
an example of using the File object
in the open method.

Invokes the Photoshop Open dialog
box for the user to select files.

Returns an array of rile objects for
the files selected in the dialog.

Purges one or more caches.

Saves a customized settings object in
the Photoshop registry.

key is the unique identifier for your
custom settings.

customObiject is the object to save in
the registry.

persistent indicates whether the
object should persist once the script
has finished.

Pauses the script while the
application refreshes. Use to slow
down execution and show the results
to the user as the script runs. Use
carefully; your script runs much more
slowly when using this method.

Force the font list to get updated.

Run a menu item given the menu ID.
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Method Parameter type Returns What it does (Continued)
showColorPicker boolean Returns false if dialog is cancelled,

0

true otherwise.

stringIDToTypeID number Converts from a string ID to a runtime
(stringID) string ID.

togglePalettes Toggle palette visibility.
0

typeIDToCharID string Converts from a runtime ID to a
(typeID) number character ID.

typeIDToStringID string Converts from a runtime ID to a string
(typeID) number ID.

Application.jsx

This script invokes an alert box to display Properties important to an application such as version number,
the path to the application, the amount of memory available, and the number of documents open.

When a user presses the OK button on the alert box, a second dialog opens, which asks users whether they
would like the foreground and background colors set for the document presently open. If no document is
open, the script opens a new document for the user.

The script (with no document open) produces a progression of three dialogs.

//Create a Welcome message

// Use the name and version properties of the application object to
// Append the application’s name and version to the Welcome message
// use "\r" to insert a carriage return

// use the combination operator += to append info to the message
var message = "Welcome to " + app.name

message += " version " + app.version + "\r\r"

// f£ind out where Adobe Photoshop CC is installed

// and add the path to the message

// add the optional parameter fsName to the path property
// to display the file system name in the most common format
message += "I’'m installed in " + app.path.fsName + "\r\r"

// see how much memory Adobe Photoshop CC has to play with
message += "You have this much memory available for Adobe Photoshop CC: " +
app.freeMemory + "\r\r"

// use the length property of the documents object to

// see how many documents are open

var documentsOpen = app.documents.length

message += "You currently have " + documentsOpen + " document (s) open.\r\r"

// display the message to the user
alert (message)

// answer will be true for a "Yes" answer and false for a "No" answer
var answer = confirm("Set the foreground and background to my favorite colors?")
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// set the colors

if (answer)
// I don’t have a favorite color. Why did I ask you may wonder?
app.foregroundColor.rgb.red = Math.random() * 255
app.foregroundColor.rgb.green = Math.random() * 255
app.foregroundColor.rgb.blue = Math.random() * 255
app.backgroundColor.rgb.red = Math.random() * 255
app.backgroundColor.rgb.green = Math.random() * 255
app.backgroundColor.rgb.blue = Math.random() * 255

// Open a document
if (app.documents.length == 0)

// use the application’s path and the offset to the samples folder
var sampleDocToOpen = File(app.path + "/Samples/Fish.psd")

// compose a message with the name of the file

message = "Would you like me to open a sample for you? ("
message += sampleDocToOpen. fsName

message += ")"

// ask the user another question
answer = confirm(message)

// open the document accordingly
if (answer)
open (sampleDocToOpen)

}

PDFPresentation.jsx
This script presents a progression of images as an Adobe PDF slide show.

// use all the files in the Samples folder
var inputFolder = new Folder (app.path + "/Samples/")

// see if we have something interesting
if (inputFolder != null) {

// get all the files found in this folder that are Adobe Photoshop CC (.psd
format)
var inputFiles = inputFolder.getFiles ("*.psd")

// output to the desktop
var outputFile = File("~/Desktop/JavaScriptPresentation.pdf")

// there are defaults but I like to set the options myself
var options = new PresentationOptions
options.presentation = true

options.view = true

options.autoAdvance = true

options.interval = 5

options.loop = true

options.transition = TransitionType.RANDOM

// create the presentation
makePDFPresentation (inputFiles, outputFile, options)
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alert ("Presentation file saved to: " + outputFile.fsName)

}
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An object within a document that contains the visual elements of the image (equivalent to a layer in the
Adobe Photoshop CC application).

Access an art layer in a document through the Document.artLayers collection. You can access a layer by

name; for example:

var layerRef = app.activeDocument.artLayers.getByName ("my layer") ;
layerRef.allLocked = true;

Access the art layers in a layer set through the LayerSet.artLayers collection in the parent set.

Property Value type What it is
allLocked boolean Read-write. True to completely lock the contents and
settings of this layer.
blendMode BlendMode Read-write. The blending mode.
bounds array of Read-only. An array of coordinates that describes the
UnitValue .
—_— bounding rectangle of the layer.
boundsNoEffects array of Read-only. An array of coordinates that describes the
UnitValue . . .
——— bounding rectangle of the layer not including effects.
fillOpacity number [0.0..100] Read-write. The interior opacity of the layer, a
percentage value.
filterMaskDensity double Read-write. The density of the filter mask (between
0.0 and 250.0)
filterMaskFeather double Read-write. The feather of the filter mask (between 0.0
and 250.0)
grouped boolean Read-write. True if this layer is grouped with the layer
beneath it.
isBackgroundLayer boolean Read-write. True if this is the background layer of the
document. A document can have only one
background layer. If there is no background layer,
setting this to true causes this to become the
background layer.
kind LayerKind Read-write. Sets the type (such as 'text layer') for an

empty layer.

Valid only when the layer is empty and when
isBackgroundLayer iS false. See
isBackgroundLayer.

You can use the kind property to make a background
layer a normal layer; however, to make a layer a
background layer, you must set isBackgroundLayer
to true.
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Property Value type What it is (Continued)

layerMaskDensity double Read-write. The density of the layer mask (between
0.0 and 100.0)

layerMaskFeather double Read-write. The feather of the layer mask (between
0.0 and 250.0)

linkedLayers array of ArtLayer Read-only. The layers linked to this layer. See

or LayerSet ArtLayer.link.

name string Read-write. The name.

opacity number [0.0..100.0]. Read-write. The master opacity of the layer, a
percentage value.

parent Document Read-only. The object's container.

pixelsLocked boolean Read-write. True if the pixels in the layer’s image
cannot be edited using the paintbrush tool.

positionLocked boolean Read-write. True if the pixels in the layer’s image
cannot be moved within the layer.

textItem TextItem Read-only. The text item that is associated with the
layer.
Valid only when kind = LayerKind.TEXT.

transparentPixelsLocked boolean Read-write. True if editing is confined to the opaque
portions of the layer.

typename string Read-only. The class name of the referenced
artLayer object.

vectorMaskDensity double Read-write. The density of the vector mask (between
0.0 and 250.0)

vectorMaskFeather double Read-write. The feather of the vector mask (between
0.0 and 250.0)

visible boolean Read-write. True if the layer is visible.

xmpMetadata xmpMetadata Read-write. Metadata for the layer.
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Method

Parameter type Returns

What it does

adjustBrightnessContrast

(brightness,
contrast)

adjustColorBalance

( [shadows]
[, midtones]
highlights]

[,
[, preserveluminosity]

adjustCurves
(curveShape)

adjustLevels

(inputRangeStart,
inputRangeEnd,
inputRangeGamma,
outputRangeStart,
outputRangeEnd)

applyAddNoise

(amount,
distribution,
monochromatic)

applyAverage
O

applyBlur
O

applyBlurMore
0

applyClouds
0

applyCustomFilter
(characteristics,
scale,
offset)

number
number

array of number
array of number
array of number
boolean

array of array of number

number [0..253]

number [(start + 2)..255]
number [0.10..9.99]
number [0..253]

number [ (start+ 2)..255]

number [0.1..400]
NoiseDistribution
boolean

array of number
number
number

Adjusts the brightness in the
range [-100..100] and contrast
[-100..100].

Adjusts the color balance of the
layer’s component channels. For
shadows, midtones, and
highlights, the array must
include three values in the
range [-100..100], which
represent cyan or red, magenta
or green, and yellow or blue,
when the document mode is
CMYK or RGB.

See Document.mode.

Adjusts the tonal range of the
selected channel using up to
fourteen points.

Each value in the curveShape
array is a point pair, an array of
an x and y integer value.

Adjusts the levels of the
selected channels

Applies the Add Noise filter
amount is a percentage value.

Applies the Average filter.

Applies the Blur filter.

Applies the Blur More filter.

Applies the Cloud:s filter.

Applies a custom filter.

The characteristics array has
25 members.

See Adobe Photoshop CC Help
for specific instructions.
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Method Parameter type Returns What it does (Continued)
applyDeInterlace Applies the De-Interlace filter.
(eliminateFields, EllmlnaFeFlelds
createFields) CreateFields
applyDespeckle Applies the Despeckle filter.

0

applyDifferenceClouds
0

applyDiffuseGlow

(graininess,
glowAmount,
clearAmount)

applyDisplace
(horizontalScale,
verticalScale,
displacement,
undefinedareas,
displacementMapFiles)

applyDustAndScratches

(radius,
threshold)

applyGaussianBlur
(radius)

applyGlassEffect
(distortion,
smoothness,
scaling
[, invert]
[, texture]
[, textureFile])

applyHighPass
(radius)

number [0..10]
number [0..20]
number [0..20]

number [-999..999]
number [-999..999]
DisplacementMapType
UndefinedAreas

File

number [1..100]
number [0..255]

number [0.1..250.0]

number [0..20]
number [1..15]
number [50..200]

boolean
TextureType
File

number [0.1..250.0]

Applies the Difference Clouds
filter.

Applies the Diffuse Glow filter.

Applies the Displace filter using
the specified horizontal and
vertical scale, mapping type,
treatment of undistorted areas,
and path to the distortion
image map.

Applies the Dust & Scratches
filter.

Applies the Gaussian Blur filter
within the specified radius (in
pixels)

Applies the Glass filter.

scalingis a percentage value.

Applies the High Pass filter
within the specified radius.
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Method Parameter type Returns What it does (Continued)
applyLensBlur Applies the Lens Blur filter.
DepthMapSource
( [[SO};;:;::iDistance] nurber source: The source for the
[: invertDepthMap] boolean depth map (default:
[, shapel % DepthMapSource . NONE)
[, radius] numoer
[, bladeCurvature] number focalDistance : The blur focal
[, rotation] nuﬁer distance for the depth map
[, brightness] numoer .
; thjlféelshold] number (default: o).
[, amount] ;u@eg tributi invertDepthMask : True if the
[’ distribution] OlseDlstCriputlion de th ma .. t d (d f It'
: boolean p p is inverted (default:
) [, monochromatic] false).
shape: The shape of the iris
(default: Geometry . HEXAGON)
radius: The radius of the iris
(default: 15).
bladeCurvature: The blade
curvature of the iris (default: o).
rotation: The rotation of the
iris (default: o)
brightness: The brightness for
the specular highlights (default:
0).
threshold: The threshold for
the specular highlights (default:
0).
amount: The amount of noise
(default: o)
distribution: The distribution
value for the noise (default:
NoiseDistribution.UNIFORM).
monochromatic: True if the
noise is monochromatic
(default: false).
applyLensFlare Applies the Lens Flare filter with
(brightness, numbe]zu  tvalue) the specified brightness (0 - 300,
flareCenter, e as a percentage), the xand y
lensType) SEnSIYRe coordinates (unit value) of the
flare center, and the lens type.
applyMaximum Applies the Maximum filter
(radius) number [1..100] within the specified radius (in
pixels).
applyMedianNoise Applies the Median Noise filter
(radius) numper [1..100] within the specified radius (in

pixels).
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Method Parameter type Returns What it does (Continued)
applyMinimum Applies the Minimum filter
(radius) number [1..100] within the specified radius (in
pixels) (1 - 100).
applyMotionBlur Applies the Motion Blur filter.
(angle, number [-360..360]
radius) number [1..999]
applyNTSC Applies the NTSC colors filter.
0
applyOceanRipple Applies the Ocean Ripple filter.
(size, number [1..15]
magnitude) number [0..20]
applyOffset . Moves the layer the specified
(horizontal, %ﬁue amount horizontally and
. ni alue . .
Xﬁﬁiifi@mag) Of FootUndef inedAreas vertically (mm/ma.x amouqts
depend on layer size), leaving
an undefined area at the layer’s
original location.
applyPinch Applies the Pinch filter.
(amount ) number [-100..100]

applyPolarCoordinates
(conversion)

applyRadialBlur

(amount,
blurMethod,
blurQuality)

applyRipple
(amount,
size)

applySharpen
0

applySharpenEdges
0

applySharpenMore
0

applyShear
(curve,
undefinedAreas)

PolarConversionType

number [1..100]
RadialBlurMethod
RadialBlurQuality

number [-999..999]
RippleSize

array of array of number
UndefinedAreas

amount is a percentage value.

Applies the Polar Coordinates
filter.

Applies the Radial Blur filter in
the specified amount, using
either a spin or zoom effect and
the specified quality.

Applies the Ripple filter in the
specified amount, throughout
the image and in the specified
size.

Applies the Sharpen filter.

Applies the Sharpen Edges filter.

Applies the Sharpen More filter.

Applies the Shear filter. The
curve defines a curve with
[2..255] points.

Each value in the curvearray is a
point pair, an array of an xand y
integer value.
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Method Parameter type Returns What it does (Continued)
applySmartBlur Applies the Smart Blur filter.
(radius, number [0.1..100.0]
threshold number [0.1..100.0]
blurQualitI:y SmartBlurQuality
node) ! SmartBlurMode
applySpherize Applies the Spherize filter.
(amount number [-100..100] .
mode) ! Spherl zeMode amount IS a percentage Value
applyStyle Applies the specified style to the
(styleName) string layer. You must use a style from
the Styles list in the Layer Styles
Palette.
applyTextureFill Applies the Texture Fill filter.
(textureFile) File
applyTwirl Applies the Twirl filter.
(angle) number [-999..999]
applyUnSharpMask Applies the Unsharp Mask filter.
(amount, number [1..500] (amount is a percentage value.
radius, number [0.1..250.0]
threshold) number [0..255]
applyWave Applies the Wave filter.
(generatorNumber, e Soa) Scale factors are percentage
minimumWavelength, number [1. '99,8] P g
maximumiavelength. number [2..min+1] values.
minimumAmplitude, number [1. ‘998,]
maximumAmplitude, number [2..min+l]
horizontalScale, number [1..100]
verticalScale, numper [1..100]
waveType, WaveTx' pe
undefinedAreas, UndefinedAreas
randomSeed) number
applyZzigZag Applies the Zigzag filter.
(amount, number [-100..100]
ridges number [0..20]
style) ! ZigZagType
autoContrast Adjusts the contrast of the
0 selected channels automatically.
autoLevels Adjusts the levels of the
0 selected channels using the
auto levels option.
clear Cuts the layer without moving it

to the clipboard.
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Method Parameter type

Returns

What it does (Continued)

copy

([merge] ) boolean

cut
()

desaturate
()

duplicate

([relativeObject] ArtLayer or LayerSet

[, insertionLocation]) ElementPlacement

equalize
0

invert
()

link
(with) ArtLayer or LayerSet

merge

ArtLayer
or

LayerSet

ArtLayer

Copies the layer to the
clipboard. When the optional
argument is set to true, a
merged copy is performed (that
is, all visible layers are copied to
the clipboard).

Cuts the layer to the clipboard.

Converts a color image to a
grayscale image in the current
color mode by assigning equal
values of each component color
to each pixel.

Creates a duplicate of the object
on the screen.

Redistributes the brightness
values of pixels in an image to
more evenly represent the
entire range of brightness levels
within the image.

Inverts the colors in the layer by
converting the brightness value
of each pixel in the channels to
the inverse value on the
256-step color-values scale.

Links the layer with the
specified layer.

Merges the layer down,
removing the layer from the
document; returns a reference
to the art layer that this layer is
merged into.
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Method

Parameter type

Returns

What it does (Continued)

mixChannels

(outputChannels
[, monochrome])

move
(relativeObject,

insertionLocation)

photoFilter

([fillColor]
[, density]

[, preservelLuminosityl])

posterize
(levels)

rasterize
(target)

remove

array of array of number
boolean

ArtLayer or LayerSet
ElementPlacement

SolidColor
number [1..100]
boolean

number [2..225]

RasterizeType

Modifies a targeted (output)
color channel using a mix of the
existing color channels in the
image.

The outputChannels
parameter is an array of channel
specifications. For each
component channel, specify a
list of adjustment values in the
range [-200..200] followed by a
'constant’ value [-200..200].)

When monochrome = true, the
maximum number of channel
value specifications is 1.

Valid only when docRef .mode =
DocumentMode .RGB Of CMYK.

RGB arrays must include four
values. CMYK arrays must
include five values.

Moves the layer relative to the
object specified in parameters.

For art layers, only the constant
values ElementPlacement.
PLACEBEFORE and PLACEAFTER
are valid.

For layer sets, only the constant
values ElementPlacement .
PLACEBEFORE and INSIDE are
valid.

Adjust the layer’s color balance
and temperature as if a color
filter had been applied.

density is a percentage value.

Specifies the number of tonal
levels for each channel and then
maps pixels to the closest
matching level.

Converts the targeted contents
in the layer into a flat, raster
image.

Deletes the object.
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Method Parameter type Returns What it does (Continued)
resize Resizes the layer to the specified
([horizontall number dimensions (as a percentage of
[, vertical] gﬁiiiposition its current size) and places it in
[, anchor]) the specified position.
rotate Rotates rotates the layer around
(angle number the specified anchor point
[, anchor]) AnchorPosition (default: MIDDLECENTER).
selectiveColor Modifies the amount of a
(selectionMethod AdjustmentReference process color in a specified
[, reds] Zgg gg Eﬁﬁg primary color without affecting
E ;iiig‘g?] array of number the other primary colors.

[, cyans] array of number
[' plues] array of number
! array of number

[, magentas]

[, whites] array of number

[, neutrals] array of number

[, blacks]) array of number
shadowHighlight

( [shadowAmount] number [0..100]

[, shadowWidth] number [0.100]

[, shadowRadius] nu$§er [0..2500]

[, highlightAmount] number [0..100]

[, highlightWidth] number [0..100]

[, highlightRadius] nuﬁer [0..2500]

[, colorCorrection] number [-100..100]

[, midtoneContrast] number [-100..100]

[, blackClipl] number [0.000..50.000]

[’ whiteClip]) number [0.000..50.000]
threshold

(level) number [1..255]
translate

([deltax] Unitvalue

[, deltaYl) Unitvalue
unlink

0

Each color array must have four
values.

Adjusts the range of tones in the
image’s shadows and highlights.

Amounts and widths are
percentage values. Radius
values are in pixels.

Converts grayscale or color
images to high-contrast, B/W
images by converting pixels
lighter than the specified
threshold to white and pixels
darker than the threshold to
black.

Moves the layer the specified
amount (in the given unit)
relative to its current position.

Unlinks the layer.

The following script opens all the files in the samples folder, creating one multi-layered document. Each
layer is pasted into one of four quadrants and given 50% transparency. Finally the layers are sorted by

name.

ArtLayer.jsx
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// Save the current preferences

var startRulerUnits = app.preferences.rulerUnits
var startTypeUnits = app.preferences.typeUnits
var startDisplayDialogs = app.displayDialogs

// Set Adobe Photoshop CC to use pixels and display no dialogs
app.preferences.rulerUnits = Units.PIXELS
app.preferences.typelUnits = TypeUnits.PIXELS
app.displayDialogs = DialogModes.NO

//Close all the open documents
while (app.documents.length)
app.activeDocument.close ()

}

// Create a new document to merge all the samples into
var mergedDoc = app.documents.add (1000, 1000, 72, "Merged Samples",
NewDocumentMode .RGB, DocumentFill.TRANSPARENT, 1)

// Use the path to the application and append the samples folder
var samplesFolder = Folder (app.path + "/Samples/")

//Get all the files in the folder
var fileList = samplesFolder.getFiles()

// open each file
for (var i = 0; i < fileList.length; i++) {
// The fileList is folders and files so open only files
if (fileList[i] instanceof File) (
open(fileList [i])

// use the document name for the layer name in the merged document
var docName = app.activeDocument .name

// flatten the document so we get everything and then copy
app.activeDocument.flatten ()
app.activeDocument.selection.selectAll ()
app.activeDocument.selection.copy ()

// don’t save anything we did
app.activeDocument.close (SaveOptions.DONOTSAVECHANGES)

// make a random selection on the document to paste into
// by dividing the document up in 4 quadrants and pasting
// into one of them by selecting that area
var topLeftH = Math.floor (Math.random() * 2)
var topLeftV = Math.floor (Math.random() * 2)
var docH = app.activeDocument.width.value / 2
var docV = app.activeDocument.height.value / 2
var selRegion = Array (Array (topLeftH * docH, topLeftV * docV),
Array (topLeftH * docH + docH, topLeftV * docV),
Array (topLeftH * docH + docH, topLeftV * docV + docV),
*
*

Array (topLeftH * docH, topLeftV * docV + docV),

Array (topLeftH * docH, topLeftV * docV))
app.activeDocument.selection.select (selRegion)
app.activeDocument .paste ()

// change the layer name and opacity
app.activeDocument.activelLayer.name = docName
app.activeDocument.activelLayer.fillOpacity = 50
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}

// sort the layers by name

for (var x = 0; x < app.activeDocument.layers.length; x++) {

for (var y = 0; y < app.activeDocument.layers.length - 1 - x; y++) {
// Compare in a non-case sensitive way

var docl
var doc2
if (docl.

}

app.activeDocument.layers [y] .name
app.activeDocument.layers[y + 1] .name

toUpperCase () > doc2.toUpperCase()) ({
app.activeDocument. layers[y] .move (app.activeDocument.layers [y+1],
ElementPlacement . PLACEAFTER)

// Reset the application preferences
app.preferences.rulerUnits = startRulerUnits
app.preferences.typeUnits = startTypeUnits

app.displayDialogs

startDisplayDialogs
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The collection of ArtLayer objects in a document or layer set.

Access through the Document.artLayers or LayerSet.artLayers collection. For example:

var layerRef

docRef .artLayers.add ()

Property Value type Whatitis
length number Read-only. The number of elements in the artLayers
collection.
parent Document Read-only. The object's container.
typename string Read-only. The class name of the referenced
artLayers object.
Method Parameter type Returns What it does
add ArtLayer Creates a new art layer in the
0 document and adds the new object to
this collection.
getByName ArtLayer Get thefirst elementin the artLayers
(name) string collection with the provided name.
removeAll Removes all elements from the

0

artLayers collection.
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Options for running a batch operation using the Application.batch() method.

JavaScript only supports folders as sources for batch commands. Specify the batch source folder as the
inputFiles parameter of the Application.batch() method.

Property

Value type

What it is

destination

destinationFolder

errorFile

fileNaming

macintoshCompatible

overrideOpen

overrideSave

startingSerial

suppressOpen

BatchDestinationType

Folder

File

array of
FileNamingType

boolean

boolean

boolean

number

boolean

Read-write. The type of destination for the
processed files (default:
BatchDestinationType .NODESTINATION).

Read-write. The folder location for the processed
files.

Valid only when destination =
BatchDestinationType.FOLDER

Read-write. The file in which to log errors
encountered.

To display errors on the screen (and stop batch
processing when errors occur) leave blank.

Read-write. A list of file naming options
(maximum: 6).

Valid only when destination =
BatchDestinationType.FOLDER

Read-write. True to make the final file names
Macintosh compatible (default: true).

Valid only when destination =
BatchDestinationType.FOLDER

Read-write. True to override action open
commands (default: false).

Read-write. True to override save as action steps
with the specified destination (default: false).

Valid only when destination =
BatchDestinationType.FOLDER Of
SAVEANDCLOSE

Read-write. The starting serial number to use in
naming files (default: 1).

Valid only when destination =
BatchDestinationType.FOLDER

Read-write. True to suppress the file open options
dialogs (default: false).
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Property Value type What it is (Continued)

suppressProfile boolean Read-write. True to suppress the color profile
warnings (default: false).

typename string Read-only. The class name of the referenced
batchOptions object.

unixCompatible boolean Read-write. True to make the final file name Unix
compatible (default: true).
Valid only when destination =
BatchDestinationType.FOLDER

windowsCompatible boolean Read-write. True to make the final file names

Windows compatible (default: true).

Valid only when destination =
BatchDestinationType.FOLDER.
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Options for converting an image to bitmap mode, using Document.changeMode() with

ChangeMode .Bitmap.

Convert color images to grayscale before converting the image to bitmap mode. See the
ArtLayer.desaturate() method.

Property

Value type

What it is

angle

frequency

method

patternName

resolution

shape

typename

number [-180..180]

number [1.0..999.99]

BitmapConversionType

string

number

BitmapHalfToneType

string

Read-write. The angle (in degrees) at which to
orient individual dots. See shape.

Valid only when method -
BitmapConversionType . HALFTONESCREEN.

Read-write. The number of printer dots (per inch) to
use.

Valid only when method =
BitmapConversionType.HALFTONESCREEN.

Read-write. The conversion method to use (default:
BitmapConversionType .DIFFUSIONDITHER).

Read-write. The name of the pattern to use.

For information about pre-installed valid patterns,
see Adobe Photoshop CC Help on the bitmap
conversion command, or view the options availabe
in the Custom Color drop down box after choosing
the bitmap conversion command.

Valid only when method -
BitmapConversionType . CUSTOMPATTERN.

Read-write. The output resolution in pixels per inch
(default: 72. 0).

Read-write. The dot shape to use.

Valid only when method =
BitmapConversionType . HALFTONESCREEN.

Read-only. The class name of the referenced
bitmapConversionOptions object.
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Options for saving a document in BMP format using the Document.saveAs() method.

Property Value type What it is
alphaChannels boolean Read-write. True to save the alpha channels.
depth BMPDepthType Read-write. The number of bits per channel.
flipRowOrder boolean Read-write. True to write the image from top
to bottom (default: false).
Available only when osType =
OperatingSystem.WINDOWS.
osType OperatingSystem Read-write. The target OS.
(default: operat ingSystem. WINDOWS).
rleCompression boolean Read-write. True to use RLE compression.
Available only when osType =
OperatingSystem.WINDOWS.
typename string Read-only. The class name of the referenced

BMPSaveOptions object.
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Options for opening a document in Camera RAW format using the Application.open() method.

Property Value type What it is

bitsPerChannel BitsPerChannelType Read-write. The number of bits per channel.
blueHue number [-100..100] Read-write. The blue hue of the shot.
blueSaturation number [-100..100] Read-write. The blue saturation of the shot.
brightness number [0..150] Read-write. The brightness of the shot.

chromaticAberrationBY

chromaticAberrationRC

colorNoiseReduction

colorSpace
contrast
exposure
greenHue
greenSaturation

luminanceSmoothing

redHue
redSaturation

resolution

saturation

settings

shadows
shadowTint
sharpness
size

temperature

number [-100..100]

number [-100..100]

number [0..100]

ColorSpaceType

number [-50..100]

number [-4.0..4.0]

number [-100..100]

number [-100..100]

number [0..100]

number [-100..100]

number [-100..100]

number [1..999]

number [-100..100]

CameraRAWSettingsType

number [0..100]
number [-100..100]
number [0..100]
CameraRAWSize

number [2000..50000]

Read-write. The chromatic aberration B/Y of the
shot.

Read-write. The chromatic aberration R/C of the
shot

Read-write. The color noise reduction of the
shot.

Read-write. The colorspace for the image.
Read-write. The contrast of the shot.
Read-write. The exposure of the shot.
Read-write. The green hue of the shot.
Read-write. The green saturation of the shot.

Read-write. The luminance smoothing of the
shot.

Read-write. The red hue of the shot.
Read-write. The red saturation of the shot.

Read-write. The resolution of the document in
pixels per inch.

Read-write. The saturation of the shot.

Read-write. The global settings for all Camera
RAW options. Default:
CameraRAWSettingsType.CAMERA.

Read-write. The shadows of the shot.
Read-write. The shadow tint of the shot.
Read-write. The sharpness of the shot.
Read-write. The size of the new document.

Read-write. The temperature of the shot.
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Property Value type What it is (Continued)

tint number [-150..150] Read-write. The tint of the shot.

typename string Read-only. The class name of the referenced
cameraRAWOpenOptions object.

vignettingAmount number [-100..100] Read-write. The vignetting amount of the shot.

vignettingMidpoint number [-100..100] Read-write. The vignetting mid point of the
shot.

whiteBalance WhiteBalanceType Read-write. The white balance options for the

image. These are lighting conditions that affect
color balance.
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Information about a color element in the image.

Access through the Document.channels collection. You can access an individual channel object in this list
by index or by name. For example, this accesses a channel object in the active document by name and
assigns an opacity value:

var channelRef = app.activeDocument.channels.getByName ("my channel") ;
channelRef .opacity = 22;

A channel is analogous to a plate in the printing process that applies a single color. The document’s color
mode determines the number of default channels; for example, an RGB document has three channels, red,

green, and blue. A color can also have an alpha channel, which stores selections as masks, or a spot
channel, which stores spot colors.

Property Value type What itis

color SolidColor Read-write. The color of the channel.
Not valid when kind = ChannelType.COMPONENT.

histogram array of number Read-only. A histogram of the color of the channel. The
array contains 256 members.
Not valid when kind = ChannelType.COMPONENT. For
component channel histogram values, use the histogram
property of the Document object instead.

kind ChannelType Read-write. The type of the channel.

name string Read-write. The name of the channel.

opacity number [0..100] Read-write. The opacity to use for alpha channels or the
solidity to use for spot channels.
Valid only when kind = ChannelType.MASKEDAREA Of
SELECTEDAREA.

parent Document Read-only. The containing document.

typename string Read-only. The class name of the referenced channel
object.

visible boolean Read-write. True if the channel is visible.

Method Parameter type Returns What it does

duplicate Channel Duplicates the channel.

Document

( [targetDocument] )
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Method

Parameter type

Returns

What it does

merge

Merges a spot channel into the
component channels.

Deletes the channel.
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The collection of Channel objects in a document.

Access through the Document.channels collection property. For example:

var channelRef = app.activeDocument.channels.add ()

Property Value type What itis
length number Read-only. The number of elements in the channels
collection.
parent Document Read-only. The containing document.
typename string Read-only. The class name of the referenced channels
object.
Method Parameter type Returns What it does
add Channel Creates a new channel object and
0 adds it to this collection.
getByName Channel Get the first element in the channels
(name) string collection with the provided name.
removeAll Removes all alpha channel objects

0 from the channels collection.

The following script opens a file if one is not already open, and then writes a histogram report
(histogram.log) for the channels in the active document.

Note: This script contains a switch construction that uses a break statement. The break statement
requires an ending semicolon (;), as in the following sample:

break;
Histogram.jsx
// Function to activate all the channels according to the documents mode
// Takes a document reference for input

function TurnOnDocumentHistogramChannels (inDocument) {

// see how many channels we need to activate
var visibleChannelCount = 0

// based on the mode of the document
switch (inDocument.mode) {

case DocumentMode.BITMAP:
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case DocumentMode.GRAYSCALE:

case DocumentMode . INDEXEDCOLOR :
visibleChannelCount = 1
break;

case DocumentMode .DUOTONE :
vigsibleChannelCount = 2
break;

case DocumentMode.RGB:
case DocumentMode.LAB:

visibleChannelCount = 3
break;

case DocumentMode.CMYK:
vigsibleChannelCount = 4

break;

case DocumentMode .MULTICHANNEL:

default:
visibleChannelCount = inDocument.channels.length + 1
break;

// now get the channels to activate into a local array
var aChannelArray = new Array ()

// index for the active channels array
var aChannelIndex = 0

for (var channelIndex = 0; channelIndex < inDocument.channels.length;
channelIndex++) {
if (channelIndex < visibleChannelCount) {
aChannelArray[aChannelIndex++] = inDocument.channels [channelIndex]

// now activate them
inDocument .activeChannels = aChannelArray

// Save the current preferences

var startRulerUnits = app.preferences.rulerUnits
var startTypeUnits = app.preferences.typeUnits
var startDisplayDialogs = app.displayDialogs

// Set Adobe Photoshop CC to use pixels and display no dialogs
app.preferences.rulerUnits = Units.PIXELS
app.preferences.typelUnits = TypeUnits.PIXELS
app.displayDialogs = DialogModes.NO

// 1f there are no documents open then try to open a sample file
if (app.documents.length == 0) {

open (File (app.path + "/Samples/Fish.psd"))
}

// get a reference to the working document
var docRef = app.activeDocument
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// create the output file
// first figure out which kind of line feeds we need

if ($.os.search(/windows/i) != -1) {
fileLineFeed = "Windows"

} else {
fileLineFeed = "Macintosh"

}

// create the output file accordingly

fileOut = new File("~/Desktop/Histogram.log")
fileOut.lineFeed = fileLineFeed

fileOut.open ("w", "TEXT", "??2?2°?")

// write out a header
fileOut.write ("Histogram report for " + docRef.name)

// find out how many pixels I have
var totalCount = docRef.width.value * docRef.height.value

// more info to the out file
fileOut.write (" with a total pixel count of " + totalCount + "\n")

// channel indexer
var channelIndex = 0

// remember which channels are currently active
var myActiveChannels = app.activeDocument.activeChannels

// document histogram only works in these modes
if (docRef.mode == DocumentMode.RGB | |
docRef .mode == DocumentMode.INDEXEDCOLOR | |
docRef .mode == DocumentMode.CMYK) {

// activate the main channels so we can get the documents histogram
TurnOnDocumentHistogramChannels (docRef)

// Output the documents histogram
OutputHistogram(docRef.histogram, "Luminosity", fileOut)

}

// local reference to work from
var myChannels = docRef.channels

// loop through each channel and output the histogram
for (var channelIndex = 0; channelIndex < myChannels.length; channellIndex++) {

// the channel has to be visible to get a histogram
myChannels [channelIndex] .visible= true

// turn off all the other channels
for (var secondaryIndex = 0; secondaryIndex < myChannels.length;
secondaryIndex++) {
if (channellIndex != secondarylIndex) ({
myChannels [secondaryIndex] .visible= false

}

// Use the function to dump the histogram
OutputHistogram (myChannels [channelIndex] .histogram,
myChannels [channelIndex] .name, fileOut)
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}

// close down the output file
fileOut.close()
alert ("Histogram file saved to: " + fileOut.fsName)

// reset the active channels
docRef .activeChannels = myActiveChannels

// Reset the application preferences
app.preferences.rulerUnits = startRulerUnits
app.preferences.typeUnits = startTypeUnits
app.displayDialogs = startDisplayDialogs

// Utility function that takes a histogram and name
// and dumps to the output file
function OutputHistogram(inHistogram, inHistogramName, inOutFile) ({

// find ouch which count has the largest number
// I scale everything to this number for the output
var largestCount = 0

// a simple indexer I can reuse
var histogramIndex = 0

// see how many samples we have total
var histogramCount = 0

// search through all and find the largest single item
for (histogramIndex = 0; histogramIndex < inHistogram.length;
histogramIndex++) {
histogramCount += inHistogram[histogramIndex]
if (inHistogram[histogramIndex] > largestCount)
largestCount = inHistogram|[histogramIndex]

}

// These should match
if (histogramCount != totalCount) ({

alert ("Something bad is happening!")
}

// see how much each "X" is going to count as
var pixelsPerX = largestCount / 100

// output this data to the file
inOutFile.write("One X = " + pixelsPerX + " pixels.\n")

// output the name of this histogram
inOutFile.write (inHistogramName + "\n")

// loop through all the items and output in the following format

// 001

// 002

for (histogramIndex = 0; histogramIndex < inHistogram.length;
histogramIndex++) {

// I need an extra "O" for this line item to keep everything in line
if (histogramIndex < 10)
inOutFile.write ("0")
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// I need an extra "0" for this line item to keep everything in line
if (histogramIndex < 100)
inOutFile.write("0")

// output the index to file
inOutFile.write (histogramIndex)

// some spacing to make it look nice
inOutFile.write(" ")

// figure out how many X’'s I need
var outputX = inHistograml[histogramIndex] / largestCount * 100

// output the X's
for (var a = 0; a < outputX; a++)

inOutFile.write ("X")

inOutFile.write ("\n")

}

inOutFile.write ("\n")
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Defines a CMYK color, used in the SolidColor object.

See also GrayColor, HSBColor, LabColor, NoColor, RGBColor

Property Value type What it is

black number [0.0..100.00] | Read-write. The black color value (as percent).

cyan number [0.0..100.00]  Read-write. The cyan color value (as percent).

magenta number [0.0..100.00]1 Read-write. The magenta color value (as percent).

typename string Read-only. The class name of the referenced cmykcolor
object.

yellow number [0.0..100.00] Read-write. The yellow color value (as percent).
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A color sampler for a document. Access through the Document.colorSamplers collection. For example:

var colorSamplerRef = app.activeDocument.colorSamplers[0];
var currentColor = colorSamplerRef.color;

Note: For additional information about color samplers, see Adobe Photoshop CC help on the Color

SamplerTool.
Property Value type What it is
color SolidColor Read-only. The color of the color sampler.
position array Olf Read-only. The position of the color sampler in the
UnitValue document. The array (x,y) represents the horizontal and
vertical location of the count item.
parent Document Read-only. The containing document.
typename string Read-only. The class name of the referenced colorsampler
object.
Method Parameter type Returns What it does
move Moves the color sampler to a new location
. array of i
(position) Y e in the document.

The position parameter (x,y) represents
the new horizontal and vertical locations
of the moved color sampler.

remove Deletes the colorsampler object.
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The collection of ColorSampler objects in a document. Access through the Document.colorSamplers
collection property. For example:

app.activeDocument .colorSamplers.removeAll ()

Property Value type What it is

length number Read-only. The number of elements in the
Colorsamplers collection.

parent Document Read-only. The containing document.

typename string Read-only. The class name of the referenced
ColorSamplers object.

Method Parameter type Returns What it does
add ColorSampler | Createsa new color sampler object
(position) array of UnitValue and adds it to this collection.

The position parameter (x,y)
represents the new horizontal and
vertical locations of the moved color
sampler.

removeAll Removes all colorsampler objects
0 from the colorsamplers collection.
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Options for creating a contact sheet with the Application.makeContactSheet() method.

Property Value type Whatiitis

acrossFirst boolean Read-write. True to place the images horizontally
(left to right, then top to bottom) first (default: true).

bestFit boolean Read-write. True to rotate images for the best fit
(default: false).

caption boolean Read-write. True to use the filename as a caption for
the image (default: true).

columnCount number [1..100] Read-write. The number of columns to include
(default: 5).

flatten boolean Read-write. True to flatten all layers in the final
document (default: true).

font GalleryFontType Read-write. The font used for the caption (default:
GalleryFontType.ARIAL).

fontSize number Read-write. The font size to use for the caption
(default: 12).

height number [0..29000] Read-write. The height (in pixels) of the resulting
document (default: 720).

horizontal number Read-write. The horizontal spacing (in pixels)
between images (default: 1).

mode NewDocumentMode Read-write. The document color mode (default:
NewDocumentMode . RGB).

resolution number [35..1200] Read-write. The resolution of the document in pixels
per inch (default: 72. 0).

rowCount number [1..100] Read-write. The number of rows to use (default: 6).

typename string Read-only. The class name of the referenced
contactSheetOptions object.

useAutoSpacing boolean Read-write. True to auto space the images (default:
true).

vertical number [0..29000] Read-write. The vertical spacing (in pixels) between
images (default: 1).
Valid only when useAutoSpacing = false.

width number [100..29000] Read-write. The width (in pixels) of the resulting

document (default: 576).
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A counted item in a document. Access through the Document.countltems collection. See the
Document.autoCount() method.

Note: This feature is available in the Extended Version only.

For additional information about count items, see Adobe Photoshop CC help on the Count Tool.

Property Value type What it is

position array of Read-only. The position of the count item in the document.
UnitValue

parent Document Read-only. The containing document.

typename string Read-only. The class name of the referenced countItem

object.
Method Parameter type Returns What it does
remove

0

Deletes the count Item object.
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The collection of Countltem objects in the document.

Access through the Document.countltems collection property. For example:

app.activeDocument.countItems.removeAll ()

Note: This feature is available in the Extended Version only.

Property Value type What it is
length number Read-only. The number of elements in the countItems
collection.
parent Document Read-only. The containing document.
typename string Read-only. The class name of the referenced count Items
object.
Method Parameter type Returns What it does
add CountItem Creates a new count item object and
(position) array of UnitValue adds it to this collection.
Parameter position (x,y) represents
the horizontal and vertical positions,
respectively, of the count Item object.
getByName CountItem Get the first element in the
(name) string CountItems collection with the
provided name.
removeAll Removes all countItem objects from

0

the countItems collection.
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Options for saving a CMYK document in DCS1 format using the Document.saveAs() method.

Property Value type What it is

dcs DCSType Read-write. (default: bcSType . COLORCOMPOSITE).

embedColorProfile boolean Read-write. True to embed the color profile in the
document

encoding SaveEncoding  Read-write. The type of encoding to use for document
(default: saveEncoding . BINARY).

halftoneScreen boolean Read-write. True to include halftone screen (default:
false).

interpolation boolean Read-write. True to use image interpolation (default:
false)

preview Preview Read-write. The type of preview (default:

Preview.MACOSEIGHTBIT).

transferFunction boolean Read-write. True to include the Transfer functions to
compensate for dot gain between the image and film
(default: false).

typename string Read-only. The class name of the referenced
DCS1_SaveOptions object.

vectorData boolean Read-write. True to include vector data.

Valid only if the document includes vector data
(unrasterized text).
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Options for saving a CMYK document in DCS2 format using the Document.saveAs() method.

Property Value type What it is

dcs DCSType Read-write. The type of composite file to create
(default: DcSType . NOCOMPOSITE).

embedColorProfile boolean Read-write. True to embed the color profile in the
document.

encoding SaveEncoding Read-write. The type of encoding to use (default:
SaveEncoding.BINARY).

halftoneScreen boolean Read-write. True to include the halftone screen
(default: false).

interpolation boolean Read-write. True to use image interpolation (default:
false).

multiFileDCS boolean Read-write. True to save color channels as multiple
files or a single file (default: false).

preview Preview Read-write. The preview type (default:
Preview.MACOSEIGHTBIT).

spotColors boolean Read-write. True to save spot colors.

transferFunction boolean Read-write. True to include the Transfer functions to
compensate for dot gain between the image and film
(default: £alse).

typename string Read-only. The class name of the referenced
DCS2_SaveOptions object.

vectorData boolean Read-write. True to include vector data.

Valid only if the document includes vector data
(unrasterized text).
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Options for opening a document in DICOM format using the Application.open() method.

Note: This feature is available in the Extended Version only.

Property Value type What it is

anonymize boolean Read-write. True to make the patient
information anonymous.

columns number Read-write. Number of columns in n-up
configuration.

reverse boolean Read-write. True to reverse (invert) the image.

rows number Read-write. The number of rows in n-up
configuration.

showOverlays boolean Read-write. True to show overlays.

typename string Read-only. The class name of the referenced
DICOMOpenOptions object.

windowLevel number Read-write. The contrast of the image in
Houndsfield units.

windowWidth number Read-write. The brightness of the image in
Houndsfield units.
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The active containment object for layers and all other objects in the script; the basic canvas for the file.

e Access the object for the currently active document through Application.activeDocument.

e You can access other documents, or iterate through all open documents using the list in the
Application.documents collection. You can access individual documents in the list by index, or use
Documents.getByName() to retrieve them by name.

e Create documents programmatically using the Documents.add() method.

See Document sample script and the Documents collection object for examples.

Note: In Adobe Photoshop CC, a document can also be referred to as an image or a canvas.

e The term image refers to the entire document and its contents. You can trim or crop an image.
You resize an image using the resizeImage () method.

e The term canvas refers to the space in which the document sits on the screen. You can rotate or
flip the canvas. You resize the canvas using the resizecanvas () method.

Property

Value type

Whatitis

activeChannels

activeHistoryBrushSource

activeHistoryState

activeLayer

artLayers

backgroundLayer

bitsPerChannel
channels

colorProfileName

colorProfileType

colorSamplers

componentChannels

array of Channel

Guide

Guide

ArtLayer or
LayerSet

ArtLayers

ArtLayer

BitsPerChannelType

Channels

string

ColorProfileType

ColorSamplers

array of Channel

Read-write. The selected channels.

Read-write. The history state to use with the
history brush.

Read-write. The selected HistoryState object.

Read-write. The selected layer.

Read-only. The art layers collection.

Read-only. The background layer of the
document.

Read-write. The number of bits per channel.
Read-only. The channels collection.

Read-write. The name of the color profile.

Valid only when colorProfileType =
ColorProfile.CUSTOM Of WORKING.

Read-write. Whether the document uses the
working color profile, a custom profile, or no
profile.

Read-only. The current color samplers
associated with this document.

Read-only. The color channels that make up
the document; for instance, the Red, Green,
and Blue channels for an RGB document.
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Property Value type What it is (Continued)
countItems CountItems Read-only. The current count items.

Note: For additional information about count
items, see Adobe Photoshop CC help on
the Count Tool.

fullName File Read-only. The full path name of the
document.

guides Guides Read-only. The guides collection.

height UnitValue Read-only. The height of the document (unit
value).

histogram array of number Read-only. A histogram showing the number
of pixels at each color intensity level for the

composite channel. The array ¢ ontains 256

members.

Valid only when mode = DocumentMode .RGB,

CMYK; Of INDEXEDCOLOR.

historyStates HistoryStates Read-only. The history states collection.

info DocumentInfo Read-only. Metadata about the document.

layerComps LayerComps Read-only. The layer compositions collection.

layers Layers Read-only. The layers collection.

layerSets LayerSets Read-only. The layer set collection.

managed boolean Read-only. True if the document a is workgroup
document.

measurementScale MeasurementScale Read-only. The measurement scale for the
document.

Note: The measurement scale feature is
available in the Extended version only.

mode DocumentMode Read-only. The color profile.
name string Read-only. The document's name.
parent Application Read-only. The application object that contains
this document.
path File Read-only. The path to the document.
pathItems PathItems Read-only. The path items collection.
pixelAspectRatio number Read-write. The (custom) pixel aspect ratio to
[0.100..10.000]
use.
printSettings DocumentPrintSettin Read-only. The print settings for the document.

gs
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Property Value type What it is (Continued)

quickMaskMode boolean Read-write. True if the document is in Quick
Mask mode.

resolution number Read-only. The document’s resolution (in pixels
per inch).

saved boolean Read-only. True if the document has been
saved since the last change.

selection Selection Read-only. The selected area of the document.

typename string Read-only. The class name of the Document
object.

width Unitvalue Read-only. The width of the document (unit
value).

xmpMetadata xmpMetadata Read-only. XMP metadata for the document.

Camera RAW settings for the image are stored
here for example.
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Method Parameter type Returns What it does
autoCount Counts the number of objects in a
(channel, Channel document. Available in the Extended
threshold) numbex Version only.
Creates a Countltem object for each
object counted.
For additional information about how to
set up objects to count, see the Count Tool
in the Adobe Photoshop CC Help
changeMode Changes the color profile of the
(destinationMode ChangeMode . . document.
[, options]) BitmapConversionOptions
I p or
IndexedConversionOptions
close Closes the document. If any changes have
([saving]) SaveOptions been made, the script presents an alert
with three options: save, do not save,
prompt to save. The optional parameter
specifies a selection in the alert box
(default: saveoptionsType.
PROMPTTOSAVECHANGES).
convertProfile Changes the color profile.
: : : string
(?iite:;zatlonProflle, Intent The destinationProfile parameter must
[, blackPointCompensation] Poolean be either a string that names the color
[, dither]) boolean mode or Working RGB, Working CMYK,
Working Gray, Lab Color (meaning one
of the working color spaces or Lab color).
crop Crops the document. The bounds
(bounds ar;;Y of ¢ UnitValue parameter is an array of four coordinates
[, angle] Eiitflilue for the region remaining after cropping,
%' ﬁ;‘j;ﬁ]t] ) UnitValue [left, top, right, bottom].
duplicate Document | Creates a duplicate of the document
([name ] string object.
[, mergelLayersOnly] boolean

)

The optional parameter name provides the
name for the duplicated document.

The optional parameter
mergeLayersOnly indicates whether to
only duplicate merged layers.
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Method Parameter type Returns |What it does (Continued)
exportDocument Exports the paths in the document to an
(exportIn glle - Illustrator file, or exports the document to
A Xpor ype . . . . .
E, (e)Xthzz;;g ExportOptionsTllustrator a fl|? vylth.Web or device viewing
r P —or— optimizations.
ExportOptionsSaveForWeb
This is equivalent to choosing File >
Export > Paths To lllustrator, or File >
Save For Web and Devices.
flatten Flattens all layers in the document.
0
flipCanvas Flips the image within the canvas in the
(direction) Direction specified direction.
importAnnotations Imports annotations into the document.
(file) File
mergeVisibleLayers Flattens all visible layers in the document.
0
paste ArtLayer Pastesthe contents of the clipboard into
([intoSelection]) boolean the document. If the optional argument is
set to true and a selection is active, the
contents are pasted into the selection.
print Prints the document.
SourceSpaceType .
( Esouijiigazi]e] string printSpace specifies the color space for
[: Li)ntentﬁj Intent the printer. Valid values are nothing (that
boolean

[blackPointCompensation] )

printOneCopy
0

rasterizeAllLayers
0

recordMeasurements

( [source]
[, dataPoints])

resizeCanvas
( [width]
[, height]
[, anchorl])

MeasurementSource
array of string

UnitValue
UnitValue
AnchorPosition

is, the same as the source); or working
RGB, Working CMYK, Working Gray, Lab
Color (meaning one of the working color
spaces or Lab color); or a string specifying
a specific colorspace (default is same as
source).

Print one copy of the document.

Rasterizes all layers.

Record measurements of document.

Changes the size of the canvas to display
more or less of the image but does not
change the image size. See resizelmage.
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Method Parameter type Returns |What it does (Continued)
resizeImage Changes the size of the image.
: UnitValue
( EWliZ}il;ht] UnitValue The amount parameter controls the
[ resolution] number amount of noise value when using
[, resampleMethod] ResampleMethod preserve details (Range: 0 - 100).
[, amount]) number
revealAll Expands the document to show clipped
0 sections.
rotateCanvas Rotates the canvas (including the image)
(angle) number in clockwise direction.
save Saves the document.
0
saveAs Saves the document in a specific format.
(saveln File oo ifv th . .
[, options] object (see description) Specify the save options appropriate to
[ asCopy] boolean the format by passing one of these
[, extensionType]) Extension objects:
BMPSaveOptions
DCS1 SaveOptions
DCS2 SaveOptions
EPSSaveOptions
GIFSaveOptions
JPEGSaveOptions
PDFSaveOptions
PhotoshopSaveOptions
PICTFileSaveOptions
PICTResourceSaveOptions
PixarSaveOptions
PNGSaveOptions
RawSaveOptions
SGIRGBSaveOptions
TargaSaveOptions
TiffSaveOptions
splitChannels array oft Splits the document channels into
0 Document separate images.
suspendHistory Provides a single entry in history states for
(historyString S’;r%ng the entire script provided by
javascriptstring) string javaScriptString. Allows a single undo
for all actions taken in the script.
The historyString parameter provides
the string to use for the history state.
The javaScriptString parameter
provides a string of JavaScript code to
excute while history is suspended.
trap Applies trapping to a CMYK document.
(Width) number

Valid only when docref.mode =
DocumentMode . CMYK.
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Method Parameter type Returns |What it does (Continued)
trim Trims the transparent area around the
([typel TrimType image on the specified sides of the canvas.
[, topl boolean
[ left] boolean Default is true for all Boolean parameters.
[, bottom] boolean
[, right]) boolean

The following script creates a document that contains two images (a sunflower and a duck) obtained from
the Adobe Photoshop CC Samples folder and employs the following steps:

e Determines which image is larger.

e Resizes the smaller image to match the larger image.

e Creates a merged document twice as high as either image in order to hold both images.
e Selects part of the document and pastes the sunflower into the selection.

e Inverts the selection and pastes the duck into the lower part of the document.

e Positions the sunflower over the duck.

Document.jsx

// Save the current preferences

var startRulerUnits = app.preferences.rulerUnits
var startTypeUnits = app.preferences.typeUnits
var startDisplayDialogs = app.displayDialogs

// Set Adobe Photoshop CC to use pixels and display no dialogs
app.preferences.rulerUnits = Units.PIXELS
app.preferences.typeUnits = TypeUnits.PIXELS
app.displayDialogs = DialogModes.NO

// first close all the open documents
while (app.documents.length)
app.activeDocument.close ()

}

// Open the sunflower and duck files from the samples folder
var flowerDoc = open(File (app.path + "/Samples/Sunflower.psd"))
var duckDoc = open(File (app.path + "/Samples/Ducky.tif"))

// Find out which document is larger
// Resize the smaller document the to the larger document’s size
// The resize requires the document be the active/front document
if ((flowerDoc.width.value * flowerDoc.height.value) >
(duckDoc.width.value * duckDoc.height.value)) ({
app.activeDocument = duckDoc
duckDoc.resize (flowerDoc.width, flowerDoc.height)
}
else {
app.activeDocument = flowerDoc
flowerDoc.resizeImage (duckDoc.width, duckDoc.height)

}

// Create a new document twice as high as two files
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var mergedDoc = app.documents.add (duckDoc.width, duckDoc.height * 2,
duckDoc.resolution, "FlowerOverDuck")

// Copy the flower to the top; make it the active document so we can manipulate it
app.activeDocument = flowerDoc
flowerDoc.activeLayer.copy ()

//Paste the flower to the merged document, making the merged document active
app.activeDocument = mergedDoc

// Select a square area at the top of the new document
var selRegion = Array (Array (0, 0),
Array (mergedDoc.width.value, 0),
Array (mergedDoc.width.value, mergedDoc.height.value / 2),
Array (0, mergedDoc.height.value / 2),
Array (0, 0))
// Create the selection
mergedDoc.selection.select (selRegion)

//Paste in the flower
mergedDoc .paste (TRUE)

// do the same thing for the duck
app.activeDocument = duckDoc
duckDoc.activeLayer.copy ()

app.activeDocument = mergedDoc
mergedDoc.selection.select (selRegion)

// Inverting the selection so the bottom of the document is now selected
mergedDoc.selection.invert ()

// Paste the duck
mergedDoc .paste (TRUE)

// get rid of our originals without modifying them
duckDoc.close (SaveOptions.DONOTSAVECHANGES)
flowerDoc.close (SaveOptions .DONOTSAVECHANGES)

// Reset the application preferences
app.preferences.rulerUnits = startRulerUnits
app.preferences.typeUnits = startTypeUnits
app.displayDialogs = startDisplayDialogs
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The print settings for a document.

Property Value type What it is

backgroundColor SolidColor Read-write. Background color of page.

bleedwWwidth Unitvalue Read-write. Bleed width

caption boolean Read-write. Print the caption found in Filelnfo.

centerCropMarks boolean Read-write. Print center crop marks.

colorBars boolean Read-write. Print color calibration bars.

copies number Read-write. Number of copies to print.

cornerCropMarks boolean Read-write. Print corner crop marks.

colorHandling PrintColorHandling |Read-only. Color handling.

activePrinter string Read-write. The currently active printer.

flip boolean Read-write. Flip the image horizontally.

hardProof boolean Read-write. Print a hard proof.

interpolate boolean Read-write.

labels boolean Read-write. Prints the document title.

mapBlack boolean Read-write. Map blacks.

negative boolean Read-write. Invert the image colors.

renderIntent Intent Read-write. Color conversion intent when print
space is different from the source space.

posX Unitvalue Read-only. The x position of the image on
page.

posY UnitvValue Read-only. The y position of the image on
page.

printBorder UnitValue Read-write. The width of the print border.

printerName string Read-write. Name of the printer.

printSpace string Read-write. color space for printer. Can be
nothing (meaning same as source); 'Working
RGB!, 'Working CMYK, 'Working Gray/, 'Lab
Color' (meaning one of the working spaces or
Lab color); or a string specifying a specific
colorspace (default is same as source)

registrationMarks boolean Read-write. Print registration marks.
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Property Value type What it is (Continued)
scale number Read-only. Scale of image on page.

vectorData boolean Read-write. Include vector data.




JavaScript Scripting Reference

Adobe Photoshop CC

JavaScript Object Reference 98

Method Parameter type Returns What it does
setPagePosition Set the position of the image on the page.
(docPosition DocPositionStyle
pOSX, UnitValue
posY, UnitValue
number

scale)
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Metadata about a document object.

Access through the Document.info property. For example, the following sets the author, caption, and
copyrighted properties:

var docRef = open(fileList[i])

// set the file info

docRef .info.author = "Mr. Adobe programmer"

docRef .info.caption = "Adobe Photo shoot"

docRef .info.copyrighted = CopyrightedType.COPYRIGHTEDWORK

These values can be set interactively by choosing File > File Info.

Property Value type What it is

author string Read-write.

authorPosition string Read-write.

caption string Read-write.

captionWriter string Read-write.

category string Read-write.

city string Read-write.

copyrighted CopyrightedType Read-write. The copyrighted status.

copyrightNotice string Read-write.

country string Read-write.

creationDate string Read-write.

credit string Read-write.

exif array of array [tag data]l Read-only. Camera data thatincludes
camera settings used when the image
was taken.

Each array member is a tag pair, an array
of [tag, tag_datal; for example, [

"camera" "Cannon"].

headline string Read-write.

instructions string Read-write.

jobName string Read-write.

keywords array of string Read-write. A list of keywords that can
identify the document or its contents.

ownerUrl string Read-write.
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Property Value type What it is (Continued)
parent Document Read-only. The info object's container.
provinceState string Read-write.
source string Read-write.
supplementalCategories array of string Read-write.
title string Read-write.
transmissionReference string Read-write
typename string Read-only. The class name of the

referenced info object.

urgency Urgency Read-write.

The following script sets document info (metadata) for all of the files in a specified folder and then saves
the modified files as low-quality JPEG images in a new folder without changing the originals.

Ask the user to specify the folder that contains the original files and the output folder for the JPEG
images, and then check that the folders exist.

Open each file and use the document Info object properties to tag it with the following metadata:
e author: Adobe programmer

e caption: Adobe Photo shoot

e captionWriter: Adobe programmer

e city: San Jose

e copyrightNotice: Copyright (c) Adobe programmer Photography

e copyrighted status: Copyrighted Work

e country: USA

e state:CA

Save the new documents in JPEG format with a low quality setting.

Documentinfo.jsx

// Save the current preferences
var startDisplayDialogs = app.displayDialogs

// Set Adobe Photoshop CC to use pixels and display no dialogs
app.displayDialogs = DialogModes.NO

// ask the user for the input and output folders
var inputFolder = Folder.selectDialog("Select a folder to tag")
var outputFolder = Folder.selectDialog("Select a folder for the output files")

// see if we got something interesting from the dialog
if (inputFolder != null && outputFolder != null) ({

// get all the files found in this folder

var filelList = inputFolder.getFiles()
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// save the outputs in JPEG
var jpegOptions = new JPEGSaveOptions ()
// set the jpeg quality really low so the files are small
jpegOptions.quality =1
// open each one in turn
for (var i = 0; i < fileList.length; i++) {
// The fileList includes both folders and files so open only files
if (fileList[i] instanceof File && fileList[i] .hidden == false) ({
// get a reference to the new document
var docRef = open(fileList[i])

// tag all of the documents with photo shoot information

docRef.info.author = "Adobe programmer"

docRef.info.caption = "Adobe Photo shoot"

docRef .info.captionWriter = "Adobe programmer"

docRef.info.city = "San Jose"

docRef .info.copyrightNotice = "Copyright (c) Adobe programmer
Photography"

docRef .info.copyrighted = CopyrightedType.COPYRIGHTEDWORK
docRef .info.country = "USA"
docRef .info.provinceState = "CA"

// change the date to a Adobe Photoshop CC date format
// "YYYYMMDD"
var theDate = new Date ()
// the year is from 1900 ?2???
var theYear = (theDate.getYear() + 1900) .toString/()
// convert the month from 0..12 to 00..12
var theMonth = theDate.getMonth() .toString/()
if (theDate.getMonth() < 10) {
theMonth = "0" + theMonth
}
// convert the day from 0..31 to 00.31
var theDay = theDate.getDate () .toString()
if (theDate.getDate() < 10) {
theDay = "0" + theDay
}
// stick them all together
docRef.info.creationDate = theYear + theMonth + theDay

// flatten because we are saving to JPEG

docRef .flatten()

// go to 8 bit because we are saving to JPEG
docRef .bitsPerChannel = BitsPerChannelType.EIGHT

// save and close
docRef .savels (new File (outputFolder + "/Output" + i + ".jpg"), jpegOptions)

// don’t modify the original
docRef .close (SaveOptions .DONOTSAVECHANGES)

}

// Reset the application preferences
app.displayDialogs = startDisplayDialogs
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The collection of open Document objects.

Access this list through the Application.documents collection property, which is available through the app
global variable, or directly at the top level. For example, the following adds a new document to the
collection:

app.documents.add (800, 500, 72, "myDocument", NewDocumentMode.RGB)

documents.add (800, 500, 72, "myDocument", NewDocumentMode.RGB)

Property Value type Whatitis
length number Read-only. The number of elements in the documents
collection.
parent Application Read-only. The containing application.
typename string Read-only. The class name of the referenced document s
object.
Method Parameter type Returns What it does
add Document Creates a new document object and
([width] UnitValue adds it to this collection.
[, height] UnitValue
[, resolution] number pixelaAspectRatio: Defaultis 1.0, a
[, name] string square aspect ratio.
[, mode] NewDocumentMode
[, initialFill] DocumentFill bitsPerChannelType: Defaultis

number [0.1..10.00]

[, pixelAspectRatio] . BitsPerChannelType.EIGHT.
[, bitsPerChannel] BitsPerChannelType
! string
[, colorProfileName] )
getByName string Document Gets the first element in the
(name) documents collection with the

provided name
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Options for opening a document in EPS format using the Application.open() method.

Property Value type What it is

antiAlias boolean Read-write. True to use antialias.

constrainProportions boolean Read-write. True to constrain the proportions of
the image.

height Unitvalue Read-write. The height of the image (unit
value).

mode OpenDocumentMode |Read-write. The color profile to use as the
document mode.

resolution number Read-write. The resolution of the document in
pixels per inch.

typename string Read-only. The class name of the referenced
EPSOpenOptions object.

width Unitvalue Read-write. The width of the image (unit value).
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Options for saving a document in EPS format using the Document.saveAs() method.

Property Value type What it is

embedColorProfile boolean Read-write. True to embed the color profile in this
document.

encoding SaveEncoding Read-write. The type of encoding to use (default:
SaveEncoding.BINARY).

halftoneScreen boolean Read-write. True to include the halftone screen
(default: false).

interpolation boolean Read-write. True to use image interpolation (default:
false).

preview Preview Read-write. The preview type.

psColorManagement boolean Read-write. True to use Postscript color management
(default: talse).

transferFunction boolean Read-write. True to include the Transfer functions to
compensate for dot gain between the image and film
(default: £alse).

transparentWhites boolean Read-write. True to display white areas as
transparent.
Valid only when document.mode =
DocumentMode . BITMAP See also changeMode().

typename string Read-only. The class name of the referenced
EPSSaveOptions object.

vectorData boolean Read-write. True to include vector data.

Valid only if the document includes vector data (text).
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Options for exporting Pathltem objects to an Adobe Illustrator® file using using the

Document.exportDocument() method. These options are the options that you can provide when you
choose File > Export > Paths To lllustrator.

Property Value type What it is
path IllustratorPathType Read-write. The type of path to export
(default:

IllustratorPathType . DOCUMENTBOUNDS).

pathName string Read-write. The name of the path to export.

Valid only when path =
IllustratorPathType.NAMEDPATH.

typename string Read-only. The class name of the referenced
exportOptionsIllustrator object.




JavaScript Scripting Reference

Adobe Photoshop CC

JavaScript Object Reference 106

Options for optimizing a document for the web or devices using the Document.exportDocumenty()
method. These are the options that you can provide when you choose File > Save For Web and Devices.

Property Value type What it is

blur number Read-write. Applies blur to the image to reduce
artifacts (default: 0. 0).

colorReduction ColorReductionType | Read-write. The color reduction algorithm (default:
ColorReductionType.SELECTIVE).

colors number Read-write. The number of colors in the palette
(default: 256).

dither Dither Read-write. The type of dither (default:
Dither.DIFFUSION).

ditherAmount number Read-write. The amount of dither (default: 100).
Valid only when
dither = Dither.DIFFUSION.

format SaveDocumentType  Read-write. The file format to use (default:
SaveDocumentType . COMPUSERVEGI F).
Note: For this property, only COMPUSERVEGIF,

JPEG, PNG-8, PNG-24, and BMP are
supported.

includeProfile boolean Read-write. True to include the document’s
embedded color profile (default: false).

interlaced boolean Read-write. True to download in multiple passes;
progressive (default: false).

lossy number Read-write. The amount of lossiness allowed
(default: o).

matteColor RGBColor Read-write. The colors to blend transparent pixels
against.

optimized boolean Read-write. True to create smaller but less
compatible files (default: true).
Valid only when
format = SaveDocumentType.JPEG.

PNGS8 boolean Read-write. Indicates the number of bits; t rue = 8,

false = 24 (default: true).

Valid only when
format = SaveDocumentType.PNG.
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Property Value type What it is (Continued)

quality number [0..100] Read-write. The quality of the produced image as a
percentage; default: 60.

transparency boolean Read-write. Indication of transparent areas of the
image should be included in the saved
image(default: true).

transparencyAmount number Read-write. The amont of transparency dither
(default: 100).
Valid only if transparency = true.

transparencyDither Dither Read-write. The transparency dither algorithm
(default: transparencyDither = Dither.NONE).

typename string Read-only. The class name of the referenced
ExportOptionsSaveForWeb object.

webSnap number Read-write. The tolerance amount within which to

snap close colors to web palette colors (default: o).
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ExtendScript defines the JavaScript classes File and Folder to encapsulate file-system references in a
platform-independent manner; see ‘JavaScript support in Adobe Photoshop CC’' on page 32. For
references details of these classes, see the JavaScript Tools Guide.
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Options for the bannerOptions property of the GalleryOptions object.

Tip: You can preserve default values for many of these properties by setting the GalleryOptions property
preserveAllMetadata to true; this is the same as choosing File > Automate > Web Photo Gallery, and
then choosing Preserve all metadata in the Options area of the Web Photo Gallery dialog.

Property Value type What it is

contactInfo string Read-write. The web photo gallery
contact info.

date string Read-write. The web photo gallery date
(default: current date).

font GalleryFontType Read-write. The font setting for the
banner text (default:
GalleryFontType.ARIAL).

fontSize number [1..7] Read-write. The font size for the banner
text (default: 3).

photographer string Read-write. The web photo gallery
photographer.
siteName string Read-write. The web photo gallery site

name (default:
Adobe Web Photo Gallery).

typename string Read-only. The class name of the
referenced galleryBannerOptions
object.
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Options for the customColorOptions property of the GalleryOptions object.

Tip: You can preserve default values for many of these properties by setting the GalleryOptions property
preserveAllMetadata to true; this is the same as choosing File > Automate > Web Photo Gallery, and
then choosing Preserve all metadata in the Options area of the Web Photo Gallery dialog.

Property Value type What it is

activeLinkColor RGBColor Read-write. The color to use to indicate
an active link.

backgroundColor RGBColor Read-write. The background color.

bannerColor RGBColor Read-write. The banner color.

linkColor RGBColor Read-write. The color to use to indicate a
link.

textColor RGBColor Read-write. The text color.

typename string Read-only. The class name of the
referenced

galleryCustomColorOptions object.

visitedLinkColor RGBColor Read-write. The color to use to indicate a
visited link.
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Options for the imagesOptions property of the GalleryOptions object.

Tip: You can preserve default values for many of these properties by setting the GalleryOptions property
preserveAllMetadata to true; this is the same as choosing File > Automate > Web Photo Gallery, and

then choosing Preserve all metadata in the Options area of the Web Photo Gallery dialog.

Property

Value type

What it is

border

caption

dimension

font

fontSize

imageQuality

includeCopyright

includeCredits

includeFilename

includeTitle

numericLinks

number [0..99]

boolean

number

GalleryFontType

number [1..7]

number [0..12]

boolean

boolean

boolean

boolean

boolean

Read-write. The size (in pixels) of the border
that separates images (default: o).

Read-write. True to generate image captions
(default: talse).

Read-write. The resized image dimensions in
pixels (default: 350).

Valid only when resizelmages = true.

Read-write. The font to use for image
captions (default: calleryFontType . ARIAL).

Read-write. The font size for image captions
(default: 3).

Valid only when caption = true.

Read-write. The quality setting for a JPEG
image (default: 5).

Read-write. True to include copyright
information in captions (default: false).

Valid only when caption = true.

Read-write. True to include the credits in
image captions (default: false).

Valid only when caption = true.

Read-write. True to include the file name in
image captions (default: true).

Valid only when caption = true.

Read-write. True to include the title in image
captions (default: false).

Valid only when caption = true.

Read-write. True to add numeric links
(default: true).
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Property

Value type

What it is (Continued)

resizeConstraint

resizeImages

typename

GalleryConstrainType

boolean

string

Read-write. The image dimensions to
constrain in the gallery image (default:
GalleryConstrainType . CONSTRAINBOTH).

Valid only when resizelmages = true.
Read-write. True to automatically resize

images for placement on the gallery pages
(default: true).

Read-only. The class name of the referenced
galleryImagesOptions Obkct
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Options for a Web photo gallery, created with Application.makePhotoGallery().

Tip: You can preserve default values for many of these properties by choosing File > Automate > Web
Photo Gallery, and then choosing Preserve all metadata in the Options area of the Web Photo

Gallery dialog.
Property Value type What it is
addSizeAttributes boolean Read-write. True to add width and
height attributes for images (default:
true).
bannerOptions GalleryBannerOptions Read-write. The options related to

customColorOptions

emailAddress

imagesOptions

includeSubFolders

layoutsStyle

preserveAllMetadata

securityOptions

thumbnailOptions

typename

useShortExtension

useUTF8Encoding

GalleryCustomColorOptions

string

GalleryImagesOptions

boolean

string

boolean

GallerySecurityOptions

GalleryThumbnailOptions

string

boolean

boolean

banner settings.

Read-write. The options related to
custom color settings.

Read-write. The email address to show
on the web page.

Read-write. The options related to
images settings.

Read-write. True to include all files
found in sub folders of the input
folder (default: true).

Read-write. The style to use for laying
out the web page (default: centered
Frame 1 - Basic).

Read-write. True to save metadata
(default: false).

Read-write. The options related to
security settings.

Read-write. The options related to
thumbnail image settings.

Read-only. The class name of the
referenced galleryoptions object.

Read-write. True to use the short web
page extension .htm. If false, use the

web page extension .html (default:

true).

Read-write. True to use UTF-8
encoding for the web page (default:
false).
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Options for the securityOptions property of the GalleryOptions object.

Tip: You can preserve default values for many of these properties by setting the GalleryOptions property
preserveAllMetadata to true; this is the same as choosing File > Automate > Web Photo Gallery, and

then choosing Preserve all metadata in the Options area of the Web Photo Gallery dialog.

Property

Value type

What it is

content

font

fontSize

opacity

text

textColor

textPosition

textRotate

typename

GallerySecurityType

GalleryFontType

number [1..72]

number

string

GallerySecurityTextColorType

GallerySecurityTextPositionType

GallerySecurityTextRotateType

string

Read-write. The web photo gallery
security content (default:
GallerySecurityType .NONE).

Read-write. The web photo gallery
security font (default:
GalleryFontType.ARIAL).

Read-write. The web photo gallery
security font size (default: 3).

Read-write. The web page security
opacity as a percent (default: 100).

Read-write. The web photo gallery
security custom text.

Read-write. The web page security text
color.

Read-write. The web photo gallery
security text position (default:
GallerySecurityTextPositionType.
CENTERED).

Read-write. The web photo gallery
security text orientation to use (default:
GallerySecurityTextRotateType.
ZERO).

Read-only. The class name of the
referenced gallerySecurityOptions
object.
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Options for the thumbnailOptions property of the GalleryOptions object.

Tip: You can preserve default values for many of these properties by setting the GalleryOptions property
preserveAllMetadata to true; this is the same as choosing File > Automate > Web Photo Gallery, and

then choosing Preserve all metadata in the Options area of the Web Photo Gallery dialog.

Property Value type What it is

border number [0..99] Read-write. The amount of border pixels you
want around your thumbnail images (default:
0).

caption boolean Read-write. True if there is a caption (default:
false).

columnCount number Read-write. The number of columns on the
page (default: 5).

dimension number Read-write. The web photo gallery thumbnail
dimension in pixels (default: 75).

font GalleryFontType Read-write. The web photo gallery font
(default: GalleryFontType . ARIAL).

fontSize number [1..7] Read-write. The font size for thumbnail
images text (default: 3).

includeCopyright boolean Read-write. True to include copyright
information for thumbnails (default: false).

includeCredits boolean Read-write. True to include credits for
thumbnails (default: faise).

includeFilename boolean Read-write. True to include file names for
thumbnails (default: false).

includeTitle boolean Read-write. True to include titles for
thumbnails (default: faise).

rowCount number Read-write. The number of rows on the page
(default: 3).

size GalleryThumbSizeType  Read-write. The thumbnail image size
(default: GalleryThumbSizeType . MEDIUM).

typename string Read-only. The class name of the referenced

GalleryThumbnailOptions object.
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Options for saving a document in GIF format using the Document.saveAs() method.

Property Value type What it is

colors number Read-write. The number of palette colors.
Valid only when palette -
Palette.LOCALADAPTIVE, LOCALPERCEPTUAL,
LOCALSELECTIVE, MACOSPALETTE, UNIFORM,
WEBPALETTE; Of WINDOWSPALETTE .

dither Dither Read-write. The dither type.

ditherAmount number [1..100]  Read-write. The amount of dither (default: 75).
Valid only when dither = Dither.DIFFUSION.

forced ForcedColors Read-write. The type of colors to force into the
color palette.

interlaced boolean Read-write. True if rows should be interlaced
(default: false).

matte MatteType Read-write. The color to use to fill anti-aliased
edges adjacent to transparent areas of the image
(default: MatteType . WHITE).
When transparency = false, the matte coloris
applied to transparent areas.

palette PaletteType Read-write. The type of palette to use (default:

preserveExactColors

transparency

typename

boolean

boolean

string

Palette.LOCALSELECTIVE).

Read-write. True to protect colors in the image
that contain entries in the color table from being
dithered.

Valid only when dither = Dither.DIFFUSION.

Read-write. True to preserve transparent areas of
the image during conversion to GIF format.

Read-only. The class name of the referenced
GIFSaveOptions object.
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Defines a gray color, used in the SolidColor object.

See also CMYKColor, HSBColor, LabColor, NoColor, RGBColor

Property Value type Whati it is
gray numpber [0.0..100.0] Read-write. The gray value (default: 0.0).
typename string

Read-only. The class name of the referenced graycolor
object.
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Property Value type What it is

direction Direction Read-write. Indicates whether the guide is
vertical or horizontal.

coordinate

UnitValue Read-write. Location of the guide from origin
of image.
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The collection of open Guide objects.

Access this list through the Document.guides collection property, which is available through the
activeDocument object. For example, the following adds a new guide to the collection:

activeDocument.guides.add (Direction.HORIZONTAL,UnitValue (20,20))

Property Value type What it is
length number Read-only. The number of elements in the guides
collection.
parent Document Read-only. The containing document.
typename string Read-only. The class name of the referenced guides
object.
Method Parameter type Returns What it does
add Guide Creates a new guide object and adds
(direction Direction it to this collection.
, coordinate) UnitValue
getByName string Guide Gets the first element in the guides
(name)

collection with the provided name
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A version of the document stored automatically (and added to the HistoryStates collection), which
preserves the document’s state, each time the document is changed.

Access through Document.historyStates collection. You can access a state in the list by name. For example,
this assigns a property value in the state object named "AddLayerMask":

var stateRef = app.activeDocument.historyState.getByName ("AddLayerMask") ;
stateRef.snapshot = true;

Property Value type Whatitis

name string Read-only. The HistoryState object's name.

parent Document Read-only. The containing document.

snapshot boolean Read-only. True if the history state is a snapshot.

typename string Read-only. The class name of the referenced HistoryState

object.
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The collection of Guide objects in the document.

Access through Document.historyStates collection property. For example, this accesses one of the states in
the collection by index:

myState app.activeDocument.historyStates[7];

Property Value type What it is

length number Read-only. The number of elements in the Historystates
collection.

parent Document Read-only. The containing document.

typename string Read-only. The class name of the referenced
HistoryStates object.

Method Parameter type Returns What it does

getByName Guide Get the first element in the

(name) string

HistoryStates collection with the
provided name.
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Defines an HSB color, used in the SolidColor object.

See also CMYKColor, GrayColor, LabColor, NoColor, RGBColor

Property

Value type

What it is

brightness
hue
saturation

typename

number [0.0..100.0]
number [0.0..360.0]
number [0.0..100.0]

string

Read-write. The brightness value.
Read-write. The hue value.
Read-write. The saturation value.

Read-only. The class name of the referenced HsBcolor
object.
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Options for converting an RGB image to an indexed color model using Document.changeMode().

Property Value type Whatiitis

colors number Read-write. The number of palette colors.

Valid only when palette =
Palette.LOCALADAPTIVE, LOCALPERCEPTUAL,
LOCALSELECTIVE, MACOSPALETTE, UNIFORM,
WEBPALETTE, or WINDOWSPALETTE.

dither Dither Read-write. The dither type.

ditherAmount number [1..100] Read-write. The amount of dither.

Valid only when dither = Dither.diffusion.

forced ForcedColors Read-write. The type of colors to force into the
color palette.

matte MatteType Read-write. The color to use to fill anti-aliased
edges adjacent to transparent areas of the image
(default: MatteType . WHITE).

When transparency = false, the matte color is
applied to transparent areas.

palette PaletteType Read-write. The palette type (default:
Palette.EXACT).

preserveExactColors boolean Read-write. True to protect colors in the image
that contain entries in the color table from being
dithered.

Valid only when dither = Dither.DIFFUSION.

transparency boolean Read-write. True to preserve transparent areas of
the image during conversion to GIF format.

typename string Read-only. The class name of the referenced
IndexedConversionOptions object.
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Options for saving a document in JPEG format using the Document.saveAs() method.

Property Value type Whatitis

embedColorProfile boolean Read-write. True to embed the color profile in the
document.

formatOptions FormatOptions Read-write.The download format to use (default:

FormatOptions.STANDARDBASELINE)

matte MatteType Read-write. The color to use to fill anti-aliased edges
adjacent to transparent areas of the image (default:
MatteType.WHITE).

When transparency is turned off for an image, the
matte color is applied to transparent areas.

quality number [0..12] Read-write. The image quality setting to use; affects
file size and compression (default: 3).

scans number [3..5] Read-write. The number of scans to make to
incrementally display the image on the page
(default: 3).

Valid only for when formatOptions -
FormatOptions.PROGRESSIVE.

typename string Read-only. The class name of the referenced
JPEGSaveOptions object.
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Defines an LAB color, used in the SolidColor object.

See also CMYKColor, GrayColor, HSBColor, NoColor, RGBColor

Property

Value type

What it is

a
b
1

typename

number [-128.0..127.0]
number [-128.0..127.0]
number [0.0..100.0]

string

Read-write. The a-value.
Read-write. The b-value.
Read-write. The L-value.

Read-only. The class name of the referenced
LabColor object.
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A snapshot of a state of the layers in a document, which can be used to view different page layouts or
compositions.

Access through Document.layerComps collection. You can access a layer comp by its name. For example,
this sets the comment property value for a Layercomp object named myLayerComp:

var layercompRef = app.activeDocument.layerComps.getByName ("myLayerComp") ;

layercompRef.comment = "View from shoreline";
Property Value type What it is
appearance boolean Read-write. True to use layer appearance (layer styles) settings.
comment string Read-write. A description of the layer comp.
name string Read-write. The name of the layer comp.
parent Document Read-write. The containing document.
position boolean Read-write. True to use layer position.
selected boolean Read-only. True if the layer comp is currently selected.
typename string Read-only. The class name of the referenced 1ayercomp object.
visibility boolean Read-write. True to use layer visibility settings .
Method Parameter type Returns What it does
apply Applies the layer comp to the document.
0
recapture Recaptures the current layer state(s) for
0 this layer comp.
remove Deletes the 1ayercomp object.
O
resetfromComp Resets the layer comp state to the

0O document state.
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The collection of LayerComp objects in the document.

Access through the Document.layerComps collection property. For example:

app.activeDocument.layerComps.add ("myLayerComp", "View from Shoreline",
true, true, true);

Property Value type What it is

length number Read-only. The number of elements in the 1ayercomps
collection.

parent Document Read-only. The containing document.

typename string Read-only. The class name of the referenced

layerComps Object.

Method Parameter type Returns What it does
add LayerComp Creates a new layer composition
(name, string object and adds it to this collection.
comment, string
appearance, boolean
position, boolean
visibility) boolean
getByName LayerComp Gets the first element in the
(name) string collection with the provided name.
removeAll Removes all member objects from

0 the layercomps collection.
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The collection of layer objects, including ArtLayer and LayerSet objects, in the document. Access through
Document.layers, or the LayerSet.layers collections properties.

For example, this uses the 1ength property to count the number of 1ayer objects in the active document,
then displays the number on the screen:

var layerNum

app.activeDocument.layers.length

alert (layerNum)

Property Value type Whatitis
length number Read-only. The number of elements in the 1ayers
collection.
parent Document or Read-only. The containing document or layer set.
LayerSet
typename string Read-only. The class name of the referenced 1ayers object.
Method Parameter type  Returns What it does
getByName Layer Gets the first element in the 1ayers
(name) string collection with the provided name.
removeAll

0

Removes all layers from the collection.
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A group of layer objects, which can include ArtLayer objects and other (nested) Layerset objects. A single
command can manipulate all layers in the set.

Access top-level layers sets in a document through the Document.layerSets collection. You can access a
layer set by name. For example, the following sets the al1Locked value for "myLayerSet":

var layerSetRef = app.activeDocument.layerSets.getByName ("myLayerSet") ;
layerSetRef.allLocked = true

Access nested layer sets through the LayerSet.layerSets collection in the parent set. For example:

app.activeDocument.layerSets [0] .layerSets[0];

Property Value type What it is

allLocked boolean Read-write. True if the contents in the layers in this set
are not editable.

artLayers ArtLayers Read-only. The art layers in this layer set.

blendMode BlendMode Read-write. The blend mode to use for the layer set.
bounds array of UnitValue Read-only. The bounding rectangle of the layer set.
enabledChannels array of Channel Read-write. The channels enabled for the layer set; must

be a list of component channels. See Channel.kind.

layers Layers Read-only. The layers in this layer set.
layerSets LayerSets Read-only. Nested layer sets contained within this layer
set.
linkedLayers array of ArtLayer Read-only. The layers linked to this 1ayerset object.
and/or LayerSet
name string Read-write. The name of this layer set.
opacity number [0.0..100.0] Read-write. The master opacity of the set.
parent Document or Read-only. The containing document or layer set.
LayerSet
typename string Read-only. The class name of the referenced Layerset
object.

visible boolean Read-write. True if the set is visible.
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Method Parameter type Returns What it does
duplicate LayerSet Creates a duplicate of the object.
([relativeObiject] artlayer or
LayerSet
. \ , ElementPlacement
[, insertionLocation])
link Links the layer set with another
(with) ArtLayer or |ayer
LayerSet '
merge ArtLayer Merges the layerset; returns a

0 reference to the art layer created
by this method.

move Moves the object.
(relativeObject ArtLayer or
! LayerSet
El tPl t
insertionLocation) el Heeril
remove Deletes the object.
0
resize Resizes all layers in the layer set to
([horizontall nuﬁer to the specified dimensions (as a
, vertical numoer i i
E e ] AnchorPosition percentage of its cu.rrent size) and
' places the layer set in the
specified position.
rotate Rotates all layers in the layer set
(angle numl;ler o around the specified anchor point
[, anchor]) AnchorPosition (default:
AnchorPosition.MIDDLECENTER)
translate Moves the position relative to its
([deltaX] UnitvValue current position.
[, deltaY]) UnitValue P

unlink Unlinks the layer set.
O
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The collection of LayerSet objects in the document.

Access the top-level layer sets in a document through the Document.layerSets collection property. For
example:

var layerSetRef = app.activeDocument.layerSets.add ()

Access the nested layer sets through the LayerSet.layerSets collection property in the parent set. For
example:

var layerSetRef = app.activeDocument.layerSets.getByName ("myParentSet") ;
var childSet = layerSetRef.layerSets.getByName ("myChildSet") ;

Property Value type What it is
length number Read-only. The number of elements in the Layersets
collection.
parent Document or Read-only. The containing document or layer set.
LayerSet
typename string Read-only. The class name of the referenced 1ayersets
object.
Method Parameter type Returns What it does
add LayerSet Creates a new layer set object and adds it to
0 the collection.
getByName LayerSet Gets the first element in the collection with
(name) string the provided name.
removeAll Removes all member layer sets, and any
0 layers or layer sets they contain, from the
document.

The following script creates three layer sets, then nests a second layer set in each layer set, and then
creates a text layer in each nested set that that displays the text "Layer in n Set Inside n Set", where n
represents the ordinal number of the set (first, second, or third).

Note: This script uses the ExtendScript ¢ debugging object. For further details, see the JavaScript Tools
Guide.

LayerSets.jsx
S.level = 1

//close all open documents
while (app.documents.length)
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app.activeDocument.close ()

}

// create a working document
var docRef = app.documents.add()

// create an array to hold the layer sets
var myLayerSets = new Array ()

// Create an array to hold the text
var textArray = Array("First", "Second", "Third")

//Create an indexer variable
var i = 0

// Create three layer sets at the top level
for (i = 0; 1 < 3; 1i++) {
myLayerSets[i] = new Array ()
myLayerSets[i] [0] = docRef.layerSets.add()

}

// Rearrange the layer sets with the first one on top, second next, etc.
myLayerSets[1] [0] .moveAfter (myLayerSets [0] [0])
myLayerSets[2] [0] .moveAfter (myLayerSets[1] [0])

// Create a layer set inside each layer set

for (i = 0; 1 < 3; i++) {
myLayerSets[i] [0] .name = textArray[i] + " Set"
myLayerSets[i] [1] = myLayerSets[i] [0] .layerSets.add ()
myLayerSets[i] [1] .name = "Inside " + textArray[i] + " Set™"

}

// Create an array to hold the layers
var myLayers = new Array ()

// Create a text layer with a description inside each layer set
for (i = 0; 1 < 3; i++) {
myLayers[i] = myLayerSets[i] [1].artLayers.add ()
myLayers [i] .kind = LayerKind.TEXT
myLayers[i] .textItem.contents = "Layer in " + textArray[i] + " Set Inside "
+ textArray[i] + " Set"
myLayers [i] .textItem.position = Array (app.activeDocument.width * i * 0.33,
app.activeDocument.height * (i + 1) * 0.25)
myLayers[i] .textItem.size = 12
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The measurement log for the application. Access through the Application.measurementLog property.

Note: This feature is available in the Extended Version only.

Method Parameter type Returns  What it does
exportMeasurements Export measurement to a file.
([file] File
[, rangel) MeasurementRange
[, dataPoints]) array of string
deleteMeasurements Delete measurements from
([range]) MeasurementRange the Iog.




Adobe Photoshop CC

JavaScript Scripting Reference JavaScript Object Reference 134

The measurement scale for the document. Access through the Document.measurementScale property.
For example:

app.activeDocument .measurementScale.pixelLength = 25

Note: This feature is available in the Extended Version only.

Property Value type What it is
pixelLength number Read-write. The length in pixels this scale equates to.
logicalLength number Read-write. The logical length this scale equates to.

logicalUnits string Read-write. The logical units for this scale.
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Represents a missing color object, used in the SolidColor object.

See also CMYKColor, GrayColor, HSBColor, LabColor, RGBColor

Property Value type What it is

typename string Read-only. The class name of the referenced nocolor

object.
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An event-handler object that tells a script to execute specified code when a specified event occurs.
Notifiers must be enabled using the Application.notifiersEnabled property.

Access through the Application.notifiers collection.

Note: Events that occur within scripts do not generally trigger notifiers, because they occur inside a "play
script” event.

Property Value type What it is

event string Read-only. The event identifier, a four-character code or a
unique string.

For a list of four-character codes, see Appendix A: Event ID
Codes.

eventClass string Read-only. The class identifier, a four-character code or a
unique string.

When an event applies to multiple types of objects, use this
propery to distinguish which object this notifier applies to.
For example, the Make event ("Mk ") can apply to
documents ("Demn"), channels ("chnl") and other objects.

eventFile File Read-only. The path to the file to execute when the event
occurs and activates the notifier.

parent Application Read-only. The containing application.

typename string Read-only. The class name of the referenced object.
Method Parameter type Returns What it does

remove Deletes this object.

0 You can also remove a Notifier object

from the Script Events Manager
drop-down list by deleting the file named
Script Events Manager.xml from the
Photoshop preferences folder. See Adobe
Photoshop CC help for more information.
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The collection of Notifier objects in the document. Access through the Application.notifiers collection
property. For example:

var notRef = app.notifiers.add("OnClickGoButton", eventFile)

Notifiers must be enabled using the Application.notifiersEnabled property.

Property Value type What it is

length number Read-only. The number of elements in the notifiers
collection.

parent Application Read-only. The notifiers object’s container

typename string Read-only. The class name of the referenced notifiers object.

Method Parameter type Returns What it does

add Notifier Creates a notifier object and adds it to this
(event, string collection.

. File
eventFile === defi he class ID of th :
[ eventClass]) string event defines the class of the event: use a

4-characters code or a unique string. See
Appendix A: Event ID Codes.

eventFile defines the script file that
executes when the event occurs.

When an event applies to multiple types of
objects, use the eventClass (a 4-character ID
or unique string) to distinguish which object
this Notifier applies to. For example, the
Make event ("mk ") applies to documents
("Demn"), channels ("chnl") and other
objects.

Tip: When specifying an event or event calss
wtih a 4-character ID code, omit the
single quotes in your code.

removeAll Removes all member objects from the
0 notifiers collection.

You can also remove a notifier object from
the Script Events Manager drop-down list by
deleting the file named script Events
Manager.xml from the Photoshop
preferences folder. See Adobe Photoshop CC
help for more information.
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A path or drawing object, such as the outline of a shape or a straight or curved line, which contains sub
paths that define its geometry.

Access through the collection in the Document.pathltems property. For example, this selects a named

path item:

var currentPathItem = app.activeDocument.pathItems.getByName ("myPath") ;
currentPathItem.select ()

Create these objects by passing a set of SubPathiInfo objects to the Pathltems.add() method. This method
creates a SubPathltem object for each SubPathInfo object, and creates and returns a new Pathltem object
for the path represented by all of the subpaths.

Property Value type Whatitis
kind PathKind Read-write. The type.
name string Read-write. The name.
parent Document Read-only. The containing document.
subPathItems SubPathItems | Read-only. The contained sub-path objects.
typename string Read-only. The class name of the referenced
pathItem object.
Method Parameter type Returns  What it does
deselect Deselects this pathItem
0 object.
duplicate Duplicates this
(name) string pathItemobject with
the new name.
fillPath Fills the area enclosed by
([fillColor] SolidColor this path.
[, mode] ColorBlendMode
[, opacity] number [0..100] opacity is a percentage.
! boolean

[, preserveTransparency]

number [0.0..250.0]

feather is in pixels.

[, feather] boolean
[, wholePath] boolean If wholePath is true, all
[, antiAlias])

subpaths are used when
doing the fill (default:

true).
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Method Parameter type Returns  What it does
makeClippingPath Makes this the clipping
([flatness]) number [0.2..100] path for this document.
flatness tells the
PostScript printer how to
approximate curvesin
the path.
makeSelection Makes a Selection object
([feather] Eumlfer [0.0..250.0] whose border is this
INE oolean
E' EEZ;ati:i}) SelectionType path.
feather is in pixels.
remove Deletes this object.
0
select Makes this the active or
0 selected PathItem
object.
strokePath Strokes the path with
([tool] ToolType the specified tool.
[, simulatePressure]) boolean

The following creates a path in three segments: two diagonal lines that form a V, and a curved line above
the V that makes it look like a 2D ice cream cone.

Paths.jsx

// Save the current preferences

var startRulerUnits = app.preferences.rulerUnits
var startTypeUnits = app.preferences.typeUnits
var startDisplayDialogs = app.displayDialogs

// Set Adobe Photoshop CC to use pixels and display no dialogs
app.preferences.rulerUnits = Units.PIXELS
app.preferences.typelUnits = TypeUnits.PIXELS
app.displayDialogs = DialogModes.NO

// first close all the open documents
while (app.documents.length)
app.activeDocument.close ()

}

// create a document to work with
var docRef = app.documents.add (5000, 7000, 72, "Simple Line")

//line 1--it’s a straight line so the coordinates for anchor, left, and right
//for each point have the same coordinates
var lineArray = new Array ()

lineArray[0] = new PathPointInfo

lineArray[0] .kind = PointKind.CORNERPOINT

lineArray [0] .anchor = Array (100, 100)
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lineArray [0]
lineArray[0]

lineArray[1]
lineArray [1]
lineArray [1]
lineArray [1]
lineArray [1]

var lineSubPathArray =

lineSubPathAr
lineSubPathAr
lineSubPathAr
lineSubPathAr

// line 2

var lineArray2 =
lineArray2[0]
lineArray2 [0]
lineArray2 [0]
lineArray2 [0]
lineArray2 [0]

lineArray2[1]
lineArray2[1]
lineArray2[1]
lineArray2[1]
lineArray2[1]

lineSubPathArray[1] =
lineSubPathArray [1]
lineSubPathArray[1] .
lineSubPathArray[1]

.leftDirection = lineArray[0] .anchor
.rightDirection =

lineArray[0] .anchor

= new PathPointInfo

.kind = PointKind.CORNERPOINT
.anchor = Array (150, 200)
.leftDirection = lineArray[1l] .anchor
.rightDirection =

lineArray[1l] .anchor

new Array ()

ray[0] = new SubPathInfo ()

ray [0] .operation = ShapeOperation.SHAPEXOR
ray[0] .closed = false

ray[0] .entireSubPath = lineArray

new Array ()

= new PathPointInfo

.kind = PointKind.CORNERPOINT

.anchor = Array (150, 200)
.leftDirection = lineArray2[0] .anchor
.rightDirection = lineArray2[0] .anchor

= new PathPointInfo

.kind = PointKind.CORNERPOINT

.anchor = Array (200, 100)
.leftDirection = lineArray2[1l] .anchor
.rightDirection = lineArray2[1l].anchor

new SubPathInfo ()

.operation = ShapeOperation.SHAPEXOR
closed = false

.entireSubPath = lineArray?2

//ice cream curve

//it’s a curved

line, so there are 3 points, not 2

//coordinates for the middle point (lineArray3[1l]) are different.

//The left direc

tion is positioned "above" the anchor on the screen.

//The right direction is positioned "below" the anchor

//You can change
//how the curve
var lineArray3 =
lineArray3[0]
lineArray3[0]
lineArray3[0]
lineArray3[0]
lineArray3[0]

lineArray3[1]
lineArray3[1]
lineArray3[1]
lineArray3[1]
lineArray3[1]

lineArray3[2]
lineArray3[2]
lineArray3[2]
lineArray3[2]
lineArray3[2]

the coordinates for these points to see
works. ..

new Array ()

= new PathPointInfo

.kind = PointKind.CORNERPOINT

.anchor = Array (200, 100)

.leftDirection = lineArray3[0] .anchor
.rightDirection = lineArray3[0].anchor

= new PathPointInfo

.kind = PointKind.CORNERPOINT
.anchor = Array (150, 50)
.leftDirection = Array (100, 50)
.rightDirection = Array (200, 50)

= new PathPointInfo

.kind = PointKind.CORNERPOINT

.anchor = Array (100, 100)
.leftDirection = lineArray3[2] .anchor
.rightDirection = lineArray3[2].anchor
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lineSubPathArray[2] = new SubPathInfo()
lineSubPathArray[2] .operation = ShapeOperation.SHAPEXOR
lineSubPathArray[2] .closed = false

lineSubPathArray[2] .entireSubPath = lineArray3

//create the path item
var myPathItem = docRef.pathItems.add("A Line", lineSubPathArray)

// stroke it so we can see something
myPathItem. strokePath (ToolType.BRUSH)

// Reset the application preferences
preferences.rulerUnits = startRulerUnits
preferences.typeUnits = startTypeUnits
displayDialogs = startDisplayDialogs
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The collection of Pathltem objects in a document.

Access through the Document.pathltems collection property. For example, this creates a new path item
using a previously-defined set of subpaths:

app.activeDocument.pathItems.add ("myPath", lineSubPathInfoArray) ;

Property Value type What it is

length number Read-only. The number of pathItem objects in the
pathItems collection.

parent Document Read-only. The pathItems object's container.
typename string Read-only. The class name of the referenced pathItems
object.
Method Parameter type Returns What it does
add PathItem Createsa new path item object and adds it
(name, string to this collection.

array of SubPathInfo

entirePath) . .
A new SubPathltem object is created for
each subPathInfo object provided in
entirePath, and those subPathItem
objects are added to the subPathltems
collection of the returned Pathltem.
getByName PathItem Get the first elementin the pathItems
(name) string collection with the provided name.
removeAll Removes all pathItem objects from the

0 pathItems collection.
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Represents the anchor and control-handle endpoints for a path segment. Each point (the anchor point,
left-direction point, and right-direction point) is an array containing X and Y position coordinates.

e Usethe Ppathproint object to retrieve information about the points that describe existing path
segments. The properties are read-only. Access PathPoint objects through the SubPathltem.pathPoints

property.

e Use PathPointInfo with Pathltems.add() to create path points. The properties are writeable.

For paths that are straight segments (not curved), the coordinates of all three points are the same. For
curved segements, the the coordinates are different. The difference between the anchor point and the left
or right direction points determines the arc of the curve. You use the left direction point to bend the curve
"outward" or make it convex; you use the right direction point to bend the curve "inward" or make it

concave.

Property Value type What it is

anchor array of number Read-only. The X and Y coordinates of the anchor point of the
curve.

kind PointKind Read-only. The role (corner or smooth) this point plays in the
containing path segment.

leftDirection array of number Read-only. The location of the left-direction endpoint ('in’
position).

parent SubPathItem Read-only. The containing subpath object.

rightDirection array of number Read-only. The location of the right-direction endpoint (‘out’
position).

typename string Read-only. The class name of the referenced PathPoint

object.
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Used to create a PathPoint, which represents the anchor and control-handle endpoints for a path segment.
Each point (the anchor point, left-direction point, and right-direction point) is an array containing X and Y
position coordinates.

e Use the JavaScript new operator to create these objects, and store them in the
SubPathinfo.entireSubPath property before using that object to create a path item with
Pathltems.add().

See the PathPointInfo sample script below.

e The resulting SubPathltem objects contain the resulting PathPoint objects. Use the PathPoint object to
retrieve information about the points that describe existing path segments. The properties are
read-only.

For paths that are straight segments (not curved), the coordinates of all three points are the same. For
curved segements, the the coordinates are different. The difference between the anchor point and the left
or right direction points determines the arc of the curve. You use the left direction point to bend the curve
"outward" or make it convex; you use the right direction point to bend the curve "inward" or make it

concave.

Property Value type What it is

anchor array of number Read-write. The X and Y coordinates of the anchor point of
the curve.

kind PointKind Read-write. The role (corner or smooth) this point plays in the
containing path segment.

leftDirection array of number Read-write. The location of the left-direction endpoint (in’
position).

rightDirection array of number Read-write. The location of the right-direction endpoint (‘out’
position).

typename string Read-only. The class name of the referenced PathPointInfo
object.

function drawLine (doc, start, stop) {

var startPoint = new PathPointInfo() ;
startPoint.anchor = start;
startPoint.leftDirection = start;
startPoint.rightDirection = start;
startPoint.kind = PointKind.CORNERPOINT;

var stopPoint = new PathPointInfo() ;
stopPoint.anchor = stop;
stopPoint.leftDirection = stop;
stopPoint.rightDirection = stop;
stopPoint.kind = PointKind.CORNERPOINT;
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var spi = new SubPathInfo() ;

spi.closed = false;

spi.operation = ShapeOperation.SHAPEXOR;
spi.entireSubPath = [startPoint, stopPoint];

var line = doc.pathItems.add("Line", [spil);
line.strokePath (ToolType.PENCIL) ;
line.remove () ;

Vi

drawLine (app.activeDocument, [100,100], [200,2001]);
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A collection of PathPoint objects that define a subpath, kept in the SubPathltem.pathPoints property.

Property Value type What it is

length number Read-only. The number of elements in the collection.
parent SubPathItem Read-only. The containing subpath object.
typename string

Read-only. The class name of the referenced pathproints
object.
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Options for opening a document in generic Adobe PDF format using the Application.open() method.

Property Value type What it is

antiAlias boolean Read-write. True to use antialias.

bitsPerChannel BitsPerChannelType| Read-write. The number of bits per channel.

constrainProportions boolean DEePRECATED for Adobe Photoshop CC.

cropPage CropToType Read-write. The method of cropping to use.

height UnitValue DePRECATED for Adobe Photoshop CC.

mode OpenDocumentMode  Read-write. The color model to use.

name string Read-write. The name of the object.

page number Read-write. The page or image to which to open
the document, depending on the value of
usePageNumber.

resolution number Read-write. The resolution of the document (in

pixels per inch).

suppressWarnings boolean Read-write. True to suppress warnings when
opening the document.

typename string Read-only. The class name of the referenced
PDFOpenOpt ions object.

usePageNumber boolean Read-write. When true, the page property refers
to a page number; when false, it refers to an
image number.

width UnitValue DEePRECATED for Adobe Photoshop CC.
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Options for saving a document in Adobe PDF format using the Document.saveAs() method.

Property Value type Whatitis

alphaChannels boolean Read-write. True to save the alpha channels
with the file.

annotations boolean Read-write. True to save comments with the
file.

colorConversion boolean Read-write. True to convert the color profile
to a destination profile.

convertToEightBit boolean Read-write. True to convert a 16-bit image
to 8-bit for better compatibility with other
applications.

description string Read-write. Description of the save options
to use.

destinationProfile string Read-write. Description of the final RGB or
CMYK output device, such as a monitor or a
press standard.

downgradeColorProfile boolean DEPRECATED for Adobe Photoshop CC.

downSample

downSampleSize

downSampleSizeLimit

embedColorProfile

embedFonts

embedThumbnail

encoding

interpolation

PDFResample

number

number

boolean

boolean

boolean

PDFEncoding

boolean

Read-write. The down sample method to
use.

Read-write. The size to downsample images
if they exceed the limit in pixels per inch.

Read-write. Limits downsampling or
subsampling to images that exceed this
value in pixels per inch.

Read-write. True to embed the color profile
in the document.

DEPRECATED for Adobe Photoshop CC.

Read-write. True to include a small preview
image in Adobe PDF files.

Read-write. The type of compression to use
(default: PDFEncoding. PDFZIP).

DEPRECATED for Adobe Photoshop CC.
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Property Value type What it is (Continued)

jpegQuality number [0..12] Read-write. The quality of the produced
image, which is inversely proportionate to
the compression amount.
Valid only when encoding =
PDFEncoding.JPEG.

layers boolean Read-write. True to save the document’s
layers.

optimizeForWeb boolean Read-write. True to improve performance of
PDF files on Web servers.

outputCondition string Read-write. An optional comment field for
inserting descriptions of the output
condition. The text is stored in the PDF/X
file.

outputConditionID string Read-write. Indentifier for the output
condition.

PDFCompatibility PDFCompatibility Read-write. The PDF version to make the
document compatible with.

PDFStandard PDFStandard Read-write. The PDF standard to make the
document compatible with.

preserveEditing boolean Read-write. True to reopen the PDF in
Adobe Photoshop CC with native
Photoshop data intact.

presetFile string Read-write. The preset file to use for
settings.
Note: This option overrides other settings.

profileInclusionPolicy boolean Read-write. True to show which profiles to
include.

registryName string Read-write. URL where the output condition
is registered.

spotColors boolean Read-write. True to save spot colors.

tileSize nunber Read-write. Compression option.
Valid only when encoding =
PDFEncoding.JPEG2000.

transparency boolean DePRECATED for Adobe Photoshop CC.

typename string Read-only. The class name of the referenced
PDFSaveOptions object.

useOutlines boolean DEPRECATED for Adobe Photoshop CC.
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Property Value type What it is (Continued)
vectorData boolean DEPRECATED for Adobe Photoshop CC.
view boolean

Read-write. True to open the saved PDF in
Adobe Acrobat.




Adobe Photoshop CC
JavaScript Scripting Reference JavaScript Object Reference 151

DEPRECATED in Adobe Photoshop CC. Kodak PhotoCD is now found in the Goodies folder on the Adobe
Photoshop CC Install DVD.

Options for opening a document in Kodak Photo CD (PCD) format (including high-resolution files from Pro
Photo CD discs) using the Application.open() method.

Property Value type What it is

colorProfileName string Read-write. The profile to use when reading the
image.

colorSpace PhotoCDColorSpace  Read-write. The colorspace for the image.

orientation Orientation Read-write. The image orientation.

pixelSize PhotoCDSize Read-write. The image dimensions.

resolution number Read-write. The image resolution (in pixels per
inch).

typename string Read-only. The class name of the referenced

photoCDOpenOptions object.
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Options for saving a document in PSD format using the Document.saveAs() method.

Property Value type Whatitis

alphaChannels boolean Read-write. True to save the alpha channels.

annotations boolean Read-write. True to save the annotations.

embedColorProfile boolean Read-write. True to embed the color profile in the
document.

layers boolean Read-write. True to preserve the layers.

spotColors boolean Read-write. True to save the spot colors.

typename string Read-only. The class name of the referenced

photoshopSaveOptions object.
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Options for saving a document in PICT format using the Document.saveAs() method.

Property Value type What it is

alphaChannels boolean Read-write. True to save the alpha channels.

compression PICTCompression Read-write. The type of compression to use
(default: PICTCOompression . NONE).

embedColorProfile boolean Read-write. True to embed the color profile in the
document.

resolution PICTBitsPerPixels  Read-write. The number of bits per pixel.

typename string Read-only. The class name of the referenced

PICTFileSaveOptions object.
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Options for saving a document as a PICT Resource file using the Document.saveAs() method.

Property Value type What it is

alphaChannels boolean Read-write. True to save the alpha channels.

compression PICTCompression Read-write. The type of compression to use (default:
PICTCompression.NONE).

embedColorProfile boolean Read-write. True to embed the color profile in the
document.

name string Read-write. The name of the PICT resource.

resolution PICTBitsPerPixels Read-write. The number of bits per pixel.

resourceID number Read-write. The ID of the PICT resource (default:
128).

typename string Read-only. The class name of the referenced

PICTResourceSaveOptions object.
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Options for a picture package created with Application.makePicturePackage().

Property Value type What it is

content PicturePackageTextType Read-write. The content information (default:
PicturePackageTextType . NONE).

flatten boolean Read-write. True if all layers in the final
document are flattened (default: true).

font GalleryFontType Read-write. The font used for security text
(default: GalleryFontType . ARIAL).

fontSize number Read-write. The font size used for security
text (default: 12).

layout string Read-write. The layout to use to generate the
picture package (default: " (2) 5x7").

mode NewDocumentMode Read-write. Read-write. The color profile to
use as the document mode (default:
NewDocumentMode . RGB).

opacity number Read-write. The web page security opacity as
a percent (default: 100).

resolution number Read-write. The resolution of the document
in pixels per inch (default: 72. 0).

text string Read-write. The picture package custom text.
Valid only when content =
PicturePackageType.USER.

textColor RGBColor Read-write. The color to use for security text.

textPosition |GallerySecurityTextPositionType Read-write. The security text position
(default:
GallerySecurityTextPositionType.
CENTERED).

textRotate GallerySecurityTextRotateType Read-write. The orientation to use for
security text (default:
GallerySecurityTextRotateType.ZERO).

typename string Read-only. The class name of the referenced

PicturePackageOptions object.
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Options for saving a document in Pixar format using the Document.saveAs() method.

Property Value type What it is

alphaChannels boolean Read-write. True to save the alpha
channels.

typename string Read-only. The class name of the

referenced PixarSaveOptions
object.
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Options for saving a document in PNG format using the Document.saveAs() method.

Property Value type Whatiit is

compression number [0..9] Read-write. The compression value (default: o).
interlaced boolean Read-write. True to interlace rows (default: false).
typename string Read-only. The class name of the referenced

PNGSaveOptions object.
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Represents application preferences for Photoshop. Access this object through the Application.preferences

property. For example:

app.preferences.rulerUnits = Units.PIXELS

app.preferences.typeUnits = TypeUnits.PIXELS

Setting values in this object is equivalent to selecting Edit > Preferences (in Windows) or Photoshop >
Preferences (in Mac OS) in the Adobe Photoshop CC application. For explanations of individual settings,

see Adobe Photoshop CC Help.

Property Value type What it is

additionalPluginFolder File Read-write. The path to an additional
plug-in folder.
Valid only when
useAdditionalPluginFolder = true.

appendExtension SaveBehavior Read-write. The preferred policy for
writing file extensions in Windows.

askBeforeSavingLayeredTIFF boolean Read-write. True to ask the user to verify
layer preservation options when saving a
file in TIFF format.

autoUpdateOpenDocuments boolean Read-write. True to automatically update
open documents.

beepWhenDone boolean Read-write. True to beep when a process
finishes.

colorChannelsInColor boolean Read-write. True to display component
channels in the Channels palette in color.

colorPicker ColorPicker Read-write. The preferred color selection
tool.

columnGutter number [0.1..600.0] Read-write. The width of the column
gutters (in points).

columnWidth number [0.1..600.0] Read-write. Column width (in points)

createFirstSnapshot

dynamicColorSliders

editLogItems

boolean

boolean

EditLogIltemsType

Read-write. True to automatically make
the first snapshot when a new document
is created.

Read-write. True if dynamic color sliders
appear in the Color palette.

Read-write. The preferred level of detail
in the history log. Valid only when

useHistoryLog = true.
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Property Value type What it is (Continued)

exportClipboard boolean Read-write. True to retain Adobe
Photoshop CC contents on the clipboard
after you exit the application.

fontPreviewSize FontPreviewType Read-write. The preferred type size to use
for font previews in the type tool font
menus.

fullSizePreview boolean Read-write. True to show image preview
as a full size image, false to show
thumbnail (in Mac OS only).

gamutWarningOpacity number [0..100] Read-write. Opacity value as a
percentage.

gridSize Gridsize Read-write. The preferred size to use for
squares in the grid.

gridstyle GridLineStyle Read-write. The preferred formatting
style for non-printing grid lines.

gridsSubDivisions number [1..100] Read-write. Number of grid subdivisions.

guideStyle GuideLineStyle Read-write. The preferred formatting
style for non-printing guide lines.

iconPreview boolean Read-write. True to use icon previews (in
Mac OS only).

imageCacheLevels number [1..8] Read-write. The number of images to
hold in the cache.

imagePreviews SaveBehavior Read-write. The preferred policy for
writing image previews in Windows.

interpolation ResampleMethod Read-write. The method to use to assign
color values to any new pixels created
when an image is resampled or resized.

keyboardZoomResizesWindows boolean Read-write. True to automatically resize
the window when zooming in or out
using keyboard shortcuts.

macOSThumbnail boolean Read-write. True to create a thumbnail
when saving the image (in Mac OS only).

maximizeCompatibility QueryStateType Read-write. The preferred policy for

maxRAMuse

nonLinearHistory

number [5..100]

boolean

checking whether to maximize
compatibility when opening PSD files.

Read-write. The maximum percentage of
available RAM used by Adobe
Photoshop CC (5 - 100).

Read-write. True to allow non-linear
history.
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Property Value type What it is (Continued)

numberofHistoryStates number Read-write. The number of history states
to preserve.

otherCursors OtherPaintingCursors Read-write. The preferred type of pointer
to use with certain tools.

paintingCursors PaintingCursors Read-write. The preferred type of pointer
to use with certain tools.

parent Application Read-write. The containing application.

pixelDoubling boolean Read-write. True to halve the resolution
(double the size of pixels) to make
previews display more quickly.

pointSize PointType Read-write. The point/pica size.

recentFileListLength number [0..30] Read-write. The number of items in the
recent file list.

rulerUnits Units Read-write. The unit the scripting system
will use when receiving and returning
values.

saveLogItems SaveLogItemsType Read-write. Thepreferred location of
history log data when saving the history
items.

saveLogItemsFile File Read-write. The path to the history log
file, when the preferred location is a file.

savePaletteLocations boolean Read-write. True to make new palette
locations the default location.

showAsianTextOptions boolean Read-write. True to display Asian text
options in the Paragraph palette.

showEnglishFontNames boolean Read-write. True to list Asian font names
in English.

showSliceNumber boolean Read-write. True to display slice numbers
in the document window when using the
Slice tool.

showToolTips boolean Read-write. True to show pop up
definitions on mouse over.

smartQuotes boolean Read-write. True to use curly, false to use
straight quote marks.

textFontSize FontSize Read-write. Size of the small font used in
panels and dialogs.

typename string Read-only. The class name of the

referenced preferences object.
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Property Value type What it is (Continued)
typeUnits TypeUnits Read-write. The preferred unit for text
character measurements.
useAdditionalPluginFolder boolean Read-write. True to use an additional
folder for compatible plug-ins stored
with a different application.
useHistoryLog boolean Read-write. True to create a log file for
history states.
useLowerCaseExtension boolean Read-write. True to use lowercase for file
extensions.
useShiftKeyForToolSwitch boolean Read-write. True to enable cycling
through a set of hidden tools.
useVideoAlpha boolean Read-write. True to enable Adobe
Photoshop CC to send transparency
information to your computer’s video
board. (Requires hardware support.)
windowsThumbnail boolean Read-write. True to create a thumbnail

when saving the image in Windows.
(Requires hardware support.)
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Options for Adobe PDF presentations created using Application.makePDFPresentation().

Property Value type What it is

autoAdvance boolean Read-write. True to auto advance images when when
viewing the presentation (default: t rue).
Valid only when presentation = true.

includeFilename boolean Read-write. True to include the file name for the image
(default: talse).

interval number [1..60] Read-write. The time in seconds before the view is auto
advanced (default: 5).
Valid only when autoAdvance = true.

loop boolean Read-write. True to begin the presentation again after
the last page (default: false).
Valid only when autoAdvance = true.

magnification MagnificationType Read-write. The magnification type to use when viewing
the image.

PDFFileOptions PDFSaveOptions Read-write. Options to use when creating the PDF file.

presentation boolean Read-write. True if the output will be a presentation
(default: false); when false, the outputis a Multi-Page
document.

transition TransitionType Read-write. The method for transition from one image to
the next (default: TransitionType . NONE).
Valid only when autoAdvance = true..

typename string Read-only. The class name of the referenced

PresentationOptions object.
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Options for opening a document in RAW format using the Application.open() method.

Property Value type Whatitis

bitsPerChannel number Read-write. The number of bits for each channel.
The only valid values are BitsPerChannelType.EIGHT
Or BitsPerChannelType .SIXTEEN.

byteOrder ByteOrder Read-write. The order in which multibyte values are
read.
Valid only when bitsPerChannel =
BitsPerChannelType.SIXTEEN.

channelNumber number [1..56] Read-write. The number of channels in the image. The
value of cannot exceed the number of channels in the
image.
When bitsPerChannel =
BitsPerChannelType.SIXTEEN, the only valid values
are1,3,or4.

headerSize number Read-write. The number of bytes of information that

[0..1919999] . . . . . .

will appear in the file before actual image information
begins; that is, the number of zeroes inserted at the
beginning of the file as placeholders.

height number Read-write. The height of the image (in pixels).

interleaveChannels boolean Read-write. True to store color values sequentially.

retainHeader boolean Read-write. True to retain the header when saving.
Valid only when headerSize is 1 or greater.

typename string Read-only. The class name of the referenced
RawFormatOpenOptions object.

width number Read-write. The image width in pixels.
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Options for saving a document in RAW format using the Document.saveAs() method.

Property Value type What it is

alphaChannels boolean Read-write. True if alpha channels should be saved.
spotColors boolean Read-write. True if the spot colors should be saved.
typename string

Read-only. The class name of the referenced rRawSaveOptions
object.
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Defines an RGB color, used in the SolidColor object.

See also CMYKColor, GrayColor, HSBColor, LabColor, NoColor.

Property

Value type

What it is

blue
green
hexValue
red

typename

number [0..255]
number [0..255]
string

number [0..255]

string

Read-write. The blue color value (default: 255).
Read-write. The green color value (default: 255)
Read-write. The hexadecimal representation of the color.
Read-write. The red color value (default: 255)

Read-only. The class name of the referenced rGBColor object.
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The selected area of a document or layer. Access through the Document.selection property. For example:

app.activeDocument.selection.fill (app.foregroundColor)

Many of the properties and methods use the UnitValue type, which combines measurement values with
the measurement unit. For information about this type, see the JavaScript Tools Guide.

Property Value type What it is
bounds array of Unitvalue  Read-only. The bounding rectangle of the entire selection.
parent Document Read-only. The object's container.
solid boolean Read-only. True if the bounding rectangle is a solid.
typename string Read-only. The class name of the referenced selection
object.
Method Parameter type Returns What it does
clear Clears the selection and
0 does not copy it to the
clipboard.
contract Contracts (reduces) the
(by) UnitValue selection by the specified
amount.
copy Copies the selection to the
([merge]) boolean clipboard. When the
optional argument is used
and set to true, a merged
copy is performed (all visible
layers in the selection are
copied).
cut Clears the current selection
0 and copies it to the
clipboard.
deselect Deselects the current
0 selection.
expand Expands the selection by the
(by) UnitValue specified amount.
feather Feathers the edges of the
(by) UnitValue selection by the specified

amount.
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Method Parameter type What it does (Continued)
£ill Fills the selection.
(Filltype SolidColor .
[ mode] ColorBlendMode opacity Is a percentage
[: opacity] number [1..100] value.
[, preserveTransparency]) boolean
grow Grows the selection to
(tolerance, Eu“?er include all adjacent pixels
antiAlias) cotean falling within the specified
tolerance range.
invert Inverts the selection
0 (deselects the selection and
selects the rest of the layer
or document).
Tip: To flip the selection
shape, see rotate.
load Loads the selection from the
(from Channel specified channel.
[, combination] SelectionType P
[, inverting]) boolean
makeWorkPath number Makes this selection item
([tolerance]) the work path for this
document.
resize Resizes the selected area to
([horizontall nuﬁer the specified dimensions
, +1 1 nu er .
E Zﬁ&iii ] AnchorPosition and anchor position.
resizeBoundary Changes the size of the
([horizontall nuﬁer selection to the specified
. 1 nu er . .
E, ;frelzil;?) ] AnchorPosition d|mngS|ons around the
’ specified anchor.
rotate Rotates the selection by the
(angle number specified amount around
[ J h AnchorPosition P .r .
. anchor]) the specified anchor point.
rotateBoundary Rotates the boundary of the
(angle number selection around the
[, anchor]) AnchorPosition specified anchor.
select Selects the specified region.
; array of number .
(]Eegi;;e] SelectionType The region parameter is an
[ feather] number array of four coordinates,
[, antiAlias]) boolean [left, top, right, bottom].
selectAll Selects the entire layer.

0
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Method Parameter type Returns What it does (Continued)
selectBorder Selects the selection border
(width) UnitValue only (in the specified width);
subsequent actions do not
affect the selected area
within the borders.
similar Grows the selection to
(tolerance, number include pixels throughout
antiAlias) boolean the image falling within the
tolerance range.
smooth Cleans up stray pixels left
(radius) number inside or outside a
color-based selection
(within the radius specified
in pixels).
store Saves the selection as a
(into Channel channel.
[, combination]) SelectionType
stroke Strokes the selection border.
(strokeColor, SolidColor opacity is a percentage
width pumbex . value.
[, location] StrokeLocation
[, mode] ColorBlendMode
[, opacity] number [1..100]
[, preserveTransparency]) boolean
translate Moves the entire selection
([deltax] UnitValue relative to its current
[, deltaY]) UnitValue position.
translateBoundary Moves the selection relative
([deltax] UnitValue to its current position.
[, deltay]) UnitvValue

The following script creates a checkerboard using the following steps:

e Create an 800 x 800 pixel document.

e Divide the entire document into 100 x 100 pixel squares.

e Select every other square in the first row, then shift the selection criteria to select the alternate squares
in the following row. Repeat until every other square in the document is selected.

o Fill the selected squares with the foreground color from the palette.

e Invert the selection and fill the newly selected squares with the background color from the palette.

e Deselect the squares to remove the selection outlines (the "marching ants").

Selection.jsx

// Save the current preferences
var startRulerUnits = app.preferences.rulerUnits
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var startTypeUnits = app.preferences.typeUnits
var startDisplayDialogs = app.displayDialogs

// Set Adobe Photoshop CC to use pixels and display no dialogs
app.preferences.rulerUnits = Units.PIXELS
app.preferences.typeUnits = TypeUnits.PIXELS
app.displayDialogs = DialogModes.NO

//Close all the open documents
while (app.documents.length)

app.activeDocument.close ()
}

//Create variables for the 800 pixel board divided in even 100 x 100 squares
var docSize = 800

var cells = 8
var cellSize = docSize / cells

// create a new document
var checkersDoc = app.documents.add(docSize, docSize, 72, "Checkers")

// Create a variable to use for selecting the checker board

// That allows me to shift the selection one square to the right
//on every other row, and then shift back for the rows in between.
var shiftIt = true

// loop through vertically to create the first row
for (var v = 0; v < docSize; v += cellSize) {

// Switch the shift for a new row
shiftIt = !shiftIt

// loop through horizontally
for (var h = 0; h < docSize; h += (cellSize * 2)) {

// push over the cellSize to start with only
if (shiftIt && h == 0) {
h += cellSize

// Select a square
selRegion = Array (Array (h, v),
Array (h + cellSize, v),
Array(h + cellSize, v + cellSize),
Array(h, v + cellSize),
Array (h, v))

// In the first ineration of the loop, start the selection
//In subsequent iterations, use the EXTEND constant value
//of the select () method to add to the selection (in the loop’s else clause)

if (h == 0 && v == 0) {
checkersDoc.selection.select (selRegion)
} else {

checkersDoc.selection.select (selRegion, SelectionType.EXTEND)

// turn this off for faster execution
// turn this on for debugging
WaitForRedraw ()
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}

// Fill the current selection with the foreground color
checkersDoc.selection.fill (app. foregroundColor)

//Invert the selection
checkersDoc.selection.invert ()

// Fill the new selection with the background color
checkersDoc.selection.fill (app.backgroundColor)

// Clear the selection to get rid of the non-printing borders
checkersDoc.selection.deselect ()

// Reset the application preferences
app.preferences.rulerUnits = startRulerUnits
app.preferences.typeUnits = startTypeUnits
app.displayDialogs = startDisplayDialogs

// A helper function for debugging
// It also helps the user see what is going on
// if you turn it off for this example you
// get a flashing cursor for a number time
function WaitForRedraw ()
{
var eventWait = charIDToTypeID ("Wait")
var enumRedrawComplete = charIDToTypeID ("RdACm")
var typeState = charIDToTypeID("Stte")
var keyState = charIDToTypeID("Stte")

var desc = new ActionDescriptor ()
desc.putEnumerated (keyState, typeState, enumRedrawComplete)

executeAction (eventWait, desc, DialogModes.NO)
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Options for saving a document in SGIRGB format using the Document.saveAs() method.

Note: The SGIRGB format is not installed automatically with Adobe Photoshop CC.

Property Value type What it is

alphaChannels boolean Read-write. True to save the alpha
channels.

spotColors boolean Read-write. True to save the spot
colors.

typename string Read-only. The class name of the

referenced SGIRGBSaveOptions
object.
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A color definition used in the document. Maps a color to equivalents in all available color models.

e Used in Application.backgroundColor and foregroundColor properties, in Channel.color, in

ColorSampler.color, and in Textltem.color

e Passed to Pathltem fillPath(), Selection fill(), and Selection.stroke().

Property Value type What it is

cmyk CMYKColor Read-write. The CMYK color mode.

gray GrayColor Read-write. The Grayscale color mode.

hsb HSBColor Read-write. The HSB color mode.

lab LabColor Read-write. The LAB color mode.

model ColorModel Read-write. The color model.

nearestWebColor  RGBColor Read-only. The nearest web color to the current color.

rgb RGBColor Read-write. The RGB color mode.

typename string Read-only. The class name of the referenced solidcolor

object.

Method Parameter type Returns What it does

isEqual boolean True if the solidcolor object is visually
(color) SolidColor equal to the specified color.
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An array of PathPoint objects that describes a straight or curved segment of a path, used to create a
SubPathltem.

Pass an array of these objects to the Pathltems.add() method. This method creates a SubPathltem object
for each subrPathInfo object, and creates and returns a new Pathltem object for the path represented by
all of the subpaths.

e Use subPathInfo to create subpaths; the properties are writeable.

e Use the SubPathltem object to retrieve information about existing subpaths. The properties are

read-only.

Property Value type Whatitis

closed boolean Read-write. True if the path describes an enclosed area.

entireSubPath array of PathPoint Read-write.

operation ShapeOperation Read-write. The subpath’s operation on other
subpaths. Specifies how to combine the shapes if the
destination path already has a selection.

typename string Read-only. The class name of the referenced

SubPathInfo object.
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Represents a subpath; a collection of subpaths make up a Pathltem.

Create these objects by passing SubPathinfo objects to the Pathltems.add() method. This method creates
a subPathItem object for each SubPathinfo object, and creates and returns a new Pathltem object for the
path represented by all of the subpaths. Access these objects in the Pathltem.subPathltems collection.

e Use the SubPathltem object to retrieve information about existing subpaths. The properties are
read-only.

e Use SubPathlinfo to create subpaths; the properties are writeable.

Property Value type Whatitis
closed boolean Read-only. True if the path is closed.
operation ShapeOperation Read-only. How this object behaves when it intersects

another SubPathltem object. Specifies how to combine the
shapes if the destination path already has a selection.

parent PathItem Read-only. The object's container.
pathPoints PathPoints Read-only. The PathPoints collection.
typename string Read-only. The class name of the referenced subPathItem

object.
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A collection of SubPathltem objects that make up a Pathltem. Access this object in the
Pathltem.subPathltems collection property.

e Use SubPathlinfo to create subpaths; the properties are writeable.

e Use the SubPathltem object to retrieve information about existing subpaths. The properties are

read-only.
Property Value type Whatitis
length number Read-only. The number of elements in the collection.
parent PathItem Read-only. The containing path item.
typename string Read-only. The class name of the referenced subrathItems

object.
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Options for saving a document in TGA (Targa) format using the Document.saveAs() method.

Property Value type What it is

alphaChannels boolean Read-write. True to save the alpha channels.

resolution TargaBitsPerPixels Read-write. The number of bits per pixel (default:
TargaBitsPerPixels.TWENTYFOUR).

rleCompression boolean Read-write. True to use RLE compression (default: true).

typename string Read-only. The class name of the referenced

TargaSaveOptions object.
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Describes a font that is available to the application. Access this object in the Application.fonts collection.
For example:

var myFont = app.fonts.getByName ("ArialMT") ;

Property Value type What it is

family string Read-only. The font family.

name string Read-only. The name of the font.

parent Application Read-only. The containing application.
postScriptName string Read-only. The PostScript name of the font.

style string Read-only. The font style.

typename string Read-only. The class name of the referenced TextFont

object.
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The collection of fonts available on your computer. Fonts are represented by TextFont objects. Access this

object in the Application.fonts collection property. For example, this displays the number of available
fonts:

alert (app.fonts.length) ;

Property Value type What it is

length number Read-only. The number of elements in the collection.

parent Application Read-only. The containing application.

typename string Read-only. The class name of the referenced TextFonts object.

Method Parameter type Returns What it does

getByName . TextFont Gets the first element in the TextFonts
(name) string

collection with the provided name.
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The text in an ArtLayer object whose kind property is Layerkind . TEXT. Access this object in the
ArtLayer.textltem property. For example:

myLayers [i] .textItem.contents = "Layer in " + textArray[i] + " Set Inside "
yLay

Many of the properties use the UnitValue type, which combines a measurement value with a
measurement unit. For information about this type, see the JavaScript Tools Guide.

Property Value type What it is
alternateligatures boolean Read-write. True to use alternate ligatures.
Note: Alternate ligatures are the same as
Discretionary Ligatures. See Adobe
Photoshop CC Help for more information.
antiAliasMethod AntiAlias Read-write. The method of anti aliasing to use.
autoKerning AutoKernType Read-write. The auto kerning option to use.
autoLeadingAmount number Read-write. The percentage to use for auto (default)
[0.01..5000.00] . . .
leading (in points).
Valid only when useAutolLeading = true.
baselineShift UnitValue Read-write. The unit value to use in the baseline
offset of text.
capitalization TextCase Read-write. The text case.
color SolidColor Read-write. The text color.
contents string Read-write. The actual text in the layer.
desiredGlyphScaling number [50..200] Read-write. The desired amount by which to scale the

horizontal size of the text letters. A percentage value;
at 100, the width of characters is not scaled.

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Or
Justification.RIGHTJUSTIFIED.

When used, the minimumGlyphScaling and
maximumGlyphScaling values are also required.
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Property

Value type

What it is (Continued)

desiredLetterScaling

desiredWordScaling

direction

fauxBold

fauxItalic

firstLineIndent

font

hangingPunctuation

height

horizontalScale

number

[100..500]

number

[0..1000]

Direction

boolean

boolean

UnitValue
-1296..1296]

points

string

boolean

UnitValueX

number

[0..1000]

Read-write. The amount of space between letters (at
0, no space is added between letters).

Equivalent to Letter Spacing in the Justification
dialog (Select Justification on the Paragraphs
palette menu).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED.

When used, the minimumLetterScaling and
maximumLetterScaling values are also required.

Read-write. The amount (percentage) of space
between words (at 100, no additional space is added
between words).

Equivalent to Word Spacing in the Justification
dialog (Select Justification on the Paragraphs
palette menu).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED.

When used, the minimumWordScaling and
maximumWordScaling values are also required.

Read-write. The text orientation.

Read-write. True to use faux bold (default: false).

Setting this to true is equivalent to selecting text and
clicking Faux Bold in the Character palette.

Read-write. True to use faux italic (default: false).

Setting this to true is equivalent to selecting text and
clicking Faux Italic in the Character palette.

Read-write. The amount (unit value) to indent the
first line of paragraphs.

Read-write. The text face of the character. Use the
PostScript Name of the font. See TextFont and use
the postScriptName property.

Read-write. True to use Roman hanging punctuation.

Read-write. The height of the bounding box (unit
value) for paragraph text.

Valid only when kind = TextType.PARAGRAPHTEXT.

Read-write. Character scaling (horizontal) in
proportion to verticalScale (a percentage value).
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Property Value type What it is (Continued)

hyphenateAfterFirst number [1..15] Read-write. The number of letters after which
hyphenation in word wrap is allowed.

hyphenateBeforeLast number [1..15] Read-write. The number of letters before which
hyphenation in word wrap is allowed.

hyphenateCapitalWords boolean Read-write. True to allow hyphenation in word wrap

hyphenateWordsLongerThan

hyphenation

hyphenationZone

hyphenLimit

justification
kind

language
leading

leftIndent

ligatures

maximumGlyphScaling

number [2..25]

boolean

UnitValue
0..720] pica

number

Justification

TextType
Language
UnitValue

UnitValue
-1296..1296]

points
boolean

number [50..200]

of capitalized words.

Read-write. The minimum number of letters a word
must have in order for hyphenation in word wrap to
be allowed.

Read-write. True to use hyphenation in word wrap.

Read-write. The distance at the end of a line that will
cause a word to break in unjustified type.

Read-write. The maximum number of consecutive
lines that can end with a hyphenated word.

Read-write. The paragraph justification.
Read-write. The text-wrap type.
Read-write. The language to use.
Read-write. The leading amount.

Read-write. The amoun of space to indent text from
the left.

Read-write. True to use ligatures.

Read-write. The maximum amount to scale the
horizontal size of the text letters (a percentage value;
at 100, the width of characters is not scaled).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED.

When used, the minimumGlyphScaling and
desiredGlyphScaling values are also required.
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Property

Value type

What it is (Continued)

maximumLetterScaling

maximumWordScaling

minimumGlyphScaling

number

[100..500]

number

number

[0..1000]

[50..200]

Read-write. The maximum amount of space to allow
between letters (at 0, no space is added between
letters).

Equivalent to Letter Spacing in the Justification
dialog (Select Justification on the Paragraphs
palette menu).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Or
Justification.RIGHTJUSTIFIED.

When used, the minimumLetterScaling and
desiredLetterScaling values are also required.

Read-write. The maximum amount of space to allow
between words (a percentage value; at 100, no
additional space is added between words).

Equivalent to Word Spacing in the Justification
dialog (Select Justification on the Paragraphs
palette menu).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED.

When used, the minimumWordScaling and
desiredWordScaling values are also required.

Read-write. The minimum amount to scale the
horizontal size of the text letters (a percentage value;
at 100, the width of characters is not scaled).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED.

When used, the maximumGlyphScaling and
desiredGlyphScaling values are also required.
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Property

Value type

What it is (Continued)

minimumLetterScaling

minimumWordScaling

noBreak

oldstyle
parent

position

rightIndent

size

spaceAfter

number
[100..500]

number [0..1000]

boolean

boolean

ArtLayer

array of
UnitValue

UnitValue
-1296..1296]

points

UnitValue

UnitValue
-1296..1296]

points

Read-write. The minimum amount of space to allow
between letters (a percentage value; at 0, no space is
removed between letters).

Equivalent to Letter Spacing in the Justification
dialog (Select Justification on the Paragraphs
palette menu).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Or
Justification.RIGHTJUSTIFIED.

When used, the maximumLetterScaling and
desiredLetterScaling values are also required.

Read-write. The minimum amount of space to allow
between words (a percentage value; at 100, no
additional space is removed between words).

Equivalent to Word Spacing in the Justification
dialog (Select Justification on the Paragraphs
palette menu).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED.

When used, the maximumWordScaling and
desiredWordScaling values are also required.

Read-write. True to disallow line breaks in this text.

Tip: When true for many consecutive characters, can
prevent word wrap and thus may prevent some
text from appearing on the screen.

Read-write. True to use old style type.
Read-write. The containing layer.

Read-write. The position of origin for the text. The
array members specify the X and Y coordinates.

Equivalent to clicking the text tool at a point in the
document to create the point of origin for text.

Read-write. The amount of space to indent text from
the right.

Read-write. The font size in unitvalue . NOTE: Type
was points for CS3 and older..

Read-write. The amount of space to use after each
paragraph.
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Property Value type What it is (Continued)
spaceBefore UnitValue Read-write. The amount of space to use before each
T-1296..1296] h
points paragrapn.
strikeThru StrikeThruType Read-write. The text strike-through option to use.
textComposer TextComposer Read-write. The composition method to use to

evaluate line breaks and optimize the specified
hyphenation and justification options.

Valid only when kind = TextType.PARAGRAPHTEXT.

tracking number Read-write. The amount of uniform spacing between
[-1000..10000] .
multiple characters.

Tracking units are 1/1000 of an em space. The width
of an em space is relative to the current type size.In a
1-point font, 1 em equals 1 point;in a 10-point font, 1
em equals 10 points. So, for example, 100 units in a
10-point font are equivalent to 1 point.

typename string Read-only. The class name of the referenced
textItem object.

underline UnderlineType | Read-write. The text underlining options.

useAutoLeading boolean Read-write. True to use a font's built-in leading
information.

verticalScale number [0-1000] |Read-write.Vertical character scaling in proportion to

horizontalScale (a percentage value).

warpBend number Read-write. The warp bend percentage.
[-100..100]

warpDirection Direction Read-write. The warp direction.

warpHorizontalDistortion r[lug%)gr 100] Read-write. The horizontal distortion of the warp (a

percentage value).

warpStyle WarpStyle Read-write. The style of warp to use.
warpVerticalDistortion number Read-write. The vertical distortion of the warp (a
[-100..100] percentage value).
width Unitvalue Read-write. The width of the bounding box for
paragraph text.

Valid only when kind = TextType.PARAGRAPHTEXT.
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Method Parameter type Returns What it does
convertToShape Converts the text item and its containing layer to
0 afill layer with the text changed to a clipping
path.
createPath Creates a clipping path from the outlines of the

0 actual text items (such as letters or words).
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Options for saving a document in TIFF format using the Document.saveAs() method.

Property Value type What it is

alphaChannels boolean Read-write. True to save the alpha channels.

annotations boolean Read-write. True to save the annotations.

byteOrder ByteOrder Read-write. The order in which the document’s
multibyte values are read (default:
ByteOrder.MACOS in Mac OS, ByteOrder . IBM
in Windows).

embedColorProfile boolean Read-write. True to embed the color profile in
the document.

imageCompression TIFFEncoding Read-write. The compression type (default:
TIFFEncoding.NONE).

interleaveChannels boolean Read-write. True if the channels in the image
will be interleaved.

jpegQuality number [0..12] Read-write. The quality of the produced
image, which is inversely proportionate to the
amount of JPEG compression.
Valid only when imageCompression =
TIFFEncoding.JPEG.

layerCompression LayerCompression  Read-write. The method of compression to use
when saving layers (as opposed to saving
composite data).
Valid only when layers = true.

layers boolean Read-write. True to save the layers.

saveImagePyramid boolean Read-write. True to preserve multi-resolution
information (default: false).

spotColors boolean Read-write. True to save the spot colors.

transparency boolean Read-write. True to save the transparency as
an additional alpha channel when the file is
opened in another application.

typename string Read-only. The class name of the referenced

TiffSaveOptions object.
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ExtendScript defines the JavaScript class Unitvalue to represent measurement values together with their
measurement units; see ‘JavaScript support in Adobe Photoshop CC’ on page 32. For references details of
these classes, see the JavaScript Tools Guide.
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Camera RAW image XMP metadata.

For camera RAW image files, the XMP metadata is stored in a sidecar file, which is a file in the same folder as
the RAW file with the same base name and an XMP extension.

Property Value type What it is
parent Document Read-only. The containing document.
rawData string Read-write. A string containing the XMP metadata in

XML (RDF) format. See the XMP Specification for
details of this format.

typename string Read-only. The class name of the referenced
xmpMetadata object.




3

JavaScript Resource

This section describes the JavaScript resource that enables your JavaScripts to behave like a plug-in. This

includes:

e the ability to specify a menu the script appears in as a command,

e aterminology resource so the script can function with the Action Manager, which allows your script to
record and be automated by scripting parameters,

e acategory to enable ordering and grouping of commands within menus, and

e an enable string that indicates whether the command is enabled or disabled given a set of conditions.

e The strings must be valid XML syntax. The "&" character will not work for example. Use the samp ; samp ;
for example to get logical ‘&&’ in the enableinfo block.

The JavaScript Resource has an HTML-style syntax, with each <tag> matched by a closing </tags>. This
resource needs to appear within comments ( /* ... */)and should be defined at the top of your script
file (within the first 10,240 characters of the file.)

Tag

Description

<javascriptresources>

<name>

<menu>

<about>

<enableinfo>

<eventids>

The resource definition tag.

The command name that appears in the Photoshop menu.

If this tag is not provided in the resource, the name of the command in the
menu defaults to the name of the script.

The menu the command appears in. If this tag is not provided, the
command appears in the File > Scripts menu.

Note: Currently the only supported values for <menu> are automate,
filter and help. automate puts the scriptin the File >
Automate menu for example.

A string that appears in an About box, which the user can select from the
Help > About Plug-in menu.

A boolean expression that indicates whether the command is enabled in
the menu. See Enable-info grammar.

Note: If you provide this tag, the menu item is enabled if and only if there
is at least one document open, and the boolean expression
evaluates to true. If you always want the menu item enabled, do not
use this tag.

A unique string that identifies the event. Using a UUID will ensure that your
script wont share this identifier with another script.

189
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Tag Description
<category> The category the command appears within in the menu. Used to group

and order commands in the menu. Commands are placed in the menu
alphabetically based on the string in <categorys. If two commands use
the same category, they are grouped together.

<terminology> The terminology dictionary for the script to function with the Action
Manager. See the Terminology dictionary.

This example shows a very basic <javascriptresources. With this resource, the script can be executed
by selecting the command Add a Document, which appears in the Automate menu. This command is
enabled in the menu, provided at least one document is already open. If the user requests information
about the script from the About Plug-in menu, the string contained in the <about > tag is displayed in a
dialog box.
/*

<javascriptresources>

<name>Add a Document</name>

<type>automate</type>

<about>A short string providing information about the script.</abouts>

<enableinfo>true</enableinfo>

</javascriptresources>

*/

app.documents.add() ;

The <enableinfo> tag provides a boolean expression that, when evaluated, indicates whether the
command is enabled in the menu. You can use this expression to enable or disable the menu item based
on various characteristics of the document. The Enable Info grammar is as follows:

<booleanExpressions> := <conjunction> { "||" <conjunctions> }
<conjunctions := <relation> {"&&" <relations> }
<relation> := <equality> {<relationOperators<equality>}
<equalitys> := <simpleExpression> {<equalityOperator><simpleExpressions}
<simpleExpression> := <term> {<addOperator><terms}
<terms> := <factor> {<mulOperators><factors}
<factor> := <integer> | <intrinsic> | <ident> |
" (" <booleanExpression ")" | "(" simpleExpression ")" |
"+" <factors | "-" <factor> | "!" <factors>
<integers := digit {digit}
<intrinsics> := <limitFunction> | <dimFunction> | <inFunctions
<limitFunction> := ( "min" | "max") " (" <simpleExpression> ", "
<simpleExpression> { "," <simpleExpression> } ")"
<dimFunctions> := "dim" " (" <simpleExpression> "," <simpleExpression> ")"
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<ident> := (alpha | " ") {alpha | digit | " » }
<mulOperators> := LA AL

<addOperator> := L

<equalityOperators> := M==t | mi=m

<relationOperators> := Mt | ome=n | ms=w | ows

<inFunction> := "in" " (" <simpleExpression> {"," <simpleExpression> } ")"

Operator precedence is shown in the following table. Operators are listed with the highest order of
precedence at the top of the table

Operator Description

| Or

&& And

+ - Addition or subtraction

* / Multiply or divide

< <= >= > Less than, less than or equal, greater than or equal, greater than

== l= Equals, or does not equal.

(..) in() max() min()  Functions
unary + - ! Unary operators: increment, decrement, not

The grammar provides variables and constants that you can use in the <enableinfo> expression. The
following table provides a list of the constants that are available.

Constant Name Description

true Boolean true

false Boolean false
BitmapMode Bitmap mode.
GrayScaleMode Grayscale mode, 8 bit depth.
IndexedMode Indexed color mode.
RGBMode RGB color mode.
CMYKMode CMYK color mode.
HSIMode HSL color mode.
HSBMode HSB color mode
MultiChannelMode Multichannel mode.
DuotoneMode Duotone mode.

LabMode

Lab color mode.
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Constant Name Description

GrayléMode Grayscale mode, 16 bits per channel
RGB48Mode RGB color mode, 16 bits per channel.
Lab48Mode LAB mode, 16 bits per channel.
CMYK64Mode CMYK mode, 16 bits per channel.

DeepMultichannelMode | Deep multichannel mode.

DuotoneléMode Duotone mode, 16 bit depth.
RGB96Mode RGB color mode, 32 bits per channel.
Gray32Mode Grayscale mode, 32 bit depth.

The following table show the set of variables you can use in the <enableinfo> expression. The value of
these variables is set based on the properties of the active document.

Variable Name

Description

PSHOP_ImageMode
PSHOP_ImageDepth
PSHOP_HasLayerMask
PSHOP_HasSelectionMask
PSHOP_ HasTransparencyMask
PSHOP_NumTargetChannels
PSHOP_NumTrueChannels
PSHOP_IsAdjustorSheet
PSHOP_ IsTargetComposite
PSHOP IsTargetSection
PSHOP_ IsTargetVisible
PSHOP_ImageWidth
PSHOP_ImageHeight

PSHOP_TargetProtectFlags.

Image mode of the active document.

Depth of the active document.

Boolean indicating presence of layer mask.
Boolean indicating presence of selection mask.

Boolean indicating presence of transparency mask.

Number of target channels.
Numer of image channels.

Boolean

Boolean indicating whether channels are flattened.

Boolean.
Boolean.
Width of the image.

Height of the image.

If any arithmetic or relation operation contains an operand whose value is undefined, or a variable that is
undefined, the result of that evaluation is false.

Boolean values are treated as in C/C++, where non-zero values are true, and zero is false, with the

exception that an undefined value is also false.
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The in function (see <inFunctions) returns true is the first parameter is equal to at least one of the
subsequent parameters. A typical use might be to see if the image mode of the active document is one of
a set of image modes. For example:

in (PSHOP_ImageMode, RGBMode, CMYKMode, LabMode)

For your script to be able to record scripting parameters and be automated by them, it requires the
addition of two basic mechanisms:

e A terminology dictionary that maps your script’s user interface to human readable text, providing text
and type information for each parameter the script uses.

e Code to read parameter information when it comes from the Action Manager, rather than from the
user-interface, and code to write parameter information to the Action Manger. This code uses the
Action Manager classes ActionDescriptor, ActionList, and ActionReference.

See conditional Mode Change.jsx foran example of a script that can record and be automated by
scripting parameters. This file can be found in the Presets/Scripts folder.

The JavaScript resource provides a <terminologys tag that allows you to provide the terminology
dictionary for your script. The first step in creating a terminology dictionary is to review your script’s user
interface, and create human-readable strings for each element in your user interface.

For example, in the Conditional Mode Change command, the user interface requests a source mode and a
target mode. Both source mode and target mode have several options. All of these elements of the user
interface need to have entries in the terminology dictionary.

The terminology dictionary is created in a PDF dictionary format, with the following entries, and must have
the following format in the <javascriptresources:

<terminology><! [CDATA [<<<
/Version integer
/Events <<event dictionarys>>
/Classes <<class dictionarys>>
/Enumerations <<enumeration dictionarys>>
>>> ]]></terminology>

Note: The information in the terminology tag needs to be wrapped in a cpata block so the xml parser will
ignore "/" and other tags that appear in the terminology.

The defintions for events, classes and enumerations dictionaries are provided below.
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The /Events dictionary contains an entry for each event:

/eventName [ // Name used in string-based API
(String event name) // required
/direct parameter type // optional; if omitted, no parameter
<< // optional parameter dictionary
/parameterName [ // Name used in string-based API
(String name) // required
/parameter type // required

]
// other parameters
>>

The /classes dictionary contains and entry for each class:

/className [ // Name used in string-based API
(zString class name) // required
<< // property dictionary
/propertyName [ // Name used in string-based API
(String name) // required
/property type // required

]

// other properties
>>

The /Enumerations dictionary contains an entry for each enumerated type:

/enumTypeName // Name used in string-based API
<<

/enumValue (String name) // required

>>

For /parameter type and /property type definitons, you can use the Class and Enumeration type
declarations you make in your own terminology dictionary, you can use declarations provided by
Photoshop or you can use basic value types.

Basic Value Types

The basic value types are shown in the following table:

Name Code Description

typelnteger 'long' int32

typeFloat "doub' IEEE 64 bit double

typeBoolean 'bool! TRUE Of FALSE

typeText "TEXT' Block of any number of readable characters.

typeAlias ralis’ Macintosh file system path.
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Name Code Description
typePaths "Pth ! Windows file system path.
typePlatformFilePath 'alis'or'Pth typeAlias for Mac OS, typePath for Windows.
Predefined Class Types

Photoshop provides a number of predefined classes that are available for use in the terminology
dictionary. A useful subset of those classes is shown in the table below. Use these classes when they are
appropriate, but you can define new classes in the terminology resource, if necessary.

Name Code Description

classColor 'Clr ! Class for color classes.

classRGBColor '"RGBC' keyRed, keyGreen, keyBlue
classCMYKColor 'CMYC! keyCyan, keyMagenta, keyYellow, keyBlack.
classUnspecifiedColo 'UnsC' Unspecified.

r

classGrayscale 'Grsc' keyGray

classBookColor 'BkC1 ! Book color

classLabColor '"IbCl! keyLuminance, keyA, keyB.

Generally, the names for terminology entries must be unique within a particular category and scope. It is
best to not make names unique unnecessarily; generic terms are prefereable, and if a name already exists
for something, go ahead and use it. Case matters in considering uniqueness of terminology entries.

The uniqueness rules for terminology entries are:

o All event names must be different from all other event names.

e All class names must be different from all other names.

e All enumeration type names must be different from all other enumeration type names.

e All keys must be different from all other keys used in the same class or event.

e All enumeration values must be different from all other enumeration values in the same enumeration
type.
e Aclass, event, enumeration type, key, and enumeration value can all have the same name.

This example demonstrates the terminology definition for a new event; the example uses ZStrings. The
event is called newaAnnot, and it takes three parameters:

e annotType, an enumeration (annotType)
e at,aclass (point), and

e =size,aclass (annotSizeClass).
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The annotSizeClass has two properties: width, and height, both of type floatType. The enumeration
annotType has three values: annot Unknown, annot Text, and annotSound

<terminology><! [CDATA [<<<
/Version 1
/Events
/newAnnot [ (New Annotation) <<
/annotType [ (Type) /annotTypel
/at [(At) /Point]
/size [(Size) /annotSizeClass] >>]
/Classes
/annotSizeClass [(Size) <<
/width [(Width) /floatType]
/height [(Height) /floatType]
>>]
/Enumerations
/annotType <<
/annotUnknown (Unknown)
/annotText (Text)
/annotSound (Sound)
>>> ]]></terminology>



Scripting Constants

This section lists and describes the enumerations defined for use with Adobe Photoshop CC JavaScript

properties and methods.

Constant type Values What it means
AdjustmentReference ABSOLUTE Method to use for interpreting
RELATIVE selective color adjustment
specifications:
ABSOLUTE = % of the whole.
RELATIVE = % of the existing color
amount.
Pass to ArtLayer.selectiveColor().
AnchorPosition BOTTOMCENTER The point around which to transform
BOTTOMLEFT an object. This is the point that does
BOTTOMR IGHT t hen an object is rotated or
MIDDLECENTER not move when an objec
MIDDLELEFT resized using methods in ArtLayer,
MIDDLERIGHT LayerSet, and Selection, or when the
TOPCENTER entire canvas is resized with
TOPLEFT D t resizeC 0
TOPRIGHT ocument.resizeCanvas().
AntiAlias CRISP Method to use to smooth edges by
NONE softening the color transition between
SHARP edge pixels and background pixels
SMOOTH 9ep ground pixels.
STRONG Used in a Textltem.antiAliasMethod.
AutoKernType MANUAL The type of kerning to use for
ggg?éﬁi characters. Used in
Textltem.autoKerning.
BatchDestinationType FOLDER The destination, if any, for
NODESTINATION batch-processed files, specified in the
SAVEANDCLOSE

BatchOptions used with the
Application.batch() method:

FOLDER: Save modified versions of the
files to a new location (leaving the
originals unchanged).

NODESTINATIONTYPE: Leave all files
open.

SAVEANDCLOSE: Save changes and
close the files.
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Constant type

Values

What it means

BitmapConversionType

BitmapHalfToneType

BitsPerChannelType

BlendMode

BMPDepthType

CUSTOMPATTERN
DIFFUSIONDITHER
HALFTHRESHOLD
HALFTONESCREEN
PATTERNDITHER

CROSS
DIAMOND
ELLIPSE
LINE
ROUND
SQUARE

EIGHT
ONE
SIXTEEN
THIRTYTWO

COLORBLEND
COLORBURN
COLORDODGE
DARKEN
DIFFERENCE
DISSOLVE
DIVIDE
EXCLUSION
HARDLIGHT
HARDMIX
HUE
LIGHTEN
LINEARBURN
LINEARDODGE
LINEARLIGHT
LUMINOSITY
MULTIPLY
NORMAL
OVERLAY
PASSTHROUGH
PINLIGHT
SATURATION
SCREEN
SOFTLIGHT
SUBTRACT
VIVIDLIGHT

BMP_A1R5G5B5
BMP_A4R4G4B4
BMP_ASR8G8B8
BMP_R5G6B5
BMP_R8G8B8
BMP_X1R5G5B5
BMP_X4R4G4B4
BMP_X8R8G8B8
EIGHT

FOUR

ONE

SIXTEEN
THIRTYTWO
TWENTYFOUR

Specifies the quality of an image you
are converting to bitmap mode. Used
in BitmapConversionOptions.

Specifies the shape of the dots (ink
deposits) in the halftone screen. Used
in BitmapConversionOptions.

The number of bits per color channel.
Value of Document.bitsPerChannel;
pass to Documents.add(). Also used in
PDFOpenOptions and
CameraRAWOpenOptions.

Controls how pixels in an image are
blended when a filter is applied. The
value of ArtLayer.blendMode and
LayerSet.blendMode.

The number of bits per channel (also
called pixel depth or color depth). The
number selected indicates the
exponent of 2. For example, a pixel
with a bit-depth of E1GHT has 28 or
256, possible color values.

Used in BMPSaveOptions.
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Constant type Values What it means
ByteOrder IBM The platform-specific order in which
MACOS multibyte values are read.
CameraRAWSettingsType CAMERA The default CameraRaw settings to
S:EJEE?TIIEDIMAGE use: the camera settings, custom
settings, or the settings of the selected
image. Set in
CameraRAWOpenOptions.
CameraRAWSize EXTRALARGE The camera RAW size type options..
LARGE
MAXTIMUM EXTRALARGE=5120 x 4096
MEDIUM LARGE=4096 x 2731
gmiﬁm MAXIMUM=6144 X 4096
MEDIUM=3072 x 2048
MINIMUM=1536 x 1024
SMALL=2048 x 1365
Set in CameraRAWOQOpenOptions.
ChangeMode BITMAP The new color profile or mode for a
CMYK document, specified in
GRAYSCALE D t ch Mode()
. ocument.changeMode().
LAB ]
MULTTCHANNEL Note: Color images must be changed
RGB to GRAYSCALE mode before you
can change them to BITMAP
mode.
ChannelType COMPONENT The type of a color channel:
MASKEDAREA
SELECTEDAREA COMPONENT: related to document color
SPOTCOLOR mode.

MASKEDAREA: Alpha channel where
color indicates masked area.

SELECTEDAREA: Alpha channel where
color indicates selected are.

SPOTCOLOR: Alpha channel to store a
spot color.
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Constant type

Values

What it means

ColorBlendMode

ColorModel

ColorPicker

ColorProfileType

ColorReductionType

ColorSpaceType

CopyrightedType

BEHIND
CLEAR

COLOR
COLORBURN
COLORDODGE
DARKEN
DARKERCOLOR
DIFFERENCE
DISSOLVE
EXCLUSION
HARDLIGHT
HARDMIXBLEND
HUE

LIGHTEN
LIGHTERCOLOR
LINEARBURN
LINEARDODGE
LINEARLIGHT
LUMINOSITY
MULTIPLY
NORMAL
OVERLAY
PINLIGHT
SATURATION
SCREEN
SOFTLIGHT
VIVIDLIGHT

CMYK
GRAYSCALE
HSB

LAB

NONE

RGB

ADOBE
APPLE
PLUGIN
WINDOWS

CUSTOM
NONE
WORKING

ADAPTIVE
BLACKWHITE
CUSTOM
GRAYSCALE
MACINTOSH
PERCEPTUAL
RESTRICTIVE
SELECTIVE
WINDOWS

ADOBERGB
COLORMATCHRGB
PROPHOTORGB
SRGB

COPYRIGHTEDWORK

PUBLICDOMAIN
UNMARKED

The way color should be blended in a
fill or stroke operation. Pass to
Pathltem.fillPath(), Selection.fill(),
Selection.stroke()

The color model to use for a
SolidColor.

The preferred color-selection tool, set
in Preferences.

The type of color profile used to
manage this document, set in
Document.colorProfileType.

The color reduction algorithm option
for ExportOptionsSaveForWeb.

The type of color space to use in
CameraRAWOpenOptions.

The copyright status of a document.
Used in
DocumentPrintSettings.copyrighted.
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Constant type Values What it means
CreateFields DUPLICATION The method to use for creating fields.
INTERPOLATION Pass to ArtLayer.applyDelnterlace().
CropToType ARTBOX The style to use when cropping a page
Eggfg?ﬁ}égox in a PDF document. Set in
CROPROX PDFOpenOptions.cropPage.
MEDIAROX
TRIMBOX
DCSType COLORCOMPOSITE The type of composite DCS file to
Egég;ggg?ggmo“m create with DCS1_SaveOptions or
DCS2_SaveOptions:
COLORCOMPOSITE: Creates a color
composite file in addition to DCS files.
GRAYSCALECOMPOSITE: Creates a
grayscale composite file in addition to
DCS files.
NOCOMPOSITE: Does not create a
composite file.
DepthMapSource IMAGEHIGHLIGHT The source to use for the depth map.
LAYERMASK Pass to ArtLayer.applyLensBlur().
NONE yer.apply 0
TRANSPARENCYCHANNEL
DescValueType ALIASTYPE The value type of an action key,
22222?1;?;% returned by
DOUBLETYDE ActionQescriptor.getType() and
ENUMERATEDTYPE ActionList.getType().
INTEGERTYPE
LARGEINTEGERTYPE
LISTTYPE
OBJECTTYPE
RAWTYPE
REFERENCETYPE
STRINGTYPE
UNITDOUBLE
DialogModes ALL Controls the type of dialogs
EgROR Photoshop displays when running
scripts.
Direction HORIZONTAL e Thedirection in which to flip the
VERTICAL

document canvas, passed to
Document.flipCanvas().

e The orientation of text in
Textltem.direction.

e The direction of text warping in
Textltem.warpDirection.
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Constant type Values What it means
DisplacementMapType STRETCHTOFIT Describes how the displacement map
TILE fits the image if the image is not the
same size as the map. Pass to
ArtLayer.applyDisplace().
Dither DIFFUSION The type of dithering to use in
Eg;:E GIFSaveOptions,
PATTERN IndexequnversmnOonns and
ExportOptionsSaveForWeb.
DocPositionStyle PRINTCENTERED The type of positioning to use in
USERDEFINED DocPosition
DocumentFill BACKGROUNDCOLOR The fill type of a new document,
TRANSPARENT passed to Documents.add().
WHITE -
DocumentMode BITMAP The color mode of a open document,
%gﬁom Document.mode. See also
GRAYSCALE Document.changeMode().
INDEXEDCOLOR
LAB
MULTICHANNEL
RGB
EditLogItemsType CONCISE The preferred level of detail in th
DETAILED history log, set in Preferences:
SESSTONONLY —
CONCISE: Save a concise history log.
DETAILED: Save a detailed history log.
SESSIONONLY: Save history log only for
the session.
ElementPlacement INSIDE The object’s position in the Layers
PLACEATBEGINNING palette.
PLACEATEND
PLACEBEFORE .
PLACEAFTER Note: No't all values are valid for fa!l
object types. See the specific
object description to make sure
you are using a valid value.
EliminateFields EVENFIELDS The type of fields to eliminate. Pass to
ODDFIELDS ArtLayer.applyDelnterlace().
ExportType ILLUSTRATORPATHS The type of export for
SAVEFORWEB Document.exportDocumenty().
This is equivalent to choosing File >
Export > Paths To lllustrator, or File
> Save For Web and Devices.
Extension LOWERCASE The policy and format for appending
NONE an extension to the filename when
UPPERCASE

saving with Document.saveAs().
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Constant type Values What it means
FileNamingType DDMM File naming options for the
gg% MELOWER BatchOptions used with the
DOCUMENTNAMEMIXED Application.patch() method.
DOCUMENTNAMEUPPER
EXTENSIONLOWER
EXTENSIONUPPER
MMDD
MMDDYY
SERIALLETTERLOWER
SERIALLETTERUPPER
SERIALNUMBER1
SERIALNUMBER2
SERTALNUMBER3
SERIALNUMBER4
YYDDMM
YYMMDD
YYYYMMDD
FontPreviewType HUGE The preferred type size to use for font
EXTEQLARGE previews in the type tool font menus,
MEDIUM set in Preferences.
NONE
SMALL
FontSize LARGE The preferred type size to use for
MEDIUM panels and dialogs, set in Preferences.
SMALL
ForcedColors BLACKWHITE The type of colors to be included the
g%m - color table regardless of their usage.
WEB Used in GIFSaveOptions and
IndexedConversionOptions.
BLACKWHITE: Pure black and pure
white.
NONE: None
PRIMARIES: Red, green, blue, cyan,
magenta, yellow, black, and white.
WEB: the 216 web-safe colors.
FormatOptions OPTIMIZEDBASELINE The option with which to save a JPEG
PROGRESSIVE file, in JPEGSaveOptions.
STANDARDBASELINE
OPTIMIZEDBASELINE: Optimized color
and a slightly reduced file size.
PROGRESSIVE: Displays a series of
increasingly detailed scans as the
image downloads.
STANDARDBASELINE: Format
recognized by most web browsers.
GalleryConstrainType CONSTRAINBOTH The type of proportions to constrain
CONSTRAINHELGHT for images. Used in
CONSTRAINWIDTH

GallerylmagesOptions.
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Constant type Values What it means
GalleryFontType ARTAL The fonts to use for the Web photo
COURTERNEW gallery captions and other text. Used
HELVETICA in GallervB Onti
TIMESNEWROMAN in GalleryBannerOptions,
GallerylmagesOptions, and
GalleryThumbnailOptions.
Also used in PicturePackageOptions.
GallerySecurityTextColorType BLACK The color to use for text displayed over
CUSTOM gallery images as an antitheft
WHITE .
deterrent. Used in
GallerySecurityOptions.
GallerySecurityTextPositionType CENTERED The position of the text displayed over
LOWERLEFT gallery images as an antitheft
LOWERRIGHT det t Used in
UPPERLEFT eterrent. Used In
UPPERRIGHT GallerySecurityOptions.
Also used in PicturePackageOptions.
GallerySecurityTextRotateType  CLOCKWISE45 The orientation of the text displayed
CLOCKWISES0 over gallery images as an antitheft
COUNTERCLOCKWISE45 det t Used in
COUNTERCLOCKWISE90 eterrent. Used In
ZERO GallerySecurityOptions.
Also used in PicturePackageOptions.
GallerySecurityType CAPTION The content to use for text displayed
COPYRIGHT over gallery images as an antitheft
CREDIT det t Used i
CUSTOMTEXT eterrent. Used in -
FILENAME GallerySecurityOptions.
NONE
TITLE Note: All types draw from the image’s
file information except
CUSTOMTEXT.
GalleryThumbSizeType CUSTCM The size of thumbnail images in the
LARGE web photo gallery. Used in
MEDTOM GalleryThumbnailOptions
SMALL alleryThu ilOptions.
Geometry HEPTAGON Geometric options for shapes, such as
HEXAGON the iris shape in the Lens Blur Filter.
OCTAGON
PENTAGON Pass to ArtLayer.applyLensBlur().
SQUARE
TRIANGLE
GridLineStyle DASHED The preferred line style for the
DOTTED nonprinting grid displayed over
SOLID . .
images, set in Preferences.
GridSize LARGE The preferred size of grid line spacing,
MEDIUM set in Preferences.
NONE _—

SMALL
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Constant type Values What it means
GuideLineStyle DASHED The preferred line style for
SOLID nonprinting guides displayed over
images, set in Preferences.
IllustratorPathType ALLPATHS The paths to export to an lllustrator
DOCUMENTBOUNDS file using
NAMEDPATH
Document.exportDocument().
Intent ABSOLUTECOLORIMETRIC  The rendering intent to use when
PERCEPTUAL converting from one color space to
RELATIVECOLORIMETRIC th ith
SATURATION another wi _
Document.convertProfile() or
Document.print()
Justification CENTER The placement of paragraph text
CENTERJUSTIFIED within the bounding box. Used in
FULLYJUSTIFIED Textltern.iustificati
LEFT extltem.justification.
LEFTJUSTIFIED
RIGHT
RIGHTJUSTIFIED
Language BRAZILLIANPORTUGUESE  The language to use for text. Used in
CANADIANFRENCH Textltem.language.
DANISH
DUTCH
ENGLISHUK
ENGLISHUSA
FINNISH
FRENCH
GERMAN
ITALIAN
NORWEGIAN
NYNORSKNORWEGIAN
OLDGERMAN
PORTUGUESE
SPANISH
SWEDISH
SWISSGERMAN
LayerCompression RLE Compression methods for data for
ZIP

pixels in layers, when saving to TIFF
format. Used in TiffSaveOptions.
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LayerKind BLACKANDWHITE The type of a layer object, in
BRIGHTNESSCONTRAST ArtLaver.kind
CHANNELMIXER ArLayerxind
COLORBALANCE
s Note: You can create a text layer only
EXPOSURE from an empty art layer.
GRADIENTFILL
GRADIENTMAP
HUESATURATION
INVERSION
LEVELS
NORMAL
PATTERNFILL
PHOTOFILTER
POSTERIZE
SELECTIVECOLOR
SMARTOBJECT
SOLIDFILL
TEXT
THRESHOLD
LAYER3D
VIBRANCE
VIDEO
LensType MOVIEPRIME The type of lens to use. Pass to
PRIME105 A
rtLayer.applyLensFlare().
PRIME35 YErapply 0
ZOOMLENS
MagnificationType ACTUALSIZE The type of magnification to use when
FITPAGE viewing an image. Used in
PresentationOptions.
MatteType BACKGROUND The color to use to fill anti-aliased
BLACK edges adjacent to transparent areas of
FOREGROUND thei When t .
NETSCAPE e image. When transparency is
NONE turned off for an image, the matte
SEMIGRAY color is applied to transparent areas.
WHITE ' .
Used in GIFSaveOptions,
IndexedConversionOptions, and
JPEGSaveOptions.
MeasurementRange ALLMEASUREMENTS The measurement to act upon. Pass to
ACTIVEMEASUREMENTS MeasurementLog methods.
MeasurementSource MEASURESELECTION The source for recording
MEASURECOUNTTOOL measurements. Pass to
MEASURERULERTOOL
Document.recordMeasurements().
NewDocumentMode BITMAP The color profile to use for a new
QYK document.
GRAYSCALE
LAB Pass to Documents.add().
RGB

Also used in ContactSheetOptions and
PicturePackageOptions.
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Constant type Values What it means
NoiseDistribution GAUSSIAN Distribution method to use when
UNTFORM applying an Add Noise filter. Pass to
ArtLayer.applyAddNoise().
OffsetUndefinedAreas REPEATEDGEPIXELS Method to use to fill the empty space
SETTOBACKGROUND left by offsetting a an image or
WRAPAROUND .
selection. Pass to
ArtLayer.applyOffset().
OpenDocumentMode CMYK The color profile to use when opening
ii:YSCALE an EPS or PDF document. Pass to
RGB app.open () in EPSOpenOptions or
PDFOpenOptions.
OpenDocumentType ALIASPIX The format in which to open the
BMP document, using app . open ().
CAMERARAW ! 9 app - open
COMPUSERVEGIF .
DICOM Note: pHoTOCD is deprecated. Kodak
ELECTRICIMAGE PhotoCD is now found in the
EPS Goodies folder on the Adobe
EPSPICTPREVIEW Photoshop CC Install DVD.
EPSTIFFPREVIEW
FILMSTRIP .
IPEG Note: The p1com option is for the
PCX Extended version only.
PDF
PHOTOCD
PHOTOSHOP
PHOTOSHOPDCS 1
PHOTOSHOPDCS_2
PHOTOSHOPEPS
PHOTOSHOPPDF
PICTFILEFORMAT
PICTRESOURCEFORMAT
PIXAR
PNG
PORTABLEBITMAP
RAW
SCITEXCT
SGIRGB
SOFTIMAGE
TARGA
TIFF
WAVEFRONTRLA
WIRELESSBITMAP
OperatingSystem 082 The target operating system in
WINDOWS BMPSaveOptions.
Orientation LANDSCAPE Page orientation for
PORTRAIT

PhotoCDOpenOptions, deprecated in
Photoshop CS3.

Note: Kodak PhotoCD is now found in
the Goodies folder on the
Adobe Photoshop CC Install
DVD.
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Constant type Values What it means
OtherPaintingCursors PRECISEOTHER The preferred pointer for the following
STANDARDOTHER tools: Eraser, Pencil, Paintbrush,
Healing Brush, Rubber Stamp, Pattern
Stamp, Smudge, Blur, Sharpen, Dodge,
Burn, Sponge.
Set in Preferences.
PaintingCursors BRUSHSIZE The preferred pointer for the following
ziECISE tools: Marquee, Lasso, Polygonal
Lasso, Magic Wand, Crop, Slice, Patch
Eyedropper, Pen, Gradient, Line, Paint
Bucket, Magnetic Lasso, Magnetic Pen,
Freeform Pen, Measure, Color Sampler.
Set in Preferences.
PaletteType EXACT The palette type to use in
Eg%ﬁggg& GIFSaveOptions and
LOCALSELECTTVE IndexedConversionOptions.
MACOSPALETTE
MASTERADAPTIVE
MASTERPERCEPTUAL
MASTERSELECTIVE
PREVIOUSPALETTE
UNIFORM
WEBPALETTE
WINDOWSPALETTE
PathKind CLIPPINGPATH The type of a Pathltem.
NORMALPATH
TEXTMASK
VECTORMASK
WORKPATH
PDFCompatibility PDF13 The PDF version to make the
gggié document compatible with. Used in
PDF16E PDFSaveOptions.
PDF17
PDFEncoding JPEG The type of compression to use when
giggigggiéﬁgmss saving a document in PDF format.
TPEG2000LOW Used in PDFSaveOptions.
JPEG2000MED
JPEG2000MEDHIGH
JPEG2000MEDLOW
JPEGHIGH
JPEGLOW
JPEGMED
JPEGMEDHIGH
JPEGMEDLOW
NONE
PDFZIP

PDFZIP4BIT
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Constant type Values What it means

PDFResample NONE The down sample method to use.
PDFAVERAGE Used in PDFSaveOptions.
PDFBICUBIC
PDFSUBSAMPLE

PDFStandard NONE The PDF standard to make the
iggﬁigggé document compatible with. Used in
PDFX32002 PDFSaveOptions.
PDFX32003
PDFX42008

PhotoCDColorSpace LAB16 The color space for
Eéii PhotoCDOpenOptions, deprecated in
Ny Photoshop CS3.

Note: Kodak PhotoCD is now found in
the Goodies folder on the
Adobe Photoshop CC Install
DVD.

PhotoCDSize EXTRALARGE The pixel dimensions of the image in
ﬁ%ﬁw PhotoCDOpenOptions, deprecated in
MEDIUM Photoshop CS3.
MINIMUM EXTRALARGE = 1024x1536
SMALL LARGE = 512x768

MAXIMUM = 2048x3072

MEDIUM = 256x384

MINIMUM = 64x96

SMALL = 128x192

Note: Kodak PhotoCD is now found in
the Goodies folder on the
Adobe Photoshop CC Install
DVD.

PICTBitsPerPixels EIGHT The number of bits per pixel to use
Z?EI;EEN when compression a PICT file. Used in
THIRTYTHO PICTFileSaveOptions a.nd
THO PICTResourceSaveOptions.

Note: Use 16 or 32 for RGB images;
use 2, 4, or 8 for bitmap and
grayscale images.

PICTCompression JPEGHIGHPICT The type of compression to use when
giggﬁgiﬁmm saving an image as a PICT file. Used in
IPEGMEDTUMPICT PICTFileSaveOptions a.nd
NONE PICTResourceSaveOptions.
PicturePackageTextType CAPTION The function or meaning of text in a
ggEP;ﬁGHT Picture Package. Used in
F1LENAME PicturePackageOptions.
NONE
ORIGIN

USER
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Constant type Values What it means
PointKind CORNERPOINT The role a PathPoint playsin a
SMOOTHPOINT Pathltem.
PointType POSTSCRIPT The preferred measurement to use for
TRADITIONAL type points, set in
Preferences.pointSize:
POSTSCRIPT = 72 points/inch.
TRADITIONAL = 72.27 points/inch.
PolarConversionType POLARTORECTANGULAR The method of polar distortion to use.
RECTANGULARTOPOLAR Pass to
ArtLayer.applyPolarCoordinates().
Preview EIGHTBITTIFF The type of image to use as a
ﬁggg?;ﬁgmn low-resolution preview in the
MACOSMONOCHROME destination application.
EgEgCHROMETIFF Used in DCS1_SaveOptions,
DCS2_SaveOptions, and
EPSSaveOptions.
PrintColorHandling PRINTERMANAGED The type of color handling to use for
PHOTOSHOPMANAGED ColorHandling
SEPARATIONS
PurgeTarget ALLCACHES Cache to be targeted in an
CLIPBOARDCACHE Application.purge() operation.
HISTORYCACHES g2 purge() op
UNDOCACHES
QueryStateType ALWAYS The preferred policy for checking
EESER whether to maximize compatibility
when opening PSD files, set in
Preferences.maximizeCompatibility.
RadialBlurMethod SPIN The blur method to use. Pass to
Z00M ArtLayer.applyRadialBlur().
RadialBlurQuality BEST The smoothness or graininess of the
gg‘ggT blurred image. Pass to
ArtLayer.applyRadialBlur().
RasterizeType ENTIRELAYER The layer element to rasterize, using
FILLCONTENT ArtLayer.rasterize().
LAYERCLIPPINGPATH
LINKEDLAYERS
SHAPE
TEXTCONTENTS
ReferenceFormType CLASSTYPE The type of an ActionReference
ENUMERATED ;
object, returned by getForm().
IDENTIFIER ) y getForm()
INDEX
NAME
OFFSET

PROPERTY
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Constant type Values What it means

ResampleMethod AUTOMATIC The method to use forimage
Eiggigzwromnc interpolation. Passed to
BICUBICSHARDER Document.re5|zelmage(){ and used. as
BICUBICSMOOTHER the value of Preferences.interpolation.
BILINEAR
NEARESTNEIGHBOR
NONE
PRESERVEDETAILS

RippleSize LARGE The size of undulations to use. Pass to
MEDIUM ArtLayer.applyRipple
SMALL yer.applyRipple()

SaveBehavior ALWAYSSAVE The application’s preferred behavior
ASKWHENSAVING when saving a document. See
NEVERSAVE .

Preferences.appendExtension and
imagePreviews

SaveDocumentType ALIASPIX The format in which to save a
21‘0’J§PUSERVEGIF document when exporting with
FLECTRTICTMAGE Document..exportDocument(). Pass in
JPEG ExportOptionsSaveForWeb.format, to
PCX to specify the type of file to write. Only
PHOTOSHOP the following are supported for
PHOTOSHOPDCS_ 1 "
PHOTOSHOPDCS 2 export: COMPUSERVEGIF, JPEG, PNG-8,
PHOTOSHOPEPS PNG-24, and BMP.
PHOTOSHOPPDF
PICTFileFORMAT
PICTRESOURCEFORMAT
PIXAR
PNG
PORTABLEBITMAP
RAW
SCITEXCT
SGIRGB
SOFTIMAGE
TARGA
TIFF
WAVEFRONTRLA
WIRELESSBITMAP

SaveEncoding ASCII The type of encoding to use when
??géﬁ[{cm saving a file to DCS or EPS with
JPEGLOW Document.saveAs().
JPEGMAXIMUM
JPEGMEDIUM

SaveLogItemsType LOGFILE The preferred location of history log
LOGFILEANDMETADATA data, set in Preferences.saveLogltems.
METADATA

SaveOptions DONOTSAVECHANGES The policy for closing a document
PROMPTTOSAVECHANGES

SAVECHANGES

with Document.close().
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Constant type Values What it means
SelectionType DIMINISH The selection behavior when a
EXTEND selection already exists:
INTERSECT
REPLACE DIMINISH: Remove the selection from
the already selected area.
EXTEND: Add the selection to an
already selected area.
INTERSECT: Make the selection only
the area where the new selection
intersects the already selected area.
REPLACE: Replace the selected area.
Used in Pathltem.makeSelection(),
Selection.load(), Selection.select(), and
Selection.store().
ShapeOperation SHAPEADD How to combine the shapes if the
SHAPEINTERSECT destination path already has a
SHAPESUBTRACT lecti
SHAPEXOR selection.
Set for SubPathinfo.operation, stored
in the resulting SubPathltem.
SmartBlurMode EDGEONLY The method to use for smart blurring:
NORMAL
OVERLAYEDGE EDGEONLY, OVERLAYEDGES: Apply blur
only to edges of color transitions.
NORMAL: Apply blur to entire image.
Pass to ArtLayer.applySmartBlur().
SmartBlurQuality HIGH The blur quality to use. Pass to
LOwW ArtLayer.applySmartBlur().
MEDIUM yer.apply 0
SourceSpaceType DOCUMENT The color space for source when
PROOF printing with Document.print().
SpherizeMode HORIZONTAL The curve (or stretch shape) to use for
Sg% the distortion. Pass to
ArtLayer.applySpherize().
StrikeThruType STRIKEBOX The style of strikethrough to use in
STRIKEHETGHT text. Used in Textltem.strikeThru.
STRIKEOFF
StrokeLocation CENTER The placement of path or selection
égié?fm boundary strokes. Pass to
Selection.stroke().
TargaBitsPerPixels SIXTEEN The resolution to use when saving an
THIRTYTWO image in Targa format. Used in
TWENTYFOUR

TargaSaveOptions.




JavaScript Scripting Reference

Adobe Photoshop CC

Scripting Constants 213

Constant type Values What it means
TextCase ALLCAPS The capitalization style to use in text.
NORMAL Used in Textltem.capitalization.
SMALLCAPS
TextComposer ADOBEEVERYLINE The composition method to use to
ADOBESINGLELINE optimize the specified hyphenation
and justification options. Used in
Textltem.textComposer.
TextType PARAGRAPHTEXT The type of text, used in Textltem.kind.
POINTTEXT
PARAGRAPHTEXT: Text that wraps
within a bounding box.
POINTTEXT: Text that does not wrap.
TextureType BLOCKS The type of texture or glass surface
CANVAS image to load for a texturizer or glass
FILE filter. Pass t
FROSTED ilter. Pass to
TINYLENS ArtLayer.applyGlassEffect().
TIFFEncoding JPEG The type of compression to use for
NONE TIFF files. Used in TiffSaveOptions.
TIFFLZW
TIFFZIP
ToolType ARTHISTORYBRUSH The tool to use with
BACKGROUNDERASER Pathltem.strokePath().
BLUR
BRUSH
BURN
CLONESTAMP
COLORREPLACEMENTTOOL,
DODGE
ERASER
HEATLINGBRUSH
HISTORYBRUSH
PATTERNSTAMP
PENCIL
SHARPEN
SMUDGE
SPONGE
TransitionType BLINDSHORIZONTAL The method to use for transition from
BLINDSVERTICAL one image to the next in a PDF
BOXIN tation. Used i
BOXOUT presentation. Used in
DISSOLVE PresentationOptions.
GLITTERDOWN
GLITTERRIGHT
GLITTERRIGHTDOWN
NONE
RANDOM
SPLITHORIZONTALIN
SPLITHORIZONTALOUT
SPLITVERTICALIN
SPLITVERTICALOUT
WIPEDOWN
WIPELEFT
WIPERIGHT

WIPEUP
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Constant type Values What it means
TrimType BOTTOMRIGHT Type of pixels to trim around an
TOPLEFT image, passed to Document.trim().:
TRANSPARENT -
BOTTOMRIGHT = bottom right pixel
color.
TOPLEFT = top left pixel color.
TypeUnits MM The preferred unit for text character
PIXELS measurements, set in Preferences.
POINTS —
UndefinedAreas REPEATEDGEPIXELS The method to use to treat
WRAPAROUND undistorted areas or areas left blank in
an image to which the afilter in the
Distort category has been applied.
Pass to ArtLayer.applyDisplace(),
applyShear(), applyWave().
UnderlineType UNDERLINELEFT The placement of text underlining.
UNDERL INEOFF Used in Textltem.underline.
UNDERLINERIGHT
Note: UNDERLINELEFT and
UNDELINERIGHT are valid only when
direction = Direction.VERTICAL.
Units CcM The preferred measurement unit for
I\I/ﬂl\\/JTCHES type and ruler increments, set in
PERCENT Preferences.rulerUnits.
PICAS
PIXELS
POINTS
Urgency FOUR The editorial urgency status of a
IE(I)%'H document, setin
NONE DocumentPrintSettings.urgency.
NORMAL
SEVEN
SIX
THREE
TWO
WarpStyle ARC The warp style to use for text. Used in
ARCH Textltem.warpStyle.
ARCLOWER
ARCUPPER
BULGE
FISH
FISHEYE
FLAG
INFLATE
NONE
RISE
SHELLLOWER
SHELLUPPER
SQUEEZE
TWIST

WAVE
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WaveType SINE The type of wave to use. Pass to
SQUARE ArtLayer.applyWave().
TRIANGULAR YELAPPY 0
WhiteBalanceType ASSHOT Lighting conditions that affect color
éILJgSDY balance. Set in
CUSTOM CameraRAWOpenOptions.
DAYLIGHT
FLASH
FLUORESCENT
SHADE
TUNGSTEN
ZigZagType AROUNDCENTER The method of zigzagging to use. Pass
OUTFROMCENTER

to ArtLayer.applyZigZag().

PONDRIPPLES




Appendix A: Event ID Codes

The following table lists events and their four-character ID codes or string identifiers for use with the
notifier object.

Note: Do not include single quotes (') with four-character IDs in your code. The single quotes are
used in this table to illustrate the placement of required spaces in codes that do not contain four

letters. However, string identifiers, which are longer than four characters, require double quotes in

the code.

Tip: If you can't find the event you want to use for notification in this table, you can use ScriptListener to
determine the event ID code. See the ScriptListener documentation in the Action Manager chapter of

the Photoshop CC Scripting Guide.

Event 4-char ID or String
3DTransform 'TdT !
Average 'Avrg'
ApplyStyle 'ASty!
Assert 'Asrt’
AccentedEdges 'AccE'
Add 'Add !
AddNoise 'AdNs'
AddTo 'Add4T!
Align 'Algn’
All 'All
AngledStrokes 'Angs'’
ApplyImage 'AppI!
BasRelief 'BsR1'
Batch 'Btch'
BatchFromDroplet 'BtcF!
Blur 'Blr !
BlurMore 'B1lrM'
Border 'Brdr'
Brightness 'BrgC'
CanvasSize 'CnvSs'
ChalkCharcoal 'ChlcC!
ChannelMixer 'ChnM'

216
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Event 4-char ID or String
Charcoal 'Chrc'
Chrome 'Chrm'
Clear 'Cler'
Close 'Cls !
Clouds 'Clds'
ColorBalance 'ClrB'
ColorHalftone 'ClrH'
ColorRange 'ClrR'
ColoredPencil 'Clrp!’
ContactSheet "0B71D221-F8CE-11d2-B21B-0008C75B322C"
ConteCrayon 'CntC!
Contract 'Cntc'!
ConvertMode 'CnvM'
Copy 'copy'!
CopyEffects 'CpFX!
CopyMerged 'CpyM'
CopyTolayer 'CpTL!'
Craquelure 'Crql’
CreateDroplet 'CrtD!
Crop 'Crop'
Crosshatch 'Crsh'
Crystallize 'Crst’
Curves 'Crvs'
Custom 'Cstm'
Cut 'cut !
CutToLayer 'CETL'
Cutout 'Ct !
DarkStrokes 'DrkS'
DeInterlace 'Dntr!
DefinePattern 'DEfnP!
Defringe 'Dfrg’
Delete 'Dlt !
Desaturate 'Dstt!
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Event 4-char ID or String
Deselect 'Dslc’
Despeckle 'Dspc'!
DifferenceClouds 'DrfcC!
Diffuse 'Dfs !
DiffuseGlow 'DfsG'
DisablelLayerFX 'dlfx!
Displace 'Dspl’
Distribute 'Dstr’
Draw 'Draw'
DryBrush 'DryB'
Duplicate 'Dplc’
DustAndScratches 'DstS'
Emboss 'Embs'
Equalize 'Eqlz’
Exchange 'Exch'
Expand 'Expn'
Export 'Expr'
Jumpto 'Jpto’

ExportTransparentImage

"02879e00-cb66-11d1-bc43-0060b0all3dc4"

Extrude 'Extr’
Facet 'Fet !
Fade 'Fade'
Feather 'Fthr'
Fibers 'Fbrs'
Fill 'F1 !
FilmGrain 'FlmG'
Filter 'Fltr'
FindEdges 'FndE'
FitImage "3caal3434-cb67-11d1-bc43-0060b0al3dc4"
FlattenImage 'F1lteI!
Flip 'Flip'
Fragment 'Frgm'
Fresco 'Frsc'
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Event 4-char ID or String
GaussianBlur 'GsnB'
Get 'getd!
Glass 'Gls !
GlowingEdges 'GlwE'
Gradient 'Grdn'
GradientMap 'GrMp'
Grain 'Grn !
GraphicPen 'GrabP’
Group 'GrpL!
Grow 'Grow'
HalftoneScreen 'H1fS!
Hide 'Hd !
HighPass 'HghP'
HSBHSL 'HsbP'
HueSaturation 'HStr!
ImageSize 'ImgS'
Import 'Impr'
InkOutlines 'InkO'
Intersect 'Intr!'
IntersectWith 'IntwW!'
Inverse 'Invs'
Invert 'Invr'
LensFlare 'LnsF!
Levels 'Lvls!
LightingEffects 'LghE'
Link 'Lnk '
Make 'Mk !
Maximum 'Mxm '
Median 'Mdn !
MergeLayers 'Mrg2'
MergeLayersOld 'MrgL'
MergeSpotChannel 'MSpt!'
MergeVisible 'MrgV'
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Event 4-char ID or String
Mezzotint 'Mztn'
Minimum 'Mnm !
ModeChange "8cba8cd6-cb66-11d1-bc43-0060b0all3dc4"
Mosaic 'Msc !
Mosaic_PLUGIN 'MscT'
MotionBlur 'MtnB'
Move 'move'
NTSCColors 'NTSC'
NeonGlow 'NGlw'
Next 'Nxt !
NotePaper 'NtPr!'
Notify 'Ntfy!
Null typeNull
OceanRipple 'OcnR'’
Offset 'Ofst!
Open 'Opn !
Paint 'Pnt !
PaintDaubs 'PntD'
PaletteKnife 'P1tK'
Paste 'past'’!
PasteEffects 'PaFX'
Pastelnto 'PstI!
PasteOutside 'PstO’
Patchwork 'Ptch!
Photocopy 'Phtc!
PicturePackage "4C1lABF40-DD82-11d2-B20F-0008C75B322C"
Pinch 'Pnch'’
Place 'Plc !
Plaster 'Plst’
PlasticWrap 'PlsW'
Play 'Ply !
Pointillize 'Pntl’
Polar 'Plr !
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Event 4-char ID or String
PosterEdges 'PStE'
Posterize 'Pstr’
Previous 'Prvs'
Print 'Prnt’
ProfileToProfile 'PriT!
Purge 'Prge'’
Quit 'quit'
RadialBlur 'RA1B'
Rasterize 'Rstr’
RasterizeTypeSheet 'RstT!
RemoveBlackMatte 'RmvB'
RemovelayerMask 'RmvL'
RemoveWhiteMatte 'RmvW'
Rename 'Rnm '
ReplaceColor 'RplC!
Reset 'Rset'’
ResizeImage "1333cf0c-cb67-11d1-bc43-0060b0al3dca"
Reticulation 'Rtcl!
Revert 'Rvrt!
Ripple 'Rple’
Rotate 'Rtte’
RoughPastels 'RghP'
Save 'save'
Select 'slct!
SelectiveColor 'SlcC!
Set 'setd’
SharpenEdges 'ShrE'
Sharpen 'Shrp'
SharpenMore 'ShrM'
Shear 'Shr !
Show 'Shw !
Similar 'Smlr'
SmartBlur 'SmrB'
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Event 4-char ID or String
Smooth 'Smth'
SmudgeStick 'SmdS'
Solarize 'Slrz!’
Spatter 'Spt !
Spherize 'Sphr'
SplitChannels 'SplcC!
Sponge 'Spng'
SprayedStrokes 'SprS!
StainedGlass 'StnG'
Stamp 'Stmp!
Stop 'Stop'
Stroke 'Strk!
Subtract 'Sbtr'
SubtractFrom ' SbtF'
Sumie 'Smie’
TakeMergedSnapshot 'TkMr'
TakeSnapshot 'TkSn'
TextureFill 'TxtF!
Texturizer 'Txtz!'
Threshold 'Thrs'
Tiles 'Tls !
TornEdges 'TrnE'
TraceContour 'TrcC!
Transform 'Trnf!
Trap 'Trap'
Twirl 'Twrl'
Underpainting 'Undr'
Undo 'undo'
Ungroup 'Ungr!
Unlink 'Unlk’
UnsharpMask 'UnsM'
Variations 'Vrtn'
Wait 'Wait'
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Event 4-char ID or String
WaterPaper 'WtrP'
Watercolor 'Wtre!
Wave 'Wave'
Wind 'Wnd '
ZigZag 'Z2gzg’
BackLight 'BacL'
FillFlash 'FilE!

ColorCast 'ColE"
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Action Manager 193
actions
command lists 40
descriptions 43
descriptors 37
playing 47
active document 45
activePrinter 96
Add Noise filter
adjustments
brightness 55
color 197
color balance 55, 61
contrast 55,59
curves 55
highlights 62
levels 55,59
shadows 62
temperature 61
Adobe lllustrator, exporting paths to 105
alpha channels
defined 72
from transparency (TIFF documents) 186
opacity 72
saving
in BMP documents 69
in PDF documents 148
in PICT documents 153
in PICT resources 154
in Pixar documents 156
in PSD documents 152
in RAW documents 164
in SGIRGB documents 171
in Targa documents 176
in TIFF documents 186
anchor points
adding 143
annotations, importing 92
anti aliasing
text 179
application
activating 47
checking if feature enabled 47
defaults 158
location 46
preferences 158
artLayers, See layers
Asian text 160
authors 99
auto kerning 179, 197
auto leading 184
auto spacing, contact sheets 82

available memory 45
Average filter 55

background color
application 45
galleries 110
background layers 53
backgroundColor 96
baseline shift 179
batch command 47
batches
destination folder 66, 197
specifying options 66
beeping 158
bitmap documents
converting to 198
depth type 198
halftone type 198
opening 207
saving 69
bitmap images
See bitmap documents
black and white images 62
bleedWidth 96
blending modes
layer sets 129
layers 53
Blur filter 55
blur filters
Average 55
Blur More 55
Gaussian Blur 56
Lens Blur 57
Motion Blur 58
Radial Blur 58
Smart Blur 59
Blur More filter 55
BMP documents
See bitmap documents
brightness 55
adjusting 55

equalizing 60
build 45
C
caches
images 159
purging 49
camera raw documents
opening 70

settings 199
size options 199

224
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canvas
flipping 92
resizing 92
canvas, defined 88
caption 96
captions
contact sheets 82
documents 99
gallery images 111
gallery thumbnails 115
images 99
centerCropMarks 96
channels
activating 88
adding 74
adjusting 55
alpha See alpha channels
creating 74
deleting 72
displaying in color 158
duplicating 72
making visible 72
merging 72
mixing 61
splitting 93
spot See spot channels
types of 72
clipping paths
from paths 139
from text 185
Clouds filter 55
CMYKColor 79
color balance, adjusting 61
color picker 158
color profiles
changing 91
determining type of 89
naming 88
color profiles, see individual document formats
color samplers
adding 81
creating 81
moving 80
removing 80
colorBars 96
colorHandling 96
colors
active links 110
adjusting 197
balancing 55
channels 72
CMYK 79
custom settings 113
in galleries 110
inverting 60
modifying 62
none 135
preserving (GIF only) 116
reduction 106
settings 45

solid color objects 172
testing if equal 172
visited links 110
comments, layer comps 126
compatibility, maximizing 159
component channels
color balance 55
defined 72
listing 88
See composite channels
composite channels 72
See component channels
Compuserve GIF documents
opening 207
saving 116
contact sheets
captions 82
columns 82
dimensions 82
making 48
rows 82
contrast
adjusting 55
adjusting automatically 59
camera raw settings 70
midtones 62
copies 96
copyrights 99
cornerCropMarks 96
countitems
adding 84
creating 84
removing 83
cropping 91
CS4 version changes 34
cursors 160
curves, adjusting 55
Custom filters 55

D

DCS 1 documents, saving 85
De-Interlace filter 56
desaturate 60
Despeckle filter 56
dialogs
displaying 45
Difference Clouds filter 56
Diffuse Glow filter 56
Displace filter 56
distort filters
Diffuse Glow 56
Displace 56
Glass Effect 56
Ocean Ripple 58
Pinch 58
Polar Coordinates 58
Ripple 58
Shear 58
Spherize 59
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Twirl 59
Wave 59
Zigzag 59
document formats, see individual document formats
DocumentPrintSettings 96
documents 88
activating 45
adding 102
closing 90
code sample 94
color profiles 88
color samplers 88
counting items 89
counting objects 91
cropping 36,91
dimensions 88
duplicating 36, 91
exporting 92
info 99
loading 48
managed 89
measurement scale 89
metadata 89, 99
open with Photoshop dialog 49
opening 49
optimizing for web 106
printing 92
resizing 92
resolution 90
saving 92,93
suspending history 93
trapping (CMYK) 93
trimming 94
Dust and Scratches filter 56

E

Enable Info
constants 191
grammar 190
operator precendence 191
variables 192
EPSSaveOptions 104
equalize 60
event IDs
using ScriptListener to find 216
Events Manager 46
executing scripts 33
exif 99
exporting
documents 92
paths 105
to lllustrator 105
to Web 106
ExportOptionslllustrator 105
ExportOptionsSaveForWeb 106

F

file extensions
format 161

including 158
script files 32
file metadata 99
files
merging 48
filetypes
macOS 46
Windows 47
filling
paths 138
selections 167
filter, see individual filter names
flip 96
Folder object 32
fonts
detecting 45
determining family of 177
determining style of 177
formats, see individual document formats

G

galleries 113
background color 110
banners 109
captions 111
color options 110
credits 111
dimensions 111
filenames 111
link colors 110
making 47, 48
metadata 113
photographer 109
security text 114
thumbnail images 115
GalleryBannerOptions 109
GalleryCustomColorOptions 110
GallerylmagesOptions 111,112
GalleryOptions 113
GallerySecurityOptions 114
GalleryThumbnailOptions 115
Gaussian Blur filter 56
GIF documents
See Compuserve GIF documents
GIFSaveOptions 116
Glass Effect filter 56
glyph scaling 179-182
GrayColor 117
grids 159
grouped layers 53
guides 159

H

halftone screen 68
hanging punctuation 180
hardProof 96
High Pass filter 56
highlights

adjusting 62



JavaScript Scripting Reference

Adobe Photoshop CC

Index

227

color balance 55
histograms
channels 72
history log 161
history states
activating 88
allowing nonlinear 159
default number of 160
snapshot 120
suspending 93
HSBColor 122
hypenation 181

IDs
getting 37
PICT Resource 154
property 43
runtime 47
runtime to string 50
string to runtime 50
string to type 50
type to char 50
Illustrator
See Adobe lllustrator
image
resizing 93
image pyramids 186
images
bitmap 68
black and white 62
caches 159
captions 111
definition of 88
desaturating 60
equalizing 60
filetypes 46
from split channels 93
inverting colors 60
previewing 159
pyramids 186
resizing 92
resizing in galleries 112
thumbnails 115
indexed color model 123
IndexedConversionOptions 123
individual document formats, examples 93
installing scripts 33
Intent 96
interpolate 96
interpolation 159

J
JavaScript
changes in Photoshop CS4 34
supported features 32
JavaScript Resource
Enable Info grammar 190
javascriptresource syntax 189

javascriptresource tag 189
JPEG

quality 124
JPEG documents

quality 124

saving 124
JPEG options

scans 124
JPEGSaveOptions 124
justification 181

K

kerning 179
text
auto kerning 197
keyboard behavior 159

L
LabColor 125
labels 96
languages 181
layer comps 126
adding 127
applying 126
in documents 89
layer sets
adding 131
art layersin 129
duplicating 130
in documents 89
linked layers in 129
linking 130
locking contents 129
moving 130
nesting 129
opacity 129
unlinking 130
layer styles, applying 59
LayerComps 127
layered TIFFdocuments, saving 158
Layers 128
layers
adding 65
applying styles 59
background 53
blending mode 53
bounds 53
clipboard commands 59
comps 126
copying 59
duplicating 60
flattening 92
grouping 53
in documents 89
inverting 60
kind 53
linking 60
locking contents 53-54
making visible 54
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merging 60
merging visible 92
moving 61
rasterizing 92
rasterizing contents 61
removing 65
resizing 62
rotating 62
saving in PDF documents 148
unlinking 62
LayerSet 129
LayerSets 131
layersets
merging 130
leading 181, 184
Lens Blur filter
applying 57
Lens Flare filter 57
letter spacing 180-183
levels
adjusting 55
adjusting automatically 55
ligatures 179-181
linked layers 60
unlinking 62
links
colors 110

M
MacOS

filetypes 46
managed documents 89
mapBlack 96
maximizing compatibility 159
Maximum filter 57
Median Noise filter 57
memory 45
merging

layers 60

visible layers 92
metadata

document 89

document object 99

galleries 113

xmp 90, 188
methods

batch 47
midtones

color balance 55
Minimum filter 58
Motion Blur filter 58

N

negative 96
noise filters
Add Noise
Despeckle 56
Dust and Scratches 56
Median Noise 57

nonlinear history 159
notifications

events within scripts 136
notifiers

adding 137

eventIDs 216

removing 136
NTSC filter 58

(0

object model
changes in Photoshop CS4 34
Ocean Ripple filter 58
Offset filter 58
old style type 183
opacity
channels 72
gallery security text 114
layer fill 53
layer sets 129
layers 54
picture packages 155
open options
DICOM format 87
EPS format 103
PDF format 147
Photo CD format 151
RAW format 70, 163
optimizing 106
other filters
Custom 55
High Pass 56
Maximum 57
Minimum 58
Offset 58

P
palettes 160
pasting 92
path 46
path items
adding 142
deselecting 138
filling 138
from text 185
making selection 139
path points 174
selecting 139
specifying path kind 138
stroking 139
sub items 138
sub path info 173
sub path items 174
work path from selection 167
path point info
anchor points 144
left direction 144
right direction 144
path points
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anchor points 143

left direction 143

right direction 143
Pathltems 142
paths

See path items
PDF documents

opening 147

saving 148
PDF presentations

auto advance 162

making 48

output format 162

transition type 162
Photo CD discs, opening 151
photo filtering 61
photo galleries

See galleries
photomerge 48
Photoshop documents

opening 207

saving 152
Photoshop files, maximizing compatibility 159
PICT documents

opening 207

saving 153
PICT resources

opening 207

saving 154
picture packages

contents 155

flattening 155

making 48

opacity 155

options 155

text properties 155
Pinch filter 58
Pixar documents

opening 207

saving 156
PixarSaveOptions 156
pixels

aspect ratio 89

doubling 160

equalizing 60

interpolation 159

locking 54

unit measures 214
playback options 46
playbackDisplayDialogs 46
plug-in folder

additional plug-in folder 161
PNG 8 documents, saving 106
PNG documents

saving 157
PNGSaveOptions 157
Polar Coordinates filter 58
posterrize 61
postscript encoding 92
PostScript names 177

posX 96
posY 96
Preferences 158
PresentationOptions 162
presentations
making 48
PDF presentations
printBorder 96
printing, documents 92
printOneCopy 92
printSelected 96
printSettings 89
printSpace 96
property
measurementlLog 46
PSD documents
opening 207
saving 152
purging 49

Q
quickMaskMode 90
quote style 160

R
Radial Blur filter 58
rasterize 61
rasterizing
document layers 92
RAW documents
opening 163
RawSaveOptions 164
recentFiles 46
registrationMarks 96
render filters
Clouds 55
Difference Clouds 56
Lens Flare 57
renderintent 96
resolution
bitmap conversions 68
documents 90
RGBColor 165
Ripple filter 58
rotation 62
ruler units 160
runMenultem 49

S
save as 93
saved 90
saving 92
saving, see individual document formats.
scale 97
scripting interface
build date 46
version 46

scriptingVersion 46
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scripts
automation 189, 193
enabling/disabling in menu 189
executing 33
grouping in menu 189
installing 33
startup 33
terminology dictionary 193
valid file extensions 32
Scripts Events Manager 46
selected areas 90
selections 166
boundaries 166
clearing 166
copying 166
cutting 166
deselecting 166
feathering 166
filling 167
from paths 139
making work path from 167
resizing 166, 167
rotating 167
smoothing 168
stroking 168
selective color 62
SGIRGB documents
saving 171, 211
SGIRGBSaveOptions 171, 197
shadows
adjusting 62
color balance 55
Sharpen Edges filter 58
Sharpen filter 58
sharpen filters
Sharpen 58
Sharpen Edges 58
Sharpen More 58
Unsharp Mask 59
Sharpen More filter 58
Shear filter 58
Smart Blur filter 59
smart quotes 160
Spherize filter 59
spot channels
defined 72
merging into component channels 73
opacity 72
saving
in DCS 2 documents 86
in PDF documents 149
in PSD documents 152
in RAW documents 164
in SGIRGB documents 171
in TIFF documents 186
spotColors 171
startup scripts 33
strike thru 184
stroking
default stroke color 45

path items 139

selections 168
styles, applying 59
sub path items 138
systemInformation 46

T

temperature 61
terminology dictionary
defined 193
syntax 193
text
Asian 160
auto kerning 179
auto leading 184
captions 111
color
composer 184
content 179
creating paths from 185
formatting 184
gallery security 114,204
hyphenation 181
in picture packages 155
justification 181
languages 181
offset 179
orientation 180
spacing 180-183
tracking 184
wrapping 181
text composer 184
text fonts
See fonts
text items
See text
text layers
adding contents 179
creating 53
Texture Fill filter 59
texture filters, Texture Fill 59
threshold 62
thumbnails 115
Mac OS 159
Windows 161
TIFF documents
layered 158
saving 186
togglePalettes 50
tool tips 160
tracking, text 184
transmission info 99
trapping 93
Twirl filter 59
type units 161

U

underlining 184
units
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ruler 160

type 161
UnitValue object 32,187
Unsharp Mask filter 59
URLs, document 99
UTF8 Encoding 113

\'

vectorData 97
version
application 47
scripting interface 46
video alpha 161
video filters
De-Interlace 56
NTSC 58
visibility
channels 72
layer comps 126
layers 54

w

warp 184

Wave filter 59

Web photo galleries
See galleries.

webSnap 107

width 90

Windows
filetypes 47

word spacing 180-183

work paths
designating 208
from selected area 167

wrapping, text 181

X
XML 188
xmp metadata 90, 188

y4
Zigzag filter 59
zoom 159
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